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1 Introduction

11 About this Document

Purpose

This guide provides you with information on the installation and implementation processes of the following SAP
applications:

Table 1:
Application ’ SAP Help Portal with Product Documentation
SAP Allocation Management for Retail 1.5 http://help.sap.com/amrl5
SAP Assortment Planning for Retail 2.0 http://help.sap.com/rap
SAP Customer Activity Repository 3.0 http://help.sap.com/car
SAP Merchandise Planning for Retail 1.1 http://help.sap.com/mpr
SAP Promotion Management for Retail 8.2 http://help.sap.com/retail-pm

For more information on these applications and their business scenarios, see the Common Master Guide at

http://help.sap.com/car|l <your release> ¥ Installation and Upgrade Information » Master Guide 3.

Technically, the application versions described in this guide are shipped in the following installable product
versions:

Table 2:

Product Version Description More Information in Specific Release

Information Note (RIN)

CAR RETAIL APPL BUNDLE 2.0 Back-end product version SAP Note 2377015#% : RIN SAP Cus-
tomer Activity Repository retail applica-
tions bundle 2.0

SAP FIORI FOR SAP CARAB 3.0 Front-end product version SAP Note 2377081#%: RIN: Release in-
formation note SAP FIORI for SAP
CARAB 3.0

Common Installation Guide CARAB 2.0
Introduction CUSTOMER 5


http://help.sap.com/amr15
http://help.sap.com/rap
http://help.sap.com/car
http://help.sap.com/mpr
http://help.sap.com/retail-pm
http://help.sap.com/car
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2377015
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2377081

Installation Versus Implementation

e Installation: For a correct installation, you must always install all components. This means, all software
component versions included in the CAR RETAIL APPIL BUNDLE back-end product version and the sap
FIORI FOR SAP CARAB front-end product version. For more information on these product versions, see
Overall System Planning [page 171].

e [mplementation: Once you have completed the installation, you only need to implement and configure those
components that are required for your specific implementation scenario. For detailed descriptions, see
Implementation Scenarios.

Upgrade

Caution

If you have an existing installation of any of these applications, you must perform a software upgrade rather
than a new installation:

Table 3:

Application Upgrade Information

SAP Customer Activity Repository http://help.sap.com/car|F <your release> ¥ Installation and Upgrade
Information > Upgrade Guide ]

SAP Assortment Planning for Retail http://help.sap.com/rapl} <your release> > Installation and Upgrade
Information > Upgrade Guide }

SAP Merchandise Planning for Retail You must complete the upgrade to SAP Customer Activity Repository 3.0 prior
to using SAP Merchandise Planning for Retail. http://help.sap.com/mpr
|} <your release> > Installation and Upgrade Information > Upgrade Guide }

SAP Promotion Management for Retail http://help.sap.com/retail-pmr810|F System Administration and Maintenance
Information > Administration Guide ]

1.2 SAP Notes for the Installation

The following list includes SAP Notes that you must read (and, when appropriate, implement) before you start
the installation.

Make sure that you have the up-to-date version of each SAP Note, which you can find on the SAP Support Portal
at http://support.sap.com/notes .
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http://help.sap.com/car
http://help.sap.com/rap
http://help.sap.com/mpr
http://help.sap.com/retail-pmr810
http://help.sap.com/disclaimer?site=http://support.sap.com/notes

Table 4: SAP Notes for SAP Customer Activity Repository

SAP Note Number

‘ Title

Description

F1773A - Fix Negative Time Zone Off-
set Bug

2379029 P Release and Information Note (RIN) - | This note serves as an entry point for SAP Cus-
SAP Customer Activity Repository tomer Activity Repository 3.0. It provides up-to-
3.0 date information on the current release, together
with a list of important SAP Notes that you must
apply to complete the installation process.
2183947 P Smart Business for SoH (Suite on Information on how to install add-on object Ul-
Hana) delivery SAFND1 100 when installing the SAP Smart Busi-
ness Modeler Apps Framework with User Interface
Add-On 2.0 for SAP NetWeaver.
1605140 " SAP HANA 1.0: Central Note - SAP LT | Collective note for all the relevant SAP Notes for LT
Replication Server Replication Server for SAP HANA.
1778607 i SAP HANA Live for SAP Business What to consider when implementing SAP HANA
Suite Live for SAP Business Suite.

1791342 e Time Zone Support in SAP HANA How to handle time zone functions UTCTOLOCAL
and LOCALTOUTC.

2387939 Invalid Selection Input Cause an How to correct a specific error with the POS Work-

Empty POS Workbench Screen bench user interface.
2388066 M Move S4H view into dedicated S4H Mandatory correction to the SAP HANA content ac-
package tivation report for SAP Customer Activity Reposi-
tory.

2390790 # HANA Content Activation Mandatory correction to the SAP HANA content ac-
tivation report for SAP Customer Activity Reposi-
tory.

2392194 Fr CAR Activation Report - Enablement | Mandatory correction to the SAP HANA content ac-

of POSDM on S/4HANA tivation report for SAP Customer Activity Reposi-
tory.

2387956 e CAR Activation Report - Fixes for Corrections to /CAR/ACTIVATE HTA report.

Customer Activity Repository, As-
sortment Planning and Demand Data
Foundation

2376424 UDF Integration with S4H Required to use UDF with an SAP S/4HANA source
master data system.

2372802 P Analyze Forecast: SAP Fiori ID Corrects a time zone issue in the Analyze Forecast

SAP Fiori app.
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http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2379029
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2183947
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1605140
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1778607
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1791342
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2387939
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2388066
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2390790
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2392194
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2387956
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2376424
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2372802

Description

SAP Note Number ’ Title

2389537 M Previous UDF modeling results are Corrects a data issue in demand modeling with

deleted if there are issues in new data | UDF.

Table 5: SAP Notes for SAP Allocation Management for Retail

SAP Note Number Title Description
2374336/ iﬁleasg Inf'\(;lrmation NOtf (RRIN) floi EAP This note serves as an entry point for
ocation Management for Retail 1. SAP Allocation Management for Retail
1.5.
2374362 Release Information Note (RIN) for SAP | This note contains information, referen-
Allocation Management for Retail 1.5 ces, and notes in the context of applying
SAP Allocation Management for Retail
1.5 back end part.
2374343/ Release Information Note (RIN) for SAP | This note contains information, referen-
Allocation Management for Retail 1.5 ces, and notes in the context of applying
SAP Allocation Management for Retail
1.5 Ul part.
23893167k Collective Note - AMR Correction Wave 1 | This note comprises all corrections for
before RTC SAP Allocation Management for Retail
for all architecture layers, i.e. SAP Fiori,
ABAP (gateway and back end), and SAP
HANA DB.
2340418 " SAP HANA DB: RUTDDLSCREATE re- SAP HANA DB
turns errors for CDS views with external
views as base object
2374190 % ABAP CDS: Inconsistency in Reference | ABAP CDS: Inconsistency in reference
Table/Field of CDS Views selecting from | table or field
Table Functions; AMDP Table Function
client handling
Table 6: SAP Notes for SAP Assortment Planning for Retail
SAP Note Number ‘ Title Description
SAP Notes for SAP Retail
2196351 M Pre-requisite for SAP Note #2196323 | Corrections to SAP Retail data elements.

2196323/ DRFOUT: Only valid current node as- | Article Hierarchy Transfer replication will transfer

signments and article assignments all node and article assignments irrespective of the
are transferred during Article Hierar- | validity.

chy Replication
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http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2389537
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2374336
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2374362
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2374343
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2389316
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2340418
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2374190
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2196351
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2196323

SAP Note Number

’ Title

Description

Planning

2209621 M Assortment Listing API: List by DC fix | Functionality on the SAP Retail side to enable PIR
integration with SAP Assortment Planning for Re-
tail.

2286994 My New Listing API for Retail Assortment | Supports:

e Different listing periods for different products
within an assortment

e (Changes in the listing after a product has been
listed

® |n-season listing changes

e Multiple validity time periods for the same lo-
cation

SAP Notes for Back-End System

Clustering Capacity and Planned
Sales

2022080 " Upgrade of PAL AFL and BFL AFL Corrections to add privileges removed during up-
from SAP HANA earlier release to grade to SAP HANA Platform SPS 08.
SPS08

2388066 Move S4H view into dedicated S4H Corrections to /CAR/ACTIVATE HTA report.
package

2390790 # HANA Content Activation Corrections to /CAR/ACTIVATE HTA report.

2392194 CAR Activation Report - Enablement | Corrections to /CAR/ACTIVATE HTA report.
of POSDM on S/4HANA

2395997 My 2395997 - SAP Assortment Planning | Corrections to /CAR/ACTIVATE HTA report.
for Retail 2.0 (FPO) - Season, Collec-
tion and Theme issue

2387956 F CAR Activation Report - Fixes for Cus- | Corrections to /CAR/ACTIVATE HTA report.
tomer Activity Repository, Assort-
ment Planning and Demand Data
Foundation

2392499 M Assortment Planning: Module location | Corrections to Plan Assortment workbook.
validity activates entire cluster

2387526 P Performance enhancements for Loc Performance enhancements.

SAP Notes for Front-End Server

Common Installation Guide CARAB 2.0
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http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2209621
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2286994
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2022080
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2388066
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2390790
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2392194
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2395997
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2387956
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2392499
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2387526

SAP Note Number ’ Title Description
2383938 ¥ RIN SAP Fiori for SAP Assortment Common note containing correction instructions
Planning for Retail 2.0 that must be implemented following the installa-
tion of the SAP Fiori Ul Components on the front-
end server.
2296550 P LPD_CUST system Alias is not recog- | Corrections to central SAP Fiori component.
nized
SAP Notes for Planning Functionality Used by SAP Assortment Planning for Retail
1637199 Fsr Using the planning applications KIT Important information for running the Planning Ap-
plication Kit (PAK).
23223607 Missing field labels in FIORI applica- Corrections to SAP Fiori label display.
tions
23360990 M Termination when calling input help Corrections to input help.
(SAP HANA model, restriction to long
text)
2327576 BW-PLA-IP: Exit for generation of Corrections to the generation of characteristic
characteristic combinations with combinations.
SQLScript
2338767 " HCPR Column View is not generated | Corrections to usage of composite providers.
on after import
1662968 Clarification on setting ResultSetSize- | Information on changing the default
Limit in Analysis Office ResultSetSizeLimit registry setting.
2074801 " Dumps and Issues with special In- Corrections to in-memory planning.
foObjects like OFISCYEAR, OCALM-
ONTH...
2364967 P BICS: Delta update result set empty Corrections to reprocessing variables and/or
) . ) query views.
after variable submit or reprocessing
of query view

Table 7: SAP Notes for SAP Merchandise Planning for Retail

SAP Note Number

All SAP notes for SAP Customer
Activity Repository are required.

Title

Description

2391503

Release Information Note

The list of all SAP notes relevant for MPR (including
BW IP in component SAP_BW).
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Table 8: SAP Notes for SAP Promotion Management for Retail

SAP Note Number ‘ Title Description
2026580 P Release strategy for the ABAP add-on | This SAP Note contains information about plan-
RTLPROMO ning the installation and upgrades of the ABAP
add-on RTLPROMO.
2163602 F DRFOUT: Incorrect timestamp send This SAP Note contains information on correcting
for Moving Average Price the timestamp field when using DRFOUT to repli-
cate the Moving Average Price.
2292852 Fyr Itis required to transfer Offers in SAP | This SAP Note describes ways to send non-trans-
PMR to SAP ERP to enable logistical | ferrable offers to SAP ERP by means of custom
processing of the articles in the sites | enhancements.

1.3 Information Available on SAP Help Portal

Table 9: Information on the Applications Provided with SAP Customer Activity Repository Retail Applications Bundle

Description Path Title

Information on SAP Customer Activity http://help.sap.com/car/retail-car300 | SAP Customer Activity Repository 3.0
Repository

Information on SAP Allocation http://help.sap.com/amrl5 SAP Allocation Management for Retail 1.5
Management for Retail

Information on SAP Assortment http://help.sap.com/retail-apr2 SAP Assortment Planning for Retail 2.0
Planning for Retail

Information on SAP Merchandise http://help.sap.com/retail-mprll SAP Merchandise Planning for Retail 1.1
Planning for Retail

Information on SAP Promotion http://help.sap.com/retail-pmr82 SAP Promotion Management for Retail
Management for Retail 8.2

Table 10: Information on Prerequisite Platforms, Applications, and Other Components

Description Path Title
Information on installing SAP HANA http://help.sap.com/hana_platform SAP HANA Server Installation and Up-
date Guide

|+ <your support package stack> »
Installation and Update > SAP HANA

Server Installation and Update Guide 3

Common Installation Guide CARAB 2.0
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http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2026580
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2163602
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Description

Information on installing SAP HANA da-
tabase clients

Path

http://help.sap.com/hana_platform
|} <your support package stack> >
Installation and Update > SAP HANA
Client Installation and Update Guide 3

’ Title

SAP HANA Client Installation and Update
Guide

Information on installing SAP HANA stu-
dio

http://help.sap.com/hana_platform
|} <your support package stack> >
Installation and Update > SAP HANA
Studio Installation and Update Guide }

SAP HANA Studio Installation and Up-
date Guide

Information on installing the SAP LT
(Landscape Transformation) Replica-
tion Server for SAP HANA

http://help.sap.com/hanallF SAP HANA
» SAP HANA Options » SAP HANA Real-

Time Replication > SAP HANA Trigger-
Based Data Replication Using SAP LT

Replication Server ¥ Installation and

Upgrade Information b |

Installation Guide - Trigger-Based Data
Replication Using SAP LT Replication
Server for SAP HANA

Information on managing major opera-
tional aspects of the SAP LT Replication
Server

http://help.sap.com/hanallF SAP HANA
» SAP HANA Options » SAP HANA Real-

Time Replication > SAP HANA Trigger-
Based Data Replication Using SAP LT

Replication Server > System
Administration and Maintenance

Information }

Application Operations Guide - Trigger-
Based Data Replication Using SAP LT
Replication Server for SAP HANA

Information on using SAP HANA

http://help.sap.com/hana_platform
|} <your support package stack> >
System Administration » SAP HANA
Administration Guide }

SAP HANA Administration Guide

Information for developers on how to
use the SAP HANA development tools to
create comprehensive analytical models
and to build applications with SAP HA-
NA's interfaces and integrated develop-
ment

http://help.sap.com/hana_platform
| 3 <your support package stack> p

Development and Modeling # SAP HANA
Developer Guide (For SAP HANA

Studio) 3

SAP HANA Developer Guide

Information for modelers (or business
analysts) on how to define data models
that will be used in SAP HANA

http://help.sap.com/hana_platform
|} <your support package stack> >

Development and Modeling > SAP HANA
Modeling Guide (For SAP HANA

Studio) 3

SAP HANA Modeling Guide
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http://help.sap.com/hana_platform
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http://help.sap.com/hana
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Description

Information on installing SAP NetWea-
ver 7.50

Path

http://help.sap.com/nw75
|} Installation and Upgrade Information

> Installation Guide }

’ Title

Installation Guide, SAP Systems Based
on the Application Server <Your Server>
of SAP NetWeaver on <Your Operating
System>: SAP HANA Database

Information on installing SAP ERP 6.0

http://help.sap.com/erp|l <your
release> } Installation and Upgrade

Information > Installation Guide 1

Installation Guide, SAP ERP 6.0 Including
<your SAP Enhancement Package> -
Technical Usage "Central Applications”
<Your Server>on <Your Operating Sys-

tem>

Information on installing SAP S/4HANA,
on-premise edition 1610

http://help.sap.com/s4hana| SAP S/4
HANA, on-premise edition 1610 »
Product Documentation ¥ Installation

Guide J

Installation Guide for SAP S/4 HANA, on-
premise edition 1610

Information on installing SAP Enhance-
ment Package 2 for SAP CRM 7.0 or
SAP Enhancement Package 2 for SAP
CRM 7.0, Version for SAP HANA or
higher

http://help.sap.com/crm702
|} Installation and Upgrade Information

> Installation Guide > Install >
Installation Guides for SAP EHP 2 for SAP

CRM 7.0 ¥ Installation Guide - SAP
enhancement package 2 for CRM 7.0 -

ABAP and Java 4

http://help.sap.com/crmhana
|} Installation and Upgrade Information

» Administrator's Guide »
Administrator's Guide SAP CRM 7.0

EHP2, Version for SAP HANA }

Installation Guide, SAP Customer Rela-
tionship Management 7.0 Including En-
hancement Package 2 Java and ABAP

Administrator's Guide, SAP Enhance-
ment Package 2 for SAP CRM 7.0, Ver-
sion for SAP HANA

Table 11: General Quick Links

Description Path
SAP Help Portal http://help.sap.com
SAP Notes http://support.sap.com/notes

SAP Software Download Center

http://support.sap.com/swdc

Product Availability Matrix

http://support.sap.com/pam P

Released platforms and operating systems

http://service.sap.com/platforms

SAP Solution Manager

http://support.sap.com/solutionmanager #
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http://help.sap.com/disclaimer?site=http://service.sap.com/platforms
http://help.sap.com/disclaimer?site=http://support.sap.com/solutionmanager

Description

Security

Path

http://service.sap.com/security fr

Security guides

http://service.sap.com/securityguides

level requirements

Support package stacks, latest versions, patch http://support.sap.com/patches P

System sizing

http://service.sap.com/sizing P

1.4 Naming Conventions

Throughout this document the following naming conventions apply.

Definitions

The following terms are used consistently in the processes and procedures described in this guide:

Table 12:

Term Definition

Common Master Guide

Common Master Guide for SAP Customer Activity Repository, SAP Allocation Management
for Retail, SAP Assortment Planning for Retail, SAP Merchandise Planning for Retail, and SAP
Promotion Management for Retail.

You can find this guide on SAP Help Portal at http://help.sap.com/carllp <your release> »
Installation and Upgrade Information > Master Guide ]

consuming application

An SAP product designed to consume and utilize data obtained from SAP Customer Activity
Repository.

«» Example

o  SAP Allocation Management for Retail
e SAP Assortment Planning for Retail
e  SAP Merchandise Planning for Retail

e  SAP Promotion Management for Retail

14 CUSTOMER
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Term

back-end system

Definition
The SAP NetWeaver-based back-end server on which SAP Customer Activity Repository and
its consuming applications are installed.

For a visual representation of the back-end system, see Figure 1 in the Overall System Plan-
ning section.

front-end server

The SAP NetWeaver-based front-end server on which the SAP Gateway, SAP Fiori launchpad,
central SAP Fiori Ul component, and the product-specific SAP Fiori component are installed.

For a visual representation of the front-end system, see Figure 1 in the Overall System Plan-
ning section.

source master data system

SAP Customer Activity Repository retail applications bundle must be installed alongside an
SAP Retail (SAP ERP) or SAP S/4HANA central component as a single source of truth for all

SAP S/4HANA central component you choose for your implementation.

master data. With this release, there are two possible source master data system options:

e SAPERP 6.0 (including the SAP Retail add-on, with or without SAP Fashion Manage-
ment)

e SAP S/4HANA, on-premise edition 1610

Whenever this guide refers to a “source master data system”, it refers to the SAP Retail or

Naming Differences

Due to naming differences between the underlying technical objects of the components, the names of the
following business objects are used interchangeably in this document:

Table 13:

SAP Customer Ac-
tivity Repository

(all modules ex-
cept for UDF and
DDF)

article

Unified Demand
Forecast (UDF)
and Demand Data
Foundation (DDF)

product

SAP Assortment
Planning for Re-
tail / SAP Mer-
chandise Planning
for Retail

product

SAP Promotion
Management for
Retail

product

SAP Allocation
Management for
Retail

product

SAP Retail or SAP
S/4HANA

article

material

article variant

product variant

product variant

product variant

product variant or
product/color/size

article variant

store

location

location

location

store

store

site
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Variables
Table 14:

Variables Description

<SAPSID> SAP system ID in uppercase letters

<sapsid> SAP system ID in lowercase letters

<DBSID> Database ID in uppercase letters

<dbsid> Database ID in lowercase letters

<INSTDIR> Installation directory for the SAP system

<DVD_DIR> Directory on which a DVD is mounted

<0S> Operating system name within a path

Common Installation Guide CARAB 2.0
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2 Planning

2.1 Overall System Planning

The retail applications described in this guide require a layered system landscape, as illustrated in the example
below. For more information about the prerequisites for this release, see the following:
® Release information notes (RINSs):
o SAP Note 2377015#% for the back-end product version
o SAP Note 2377081#% for the front-end product version
e Forinitial installations: Prerequisites [page 32]
e For upgrade scenarios: Prerequisites

Common Installation Guide CARAB 2.0
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HTTPS (OData) c?

ABAP Front-End Server (SAP NetWeaver 7.31 or

SAP Fiori for SAP Customer Activity Repository Retail Applications Bundle!

7.40 or 7.50)

SAP Fiori
Launchpad

Product-Specific SAP Fiori Front-End
(UICARO0O1 200)

|
I
I
I
[ E—

Central SAP Fiori Ul Component
(SAP_UI)

SAP
| | NetWeaver
Gateway

Trusted RFC #)

Separate Shipment

ABAP Back-End Server (SAP NetWeaver 7.50 SPS 04)
SAP Customer Activity Repository Retail Applications Bundle

SAP BusinessObjects
Analysis, Edition for
Microsoft Office 2.3 SP3

SAP Merchandise Planning

SAP Allocation Management for Retail
SAP Assortment Planning for Retail

for Redtail

SAP Promotion Management for Retail
(RTLAPPS 300)
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Add-Ons

SAP Customer Activity Repository
(RTLCAR 300)

Demand Data Foundation
(RTLDDF 300)

SAP Customer Activity Repository

SAP NetWeaver 7.50 SPS 04

SAP Fiori App Content |

SAP HANA XS Engine

5

o

SAP HANA Platform 1.0 SPS 12 Latest Maintenance Revision

SAP Customer Activity Repository Retail Applications Bundle
SAP HANA Content (HTAs)

OFL

SAP RTL AFL

FOR SAP HANA 200

PAL

SAP HANA AFL

Product-Specific AFL

Component with

Libraries for UDF, OSA

CUSTOMER

Figure 1: System Landscape
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Product Versions

The installation of SAP Customer Activity Repository and its consuming applications is comprised of the
installation of two distinct product versions:

e SAP Customer Activity Repository retail applications bundle 2.0 (back-end product version CAR RETATL
APPL BUNDLE 2.0)
The back-end product version contains several software components that provide the ABAP back-end
functionality and the business content (such as SAP HANA views and SQLScript procedures, local Bl Content,
application function libraries, and workbooks, where applicable).

e SAP Fiori 3.0 for SAP Customer Activity Repository retail applications bundle 2.0 (front-end product version
SAP FIORI FOR SAP CARAB 3.0)
The front-end product version contains the product-specific SAP Fiori Ul component, which includes all the
SAP Fiori user interfaces for the applications provided for SAP Customer Activity Repository retail
applications bundle.
For more information about the system landscape for SAP Fiori apps, see http://help.sap.com/

fiori_implementation| Required System Landscape 3.

Central Hub Deployment

For SAP Customer Activity Repository, SAP Assortment Planning for Retail, and SAP Allocation Management for
Retail, we recommend that you use central hub deployment, the deployment option recommended by SAP Fiori
for SAP Business Suite.

With central hub deployment, the CAR RETAIL APPL BUNDLE product version is installed on a back-end server,
and the SAP FIORI FOR SAP CARAB product version isinstalled on a separate front-end server.

The central hub deployment option decouples the lifecycle of the Ul SAP Fiori apps from the back-end
components, and offers the following advantages:

e Faster iterations for the Ul apps

e (Changes to the user interface are possible without having development authorizations in the back-end

e Single point of maintenance for user interface issues, such as browser support and updated versions of
SAPUI5S libraries

e (entral place for theming and branding SAP Fiori apps

In general, when an SAP solution includes an SAP Fiori user interface, you could potentially use the embedded
deployment option, which allows you to use the same SAP NetWeaver server for back-end and front-end
components. Although the advantage of this deployment is that you do not require a separate SAP NetWeaver
front-end server, this deployment option is not recommended for the retail applications described in this guide.

As we do not recommend the embedded deployment option, the remainder of this document is entirely based on
the central hub deployment option.

For more information on deployment options, see:
e http://help.sap.com/fiori_implementation|}p Required System Landscape » With SAP NetWeaver 7.5 » Setup
of SAP Fiori System Landscape # Deployment Options 3

e http://help.sap.com/nwgateway20|p Installation and Upgrade Information » Master Guide » SAP NetWeaver
Gateway Master Guide » Deployment Options 3 as well as Embedded Versus Hub Deployment

Common Installation Guide CARAB 2.0
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2.2 System Landscape Variants
2.2.1 SAP Allocation Management for Retail

2.211 Common Characteristics of Landscape Variants

All SAP Allocation Management for Retail landscape variants share the following common characteristics:

e SAP Allocation Management for Retail is installed as part of SAP Customer Activity Repository retail
applications bundle (CAR RETAIL APPL BUNDLE), however, the application is licensed separately.

SAP Customer Activity Repository retail applications bundle is installed as an add-on to SAP NetWeaver
Application Server for ABAP, on an underlying SAP HANA Platform.

e SAP Allocation Management for Retail is a consuming application of SAP Customer Activity Repository.

e SAP Allocation Management for Retail uses SAP HANA content that is automatically installed when installing
SAP Customer Activity Repository retail applications bundle (CAR RETAIL APPL BUNDLE), including:

o Demand Data Foundation (DDF) module in SAP Customer Activity Repository (RTLDDF software
component)

o SAP Customer Activity Repository platform layer (RTLCAR software component)

o SAP Allocation Management for Retail (RTLAPPS consuming applications software component)

e SAP Allocation Management for Retail is embedded into the SAP Assortment Planning for Retail database
schema on the SAP HANA Platform (SAP_RAP DB Schema) in addition to the schemas of SAP Customer
Activity Repository software components ( SAP_ DDF DB Schema, SAP_CAR DB Schema).

e SAP Allocation Management for Retail uses master data, sales data, and inventory data originating from
connected source system, such as SAP Retail.

2.21.2 SAP Allocation Management for Retail Standalone

This deployment option has the following key characteristics:
SAP Allocation Management for Retail is deployed alongside an existing installation of SAP ERP for Retail 6.0:

e Dataisimported from SAP ERP into Demand Data Foundation, using the DRFOUT data replication framework,
and is persisted in SAP_DDF Schema (subset of data)

e Datais replicated using SAP LT Replication Server (SLT), and is persisted in SAP_ECC Schema.

2.21.3 SAP Allocation Management for Retail Co-Deployed
with SAP ERP

This deployment option has the following key characteristics:

Common Installation Guide CARAB 2.0
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SAP Allocation Management for Retail is co-deployed with SAP ERP for Retail 6.0 see (Prerequisites [page
32] section for information on supported enhancement packages) on the same SAP HANA Platform but on a
different SAP NW stack.

Since SAP Allocation Management for Retail and SAP ERP share the same SAP HANA Platform, SLT
replication of data from SAP ERP is not required. SAP Allocation Management accesses SAP ERP data
directly fromthe SAP ERP database schema (SAP ECC DB Schema).

Data is imported from SAP ERP into DDF using the DRFOUT data replication framework and is persisted in
SAP DDF Schema.

2.2.2 SAP Assortment Planning for Retail

2.2.2.1 Common Characteristics of Landscape Variants

All SAP Assortment Planning for Retail landscape variants share the following common characteristics:

SAP Assortment Planning for Retail is installed as part of SAP Customer Activity Repository retail
applications bundle (CAR RETAIL APPL BUNDLE), however, the application is licensed separately.
The SAP Customer Activity Repository retail applications bundle is installed as an add-on to SAP NetWeaver
Application Server for ABAP, on an underlying SAP HANA Platform.

SAP Assortment Planning for Retail is a consuming application of SAP Customer Activity Repository.

SAP Assortment Planning for Retail uses master data, sales history data, and inventory data originating from
connected systems, such as SAP S/4HANA, SAP Retail (SAP ERP) or SAP BW. For more information, see
Configure Data Replication [page 103].

SAP Assortment Planning for Retail supports a single or multiple SAP Retail and/or SAP S/4HANA source
system(s). These systems do not needs to have the same versions installed (for example, one source system
can be SAP Retail EPH7, while another system can be SAP S/4HANA). Data from connected SAP Retail and
SAP S/4HANA systems is stored in different database schemas, accessed by SAP Assortment Planning for
Retail.
You define the source systems in Customzing under | Cross-Application Components » Demand Data
Foundation » Basic Settings » Define Logical Systems 3.

SAP Assortment Planning for Retail uses SAP HANA content that is automatically installed when installing the
SAP Customer Activity Repository retail applications bundle (CAR RETAIL APPL BUNDLE), including:

o Demand Data Foundation (DDF) module in SAP Customer Activity Repository ( RTLDDF software

component)

o SAP Customer Activity Repository ( RTLCAR software component)

o SAP Assortment Planning for Retail (included in the RTLAPPS software component)

SAP Assortment Planning for Retail has its own database schema on the SAP HANA Platform ( SAP_RAP DB
Schema) in addition to the schemas of SAP Customer Activity Repository software components ( SAP_DDF
DB Schema, SAP_CAR DB Schema).

Common Installation Guide CARAB 2.0
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2.2.2.2 SAP Assortment Planning for Retail Standalone

This deployment option has the following key characteristics:

e SAP Assortment Planning for Retail is deployed alongside an existing installation of the following:
o SAP Retail or SAP S/4HANA (see the Prerequisites [page 32] section for information on supported

enhancement packages).
SAP Assortment Planning for Retail supports a single or multiple SAP Retail (SAP ERP) and/or SAP S/
4HANA source system(s). These systems do not needs to have the same versions installed (for example,
one source system can be SAP ERP EPH7, while another system can be S/4HANA). Data from connected
SAP Retail and SAP S/4HANA systems is stored in different database schemas, accessed by SAP
Assortment Planning for Retail.
You define the source systems in Customzing under ||# Cross-Application Components » Demand Data

Foundation }» Basic Settings » Define Logical Systems 3.

o (Optional) An SAP Business Warehouse system that contains data generated using SAP Planning for
Retail, rapid deployment solution. We recommend that you use the SAP Merchandise Planning for Retail
application, included in SAP Customer Activity Repository retail applications bundle.

e Dataisimported from SAP Retail or SAP S/4HANA into:
© SAP_ECCand SAP_SH4 schemas using SAP LT Replication Server (SLT), and
o DDF, using the DRFOUT data replication framework, and is persisted in SAP_DDF Schema (subset of data)

Common Installation Guide CARAB 2.0
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Figure 2: SAP Assortment Planning for Retail Standalone Deployment

2.2.2.3 SAP Assortment Planning for Retail Co-Deployed

with SAP Retail or SAP S/4HANA

This deployment option has the following key characteristics:

SAP Assortment Planning for Retail is co-deployed with SAP Retail and/or SAP S/4HANA (see the
Prerequisites [page 32] section for information on supported enhancement packages) on the same SAP
HANA Platform but on a different SAP NetWeaver stack.

SAP Assortment Planning for Retail supports a single or multiple SAP Retail (SAP ERP) and/or SAP S/4HANA
source system(s). These systems do not needs to have the same versions installed (for example, one source
system can be SAP ERP EPH7, while another system can be S/4HANA). Data from connected SAP Retail and
SAP S/4HANA systems is stored in different database schemas, accessed by SAP Assortment Planning for
Retail.

You define the source systems in Customzing under |» Cross-Application Components » Demand Data
Foundation j Basic Settings » Define Logical Systems

Since SAP Assortment Planning for Retail and SAP Retail and/or SAP S/4HANA share the same SAP HANA
Platform, SLT replication of data from SAP Retail and/or SAP S/4HANA is not required. SAP Assortment
Planning accesses SAP Retail and/or SAP S/4HANA data directly from the sap_Ecc and/or SAP_S4H
database schemas.
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Data is imported from SAP Retail and/or SAP S/4HANA into DDF using the DRFOUT data replication
framework and is persisted in SAP_ DDF Schema.
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Figure 3: SAP Assortment Planning for Retail Co-Deployed with SAP Retail and/or SAP S/4HANA

2.2.2.4 SAP Assortment Planning for Retail Co-Deployed

with SAP BW

This deployment option has the following key characteristics:

24

SAP Assortment Planning for Retail is co-deployed with SAP Business Warehouse on the same SAP HANA
Platform but on a different SAP NetWeaver stack.

Furthermore, SAP Assortment Planning for Retail supports a single or multiple SAP Retail (SAP ERP) and/or
SAP S/4HANA source system(s). These systems do not needs to have the same versions installed (for
example, one source system can be SAP ERP EPH7, while another system can be S/4HANA). Data from
connected SAP Retail and SAP S/4HANA systems is stored in different database schemas, accessed by SAP
Assortment Planning for Retail.

You define the source systems in Customzing under |» Cross-Application Components » Demand Data
Foundation » Basic Settings » Define Logical Systems

Data is imported from SAP Retail or SAP S/4HANA into:

0 SAP_ECCand SAP_SH4 schemas using SAP LT Replication Server (SLT), and

o DDF, using the bRFOUT data replication framework, and is persisted in SAP_DDF Schema (subset of data)

If you would like to integrate released merchandise planning data, this data needs to be imported into the
SAP DDF Schema. You canimport merchandise planning data from the SAP Planning for Retail, rapid
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deployment solution or the SAP Merchandise Planning for Retail application, included in SAP Customer
Activity Repository retail applications bundle (recommended).
For more information, see Configure Data Replication [page 103].

1 Note

InfoProviders and InfoObjects in SAP BW are accessed by SAP Assortment Planning for Retail using SAP
HANA views so that data stored in SAP BW can be used in SAP HANA procedures/views.
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Figure 4: SAP Assortment Planning for Retail Co-Deployed with SAP BW

2.2.3 SAP Customer Activity Repository

2.2.3.1 Common Characteristics of Landscape Variants

All SAP Customer Activity Repository landscape variants share the following common characteristics:

e SAP Customer Activity Repository is installed as part of SAP Customer Activity Repository retail applications
bundle (CAR RETAIL APPL BUNDLE), however, the application is licensed separately.
The SAP Customer Activity Repository retail applications bundle is installed as an add-on to SAP NetWeaver
Application Server for ABAP, on an underlying SAP HANA Platform.

e SAP Customer Activity Repository uses master data from a source master data system, such as SAP S/

4HANA or SAP ERP.
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SAP Customer Activity Repository uses SAP HANA content that is automatically installed when installing the
SAP Customer Activity Repository retail applications bundle (CAR RETAIL APPL BUNDLE).

SAP Customer Activity Repository has its own database schemas on the SAP HANA Platform ( SAP_CAR DB
Schema and SAP_ DDF DB Schema).

POS transactions processed by the repository are persisted in the SAP_CAR schema in the form of
transaction logs ( TLOG).

2.2.3.2 SAP Customer Activity Repository Standalone

This deployment option has the following key characteristics:

26

SAP Customer Activity Repository is deployed alongside an existing installation of one of the following:
o SAPERP6.0
o SAP S/4 HANA, on-premise edition 1610

The repository has its own database schema on the SAP HANA Platform ( SAP_CAR DB Schema).

SAP ERP data, replicated from a source SAP ERP system into the repository using trigger-based (SLT)
replication, is persisted in a separate schema ( SAP_ECC DB Schema) on the same SAP HANA Platform.

SAP ERP data required by the Demand Data Foundation (DDF) and Unified Demand Forecast (UDF) modules
in SAP Customer Activity Repository is imported from SAP ERP using the data replication framework (DRF,

transaction DRFOUT). For more information, see http://help.sap.com/carllr <your release> » Application
Help » Demand Data Foundation j» Integration Information » Master Data Replication from SAP ERP to
Demand Data Foundation 3.
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Figure 5: SAP Customer Activity Repository Standalone Deployment

2.2.3.3 SAP Customer Activity Repository Co-Deployed with
a Source Master Data System

This deployment option has the following key characteristics:

e SAP Customer Activity Repository is co-deployed with a source master data system on the same SAP HANA
Platform, but on a different SAP NetWeaver stack.
See the Prerequisites [page 32] section for information on supported releases.

e SLT replication of data from a source master data system is not required. SAP Customer Activity Repository
accesses data directly from the SAP_ECC or SAP_S4H database schemas.
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Figure 6: SAP Customer Activity Repository Co-Deployed with a Source Master Data System

This deployment option provides the following advantages:

No SLT replication is required from SAP ERP to SAP Customer Activity Repository. The repository uses virtual
data models to consume data directly (without SLT replication) from SAP ERP tables stored on the shared
SAP HANA Platform.

There are no technical dependencies or limitations between the individual SAP NetWeaver stacks used by
SAP Customer Activity Repository and SAP ERP.

Only one single SAP HANA Platform is required.

However, this deployment option has the following disadvantages:

28

Because the SAP HANA Platform is shared by two large applications (SAP Customer Activity Repository and
SAP ERP), the size of the required SAP HANA Platform increases substantially.

Because data is not replicated from SAP ERP to the repository, there is no opportunity to apply
transformation rules to correct any potential differences in SAP client numbers. As a result, the SAP client
numbers of the source SAP ERP system and of the SAP Customer Activity Repository system must match.
For more information, see Set Up SAP Client [page 47].
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2.2.3.4 SAP Customer Activity Repository Co-Deployed with
SAP BW

This deployment option has the following key characteristics:

e SAP Customer Activity Repository is co-deployed with SAP Business Warehouse on the same SAP HANA
Platform, but on a different SAP NetWeaver stack
See the Prerequisites [page 32] section for information on supported releases.

e SLTreplication of data from a source master data system is not required. SAP Customer Activity Repository
accesses data directly from the SAP_ECC or SAP_S4H database schemas.
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Figure 7: SAP Customer Activity Repository Co-Deployed with SAP BW

2.2.4 SAP Merchandise Planning for Retail

2.2.4.1 Common Characteristics of Landscape Variants

All SAP Merchandise Planning for Retail landscape variants share the following common characteristics:

e SAP Merchandise Planning for Retail is a consuming application of SAP Customer Activity Repository.
In turn, SAP Customer Activity Repository is installed as an add-on to SAP NetWeaver Application Server for
ABAP, on an underlying SAP HANA Platform.
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e SAP Merchandise Planning is installed as part of SAP Customer Activity Repository retail applications bundle
(product version CAR RETAIL APPL BUNDLE 2.0).However, the application is licensed separately.

e SAP Merchandise Planning for Retail uses SAP HANA content that is automatically installed when installing:
o SAP Customer Activity Repository retail applications bundle (CAR RETAIL APPL BUNDLE 2.0),
including:
© Demand Data Foundation module in SAP Customer Activity Repository ( RTL.DDF software
component)
o  SAP Customer Activity Repository ( RTLPOSDM and RTLCAR software components)
o Syndication Layer ( RTLCONS software component)
o SAP Merchandise Planning for Retail (RTLAPPS software component)
® SAP Merchandise Planning for Retail has its own database schema on the SAP HANA Platform ( SAP_RAP DB
Schema) in addition to the schemas of SAP Customer Activity Repository software components ( SAP_DDF
DB Schema, SAP_CAR DB Schema).

e SAP Merchandise Planning for Retail accesses master data from Demand Data Foundation: Data is imported
to the DDF module in SAP Customer Activity Repository from an SAP ERP system using the DRFOUT data
replication framework.

2.2.4.2 SAP Merchandise Planning for Retail Standalone

This deployment option has the following key characteristics:

e SAP Merchandise Planning for Retail is deployed alongside an existing installation of the following:
o SAPERP
e Dataisimported from SAP ERP into the following:
o SAP HANA Live for SAP ERP, using SAP LT Replication Server (SLT), and is persisted in SAP_ECC
Schema, and

o DDF, using the DRFOUT data replication framework, and is persisted in SAP_DDF Schema (subset of data)

2.2.4.3 SAP Merchandise Planning for Retail Co-Deployed
with SAP ERP

This deployment option has the following key characteristics:

e SAP Merchandise Planning for Retail is co-deployed with SAP ERP on the same SAP HANA Platform but on a
different SAP NetWeaver stack.

e Since SAP Merchandise Planning for Retail and SAP ERP share the same SAP HANA Platform, SLT replication
of data from SAP ERP is not required. SAP Merchandise Planning accesses SAP ERP data directly from the
SAP ERP database schema ( sapP_ECC DB Schema).

e Dataisimported from SAP ERP into DDF, using the DRFOUT data replication framework and is persisted in
SAP DDF Schema.

Common Installation Guide CARAB 2.0
30 CUSTOMER Planning



2.2.4.4 SAP Merchandise Planning for Retail Co-Deployed
with SAP BW

This deployment option has the following key characteristics:

SAP Merchandise Planning for Retail is co-deployed with SAP Business Warehouse on the same SAP HANA
Platform but on a different SAP NetWeaver stack.

e Dataisimported from SAP ERP into:

o SAP HANA Live for SAP ERP, using SAP LT Replication Server (SLT), and is persisted in SAP_ECC
Schema, and

Demand Data Foundation, using the DRFOUT data replication framework. and is persisted in SAP_DDF
Schema (subset of data)

Common Installation Guide CARAB 2.0

Planning CUSTOMER 31



3 Prerequisites

This section lists all the prerequisite platforms, applications, and components that must be installed and
configured during an initial installation of this release.

1 Note

If you are upgrading from a previous release, you must not follow this Common Installation Guide and rather
proceed with the Common Upgrade Guide.

For your convenience, the prerequisites are presented to you in two categories:

e common prerequisites, which must be installed regardless of the business scenario you are planning to
implement

e application-specific prerequisites, which are only relevant for specific retail applications under specific
conditions

1 Note

The prerequisites should be installed and configured by an experienced SAP Basis administrator.
Documentation and support for each prerequisite is available on the SAP Help Portal and the SAP Service
Marketplace.

Common Prerequisites

1. SAP HANA Platform

o SAP HANA database component: The minimum requirement for this release is the last available SAP
HANA Maintenance Revision for SAP HANA database SPS 12, regardless of the business scenario you
are planning to implement. For more information, see SAP Note 2021789#% and consult the information
under Last Available Maintenance Revision in SPS. SAP strongly recommends always using the latest SAP
HANA Maintenance Revision of the same Support Package Stack.

o SAP HANA AFL component: The minimum requirement for this release is the SAP HANA AFL revision
that is compatible with the selected SAP HANA database revision, regardless of the business scenario
you are planning to implement. For each AFL revision that is available for download, the compatible SAP
HANA database revision is indicated directly on the SAP Support Portal.

For guidance on selecting a revision for this release, see the Download and Install the Application Function
Library (AFL) section in Install SAP Customer Activity Repository Retail Applications Bundle [page 44].
For installation information, see SAP Notes 2354063 % and 2339267 #, as well as http://help.sap.com/
hana_platforml|r SAP HANA Platform SPS 12 » Installation and Update » SAP HANA Server Installation and
Update Guide .

2. SAP NetWeaver
The minimum requirement for this release is SAP NetWeaver 7.50 SPS 04, regardless of the business
scenario you are planning to implement.
You must install SAP NetWeaver prior to installing other back-end components.
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For installation information, see http://help.sap.com/nw75|p Installation and Upgrade Information »
Installation Guide 3.

3. SAP Landscape Transformation Replication Server
The minimum requirement for this release is SAP Landscape Transformation Replication Server for SAP
HANA 2.0, regardless of the business scenario you are planning to implement.
For installation information, see http://help.sap.com/hanalr SAP HANA Options  SAP HANA Real-Time
Replication » SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server ¥ Installation and

Upgrade Information .

4. SAP Fiori
The minimum requirement for this release is SAP FIORI FRONT-END SERVER 2.0 SPS4, regardless of the
business scenario you are planning to implement.
For installation information, see SAP Notes 2219596 /%, 2327935/ , and 2169917#% , as well as http://
help.sap.com/fiori_implementation [ App Implementation Information 3.

5. SAP RTL AFL FOR SAP HANA 200
The minimum requirement for this release is the SAP RTL AFL FOR SAP HANA 200 revision that is
compatible with the selected SAP HANA database revision, regardless of the business scenario you are
planning to implement. For each AFL revision that is available for download, the compatible SAP HANA
database revision is indicated directly on the SAP Support Portal.
For installation information, see Install SAP Customer Activity Repository Retail Applications Bundle [page
44].

1 Note

Software component version SAP RTI, AFI, FOR SAP HANA 200 is available as of SAP Customer Activity
Repository retail applications bundle 2.0. It contains back-end functionality for two modules in SAP
Customer Activity Repository: Unified Demand Forecast and On-Shelf Availability.

The installation of the component is always mandatory, regardless of the business scenario you are
planning to implement.

The implementation of Unified Demand Forecast or On-Shelf Availability functionality, however, depends
on your business scenario:
o Unified Demand Forecast
o Mandatory implementation for: SAP Promotion Management for Retail (only for what-if forecasts)
o Optional implementation for: SAP Allocation Management for Retail, SAP Assortment Planning for
Retail, SAP Merchandise Planning for Retail
o On-Shelf Availability
Optional implementation for: SAP Allocation Management for Retail, SAP Assortment Planning for
Retail, SAP Merchandise Planning for Retail, SAP Promotion Management for Retail
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Application-Specific Prerequisites

SAP Customer Activity Repository

Table 15: Prerequisites for SAP Customer Activity Repository

Product Prerequisite Version Mandatory/Optional Installation Information
SAP ERP The minimum requirement You must install a source http://help.sap.com/erp
for this release is one of the master data system; either |} <your release> >
following: SAP ERP or SAP S/4HANA Installation and Upgrade
* SAPERP6.0Enhance- | Mt be installed. Information # Installation
ment Package 4 is man- Guide }
datory at a bare mini-
mum if installing but not
implementing DDF and
UDF.
e SAPERP 6.0 Enhance-
ment Package 5 is man-
datory when implement-
ing SAP Customer Activ-
ity Repository with its
DDF and UDF modules.
e SAPERP 6.0 Enhance-
ment Package 7 or
higher is mandatory if
implementing the SAP
Customer Activity Repo-
sitory Co-Deployed with
a Source Master Data
System [page 27] sys-
tem landscape.
The following prerequisites
apply if you want to imple-
ment the Omnichannel Article
Availability and Sourcing
functionality within SAP Cus-
tomer Activity Repository:
e SAPERP 6.0 Enhance-
ment Package 7 SPS 13
or SAP ERP 6.0 Enhance-
ment Package 8 SPS 4
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Prerequisite Version

Mandatory/Optional

Installation Information

SAP S/4HANA, on-premise
edition

SAP S/4HANA, on-premise
edition 1610

You must install a source
master data system; either
SAP ERP or SAP S/4HANA
must be installed.

http://help.sap.com/s4hana
|} SAP S/4HANA, on-premise
edition 1610 > Product

Documentation > Installation

Guide 3

SAP CRM

The minimum requirement
for this release is one of the
following:

e SAP Enhancement Pack-
age 2 for SAP CRM 7.0

e SAP Enhancement Pack-
age 2 for SAP CRM 7.0,
Version for SAP HANA or
higher

Optional, depending on
whether or not you choose to
implement customer determi-
nation with SAP CRM.

http://help.sap.com/crm

I <your release> »
Installation and Upgrade

Information ¥ Installation

Guide 3

SAP Smart Business

SAP Smart Business founda-
tion component 1.0 SPS 03

Optional, depending on
whether or not you choose to
implement the SAP Smart
Business for Multichannel
Sales Analytics dashboard
within SAP Customer Activity
Repository.

SAP Note 2018360

SAP Hybris Marketing SAP Hybris Marketing 1.10 or | Optional, depending on http://help.sap.com/mkt
higher whether or not you choose to |b <your release> >
implement customer determi- | ;<2 11ation and Upgrade
nation with SAP Hybris Mar-
) Information > Installation
keting.
Guide 3
SAP Hybris Commerce SAP Hybris Commerce 6.2 or | Optional, depending on http://help.hybris.com

higher (in particular, the Ac-
celerator, the Data Hub and
SAP Asynchronous Order
Management)

whether or not you choose to
implement the Omnichannel
Article Availability and
Sourcing functionality or the
Omnichannel Promotion
Pricing functionality within
SAP Customer Activity Repo-
sitory.

|} <Main Menu> > Installing
and Migrating Hybris 4
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Prerequisite Version

Mandatory/Optional

Installation Information

SAP Hybris Commerce, inte-
gration package for SAP for
Retail

SAP Hybris Commerce, inte-
gration package for SAP for
Retail 2.2 or higher

Optional, depending on
whether or not you choose to
implement the Omnichannel
Article Availability and
Sourcing functionality or the
Omnichannel Promotion
Pricing functionality within
SAP Customer Activity Repo-
sitory.

See the Administrator Guide
delivered with the software
package.

SAPIQ SAP1Q 16.0, SP8 or higher Optional, depending on http://help.sap.com/iql608
whether or not you choose to |} Installation and Upgrade
use the Table Content Aging

Inf ti Installati
report to move data from SAP nrormation > nstatiation
Customer Activity Repository | Guides 3
to SAPIQ.

SAP HANA Dynamic Tiering SAP HANA Dynamic Tiering is | Optional, depending on http://help.sap.com/

delivered with the SAP HANA | whether or not you choose to | hana_options_dt
Platform. See Common Pre- | use the Table Content Aging |p installation and Update 3
requisites. report to move data from SAP
Customer Activity Repository
to extended storage using
SAP HANA Dynamic Tiering.
SAP Jam SAP Jam, initial release or Optional, depending on http://help.sap.com/sapjam
higher whether or not you choose to |’ SAP Jam Collaboration
integrate social media collab- System Administration
oration functionality with SAP Int tion % Administrat
nformation ministrator
Jam.

Guide 3

SAP HANA Live for SAP ERP | SAP HANA Live for SAP ERP | Optional, depending on http://help.sap.com/hba

1.0 SPS 02 or higher whether or not you choose to |k instaliation, Security.
use the SAP Smart Business | configuration, and Operations
Apps for SAP Customer Ac-
.p.p ) Information > Administrator's
tivity Repository
Guide 3
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SAP Allocation Management for Retail

Table 16: Prerequisites for SAP Allocation Management for Retail

Product

Prerequisite Version

Mandatory/Optional

Installation Information

SAP ERP

The minimum requirement
for this release is one of the
following:

e SAPERP 6.0 Enhance-
ment Package 5 is man-
datory.

e SAPERP 6.0 Enhance-
ment Package 7 or higher
is mandatory if imple-
menting the SAP Alloca-
tion Management for Re-
tail Co-Deployed with
SAP ERP [page 20] sys-
tem landscape.

Mandatory

http://help.sap.com/erp

|} <your release> >
Installation and Upgrade

Information > Installation

Guide 3

SAP Assortment Planning for Retail

Table 17: Prerequisites for SAP Assortment Planning for Retail

Product

Prerequisite Version

Mandatory/Optional

Installation Information

SAP ERP

The minimum requirement
for this release is one of the
following:

e SAPERP 6.0 Enhance-
ment Package 5 is man-
datory.

e SAPERP 6.0 Enhance-
ment Package 7 or higher
is mandatory if imple-
menting the SAP Assort-
ment Planning for Retail
Co-Deployed with SAP
ERP [page 21] system
landscape.

You must install a source
master data system; either
SAP ERP or SAP S/4HANA
must be installed.

http://help.sap.com/erp

|} <your release> }
Installation and Upgrade

Information > Installation

Guide }

SAP S/4HANA, on-premise
edition

SAP S/4HANA, on-premise
edition 1610

You must install a source
master data system; either
SAP ERP or SAP S/4HANA
must be installed.

http://help.sap.com/s4hana
| SAP S/4HANA, on-premise
edition 1610 > Product

Documentation > Installation

Guide J
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Prerequisite Version

Mandatory/Optional

Installation Information

fice 2.3 SP3

SAP Jam SAP Jam, initial release or Optional, depending on http://help.sap.com/sapjam
higher whether or not you choose to I SAP Jam Collaboration
integrate social media collab- System Administration
oration functionality with SAP
Information > Administrator
Jam.
Guide 3
SAP BusinessObjects Analy- | SAP BusinessObjects Analy- | Mandatory http://help.sap.com/boao
sis sis, edition for Microsoft Of-

|} <your release> >
Installation, Configuration,
Security, and Administration

Information > Administrator's

Guide 3

SAP Merchandise Planning for Retail

Table 18: Prerequisites for SAP Merchandise Planning for Retail

Product Prerequisite Version Mandatory/Optional Installation Information
SAP ERP The minimum requirement for | Mandatory http://help.sap.com/erp
this release is one of the fol- |’, <your release> >
lowing: Installation and Upgrade
® SAPERP6.0 Enhance- Information } Installation
ment Package 5 is man- Guide
datory.
e SAPERP 6.0 Enhance-
ment Package 7 or higher
is mandatory if imple-
menting the SAP Mer-
chandise Planning for Re-
tail Co-Deployed with
SAP ERP [page 29] sys-
tem landscape.
SAP Jam SAP Jam, initial release or Optional, depending on http://help.sap.com/sapjam
higher whether or not you choose to |+ sAP Jam Collaboration
integrate social media collab- System Administration
oration functionality with SAP ) N
Jam. Information @ Administrator
Guide J
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Prerequisite Version

Mandatory/Optional

Installation Information

SAP BusinessObjects Analy-
sis

SAP BusinessObjects Analy-
sis, edition for Microsoft Of-
fice 2.3 SP3

Mandatory

http://help.sap.com/boao

|} <your release> >
Installation, Configuration,
Security, and Administration

Information ¥ Administrator's

Guide 3

SAP Promotion Management for Retail

Table 19: Prerequisites for SAP Promotion Management for Retail

Product

Prerequisite Version

Mandatory/Optional

Installation Information

SAP ERP

SAP ERP 6.0 Enhancement
Package 5

Mandatory

http://help.sap.com/erp

|} <your release> >
Installation and Upgrade

Information > Installation

Guide 3

SAP S/4HANA, on-premise
edition

SAP S/4HANA, on premise
edition 1610

You must install a source
master data system; either
SAP ERP or SAP S/4HANA
must be installed

http://help.sap.com/s4hana
| SAP S/4HANA, on-premise
edition 1610 * Product

Documentation ¥ Installation

Guide 3

SAP Jam

SAP Jam, initial release or
higher

Optional, depending on
whether or not you choose to
integrate social media collab-
oration functionality with SAP
Jam.

http://help.sap.com/sapjam

|\ SAP Jam Collaboration
System Administration

Information > Administrator

Guide J
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4 Preparation

4.1 SAP Assortment Planning for Retail

4.1.1 Verify SAP HANA Users and Privileges

Use

The SAP Assortment Planning for Retail application requires a layered system landscape. As an assortment
planner or planning administrator, you must assign the necessary users, roles and authorizations in all of the
levels of the SAP Assortment Planning for Retail application.

SAP NetWeaver Gateway (Front-End Server)

User, roles, groups, and catalogs required to use the collection of SAP Fiori apps that form
the S54P Assortment Planning for Retail application userinterface.

ABAP Back-End Server

User and roles to access the relevant Customizing activities and use core SAP Assortment
Planning for Retail application functionality.

— T
— ——

SAP HANA Database

Users and privileges allowing the SAP Assortment Planning for Retail application to access
SAP HAMA views and procedures, which provide access to data and functionality directly
on the database level,

\ /

Figure 8: Authorization Levels

This procedure lists the required database users and privileges shown as level 1 in the diagram above. These are
roles and privileges that you can set up in the database before installing SAP Assortment for Retail on the back-
end or front-end systems.

Common Installation Guide CARAB 2.0
40 CUSTOMER Preparation



Back-end, level 2 authorizations, are described in the Verify Users, Privileges, and Roles section of the Common
Installation Guide. Front-end, level 3 authorizations, are described in the Assign Roles, Catalogs, and Groups in
SAP Fiori Launchpad section of the Common Installation Guide.

Procedure

1. Ensure that the SAP HANA database users listed below exist and that they have the required roles/privileges.

Table 20:

User

SAP<SID>

This is the generic database user
specified for the connection from the
SAP NetWeaver back-end server to

o

Role/Privilege

System privilege REPO. IMPORT
System privilege ROLE ADMIN
System privilege STRUCTUREDPRIVILEGE ADMIN

Role CONTENT ADMIN

the SAP HANA database. o Role AFLPM CREATOR ERASER EXECUTE.For more information, see Enable
Usage of PAL Functions [page 42] and SAP Note 2046767 ¥ .
© RoleAFL SYS AFL OFL_AREA EXECUTE
SYS REPO o Privilege SELECT, with option "Grantable to others", on the following physical

_SYS REPO WITH GRANT OPTION;

DB schemas:
o Physical database schema of your back-end system, typically this is
called SAP<SID>
o Physical database schema that contains the SAP Retail or SAP S/
4HANA tables
o Physical database schema that contains the SAP CRM tables
You can use the following example SQL statement to grant the required privi-
lege:
GRANT SELECT ON SCHEMA <Your schema name> TO

Privileges described in http://help.sap.com/carl} <your release> >
Security Information > Security Guide > Authorization Requirements for the

UDF AFL 4.

<Your User Name>*

Privilege SELECT on schema sSyS BI
Privilege SELECT on schema SAP<SID>

Privilege EXECUTE on procedure REPOSITORY REST

*Your user on SAP HANA database level,
be identical on these three levels.

back-end system, and on the front-end server (SAP NetWeaver Gateway) must
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4.1.2 Configure AFL Usage
4121 Activate SAP HANA Script Server

Use

Once all the required AFLs are installed, as listed in the Prerequisites section, ensure that you have activated the
script server for the SAP HANA database.

Procedure

Read and implement SAP Note 1650957 ¥ .

412.2 Enable Usage of PAL Functions

Use

The installation of SAP HANA Platform includes the installation of the PAL algorithm, a prerequisite for SAP
Assortment Planning for Retail.

To enable the usage of the PAL algorithm, as required by SAP Assortment Planning for Retail, perform the
following procedure.

Procedure

1. Ensure that the SAP<SID> user has the role AFLPM CREATOR ERASER EXECUTE as described in Verify SAP
HANA User and Privileges [page 40] and SAP Note 2046767 #r .
This role must be assigned to execute functions of the PAL library. In the case of SAP Assortment Planning for
Retail, this role is necessary for the assortment planner to use smart clustering in the Manage Location
Clusters SAP Fiori app.
You do not need to create the AFL. WRAPPER GENERATOR Or AFL_WRAPPER ERASER procedures, nor do you
need to generate any special PAL procedures; this is done automatically.
2. To confirm that the PAL functions were installed successfully, you can run SELECT statements in the three
relevant public views as follows:
© SELECT * FROM SYS.AFL AREAS WHERE AREA NAME = 'AFLPAL'
© SELECT * FROM SYS.AFL PACKAGES WHERE AREA NAME = 'AFLPAL'

© SELECT * FROM SYS.AFL_FUNCTIONS WHERE AREA NAME = 'AFLPAL'
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More Information

® Prerequisites section

e http://help.sap.com/hana_platforml References » SAP HANA Predictive Analysis Library (PAL) Reference 3

41.2.3 Check the OFL Installation

Use

The installation of SAP HANA Platform includes the installation of the OFL algorithm, a prerequisite for SAP
Assortment Planning for Retail.

Procedure

1. Toconfirm that the OFL was installed successfully, you can run SELECT statements in the three relevant
public views as follows:
© SELECT * FROM SYS.AFL AREAS WHERE AREA NAME = 'OFL_AREA'
© SELECT * FROM SYS.AFL PACKAGES WHERE AREA NAME = 'OFL_AREA'
© SELECT * FROM SYS.AFL FUNCTIONS WHERE AREA NAME = 'OFL_AREA'
In the case of a successful installation, each of statements should return 1 row.

More Information

Prerequisites section
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5 Installation

5.1 Install Prerequisites and SAP Notes

Before proceeding with the installation, ensure that you have installed and configured all the prerequisites specific
to your implementation scenario, as described under Prerequisites [page 32].

Furthermore, you need to verify that all of the SAP Notes required for your scenario have been implemented, as
described under SAP Notes for the Installation [page 6].

5.2 Install ABAP Back-End Server

5.2.1 Install SAP Customer Activity Repository Retail
Applications Bundle

Use

You use the Maintenance Planner tool to plan your system landscape and generate a stack XML file based on the
required product versions. You then install or upgrade components based on this stack XML file using the
Software Update Manager (SUM) tool.

Caution

Note that it may be possible to install or upgrade components using the SAP Add-On Installation Tool as an
alternative, but this alternative procedure is not described in this guide. For more information on whether this is
possible for your implementation scenario and on how to proceed, see SAP Note 1803986 .

For more information about Maintenance Planner, see SAP Help Portal at http://help.sap.com/
maintenanceplanner.

Create the Stack XML Using Maintenance Planner

1. Consult SAP Note 2377015#% . This is the Release Information Note (RIN) for SAP Customer Activity
Repository retail applications bundle 2.0. It provides up-to-date information on the current release, together
with a list of important SAP Notes that you must apply to complete the installation process.

2. Loginto the Maintenance Planner tool at https://support.sap.com# |» Keys, Systems & Installations »
Maintenance Planner 3.
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. Choose Plan a New System.
. Choose Plan.
. Choose a system type and enter a three-character system ID.

3

4

5

6. Choose Install an SAP NetWeaver System.

7. Select avalid product version (for example, SAP NETWEAVER 7.5) and a valid support package stack.

8. Select avalid instance (for example, Application Server ABAP).

9. Choose Confirm Selection.

10. Choose Install or Maintain an Add-On..

11. Selectthe CAR RETAIL APPL BUNDLE 2.0 back-end productversionandthe Initial Shipment Stack
instance.

12. Selectthe CAR Retail Appl Bundle NW 750 instance.

13. Choose Confirm Selection.

14. Choose Next.

15. Select the operating system and database for your implementation scenario.

16. Choose Confirm Selection.

17. Review the details of your stack dependent and independent files, then choose Next.

18. Choose Download Stack XML.

Download and Install the Stack XML Using Software Update Manager (SUM)

The Software Update Manager (SUM) tool installs your add-on product using the stack XML file created during
the previous procedure.

For detailed instructions on using the SUM tool for your specific operating system/platform and database, see
http://support.sap.com/sltoolset | System Maintenance » Software Update Manager (SUM) 1.0 <your SP> »
Guides for SUM 1.0 <your SP> 1.

You have now completed the stack XML installation. To finalize the installation of the back-end product version,
you must additionally do some manual steps. Continue with the next section.

Download and Install the Application Function Library (AFL)

There is one software component that you cannot install with Maintenance Planner and SUM: SAP RTL AFL FOR
SAP HANA 200. This AFL component is available as of SAP Customer Activity Repository retail applications
bundle 2.0. It contains back-end functionality for two modules in SAP Customer Activity Repository:

e Unified Demand Forecast (UDF, provides the demand modeling and forecasting services, the application
functions run directly in the SAP HANA database)

e On-Shelf Availability (provides the On-Shelf Availability services, the application functions run directly in the
SAP HANA database)

You need to download a revision of SAP RTI, AFL FOR SAP HANA 200 andinstallitin your SAP HANA database
as described in the following.
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Dependencies Between AFLs and the SAP HANA Database

For a successful installation, you need to be aware of the following dependencies:

The AFL is released independently of the releases of SAP Customer Activity Repository retail applications bundle.
This is because the AFL follows the release cycle of the SAP HANA database. The releases are called “revisions™.
Whenever a new revision of the SAP HANA database is released, a new revision of the AFL is released. As a result,
multiple revisions of the AFL are available on the SAP Support Portal at any one time.

Caution

For each revision of an AFL, there is only one compatible revision of the SAP HANA database. Whenever you
upgrade the AFL, you must also upgrade the database and any other AFLs to the compatible revisions.
Reversely, whenever you upgrade the database, you must upgrade the AFLs.

This dependency applies not only to SAP RTL AFL FOR SAP HANA but also to the generic SAP HANA AFL.
The SAP HANA AFL and the SAP HANA database are components of the SAP HANA Platform (see
Prerequisites).

When you download an AFL revision from the SAP Support Portal, the compatible revision of the SAP HANA
database is always indicated for your convenience.

You can easily see the dependencies by looking at the release numbers:

Table 21: Release Nomenclature

Release of ... Released as ... Example Guideline

SAP HANA Platform <Support Package Stack> SAP HANA Platform SPS 12 The number of the support
package stack determines
the first digits of the revi-

sions.

SAP HANA Database <Revision>.<Patch> SAP HANA Database 122.04 | All 12x.xx database revisions
belong to SPS 12.

SAP RTL AFL FOR SAP HANA | <Revision>.<Patch> SAP RTL AFL FOR SAP HANA | The database patch deter-

SAP HANA AFL 122. 4x mines the first digit of the
AFL patch.

SAP HANA AFL 122.4x

Download and Install SAP RTL AFL FOR SAP HANA 200

1. Select arevision for the SAP HANA database and the AFL components.
Multiple revisions are available on the SAP Support Portal. To select the best revision for your scenario, see
the following:

o SAP Note 23770154 : This is the Release Information Note (RIN) for SAP Customer Activity Repository
retail applications bundle 2.0. Consult this note for up-to-date information on the current release.

o Prerequisites: This section indicates the minimum revision of the SAP HANA database and the AFL
components. You need at least this revision for the current release.

o If you want to use a higher revision for your scenario, select one of the “Datacenter Service Point (DSP)”
revisions. These are specially verified revisions, which you can find listed in SAP Note 2021789 . If you
want to know more about DSPs, see the SAP HANA Revision Strategy document linked from the note.

o SAP Note 1948334#%: This note lists the supported database update paths for SAP HANA Maintenance
Revisions. Consult this note for valid revision combinations for your scenario.
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For more information on the release and maintenance strategy of the SAP HANA Platform, see http://
support.sap.com/swdc# | Software Downloads » By Alphabetical Index (A-Z) # H % SAP HANA PLATFORM

EDITION » SAP HANA PLATFORM EDIT. 1.0 ¥ Support Packages and Patches j# Info 3.
Once you have selected a revision, this gives you the compatible revisions of the other components.

2. Locate the compatible revisions on the SAP Support Portal:
O SAP RTL AFL FOR SAP HANA 200:
This component is provided as part of the CAR RETAIL APPL BUNDLE 2.0 back-end product version.

You can find it at http://support.sap.com/swdc# |+ Software Downloads * By Alphabetical Index (A-Z)
» C» CARRETAIL APPLICATIONS BUNDLE » CAR RETAIL APPL BUNDLE 2.0 » Support Packages and
Patches » DOWNLOADS » COMPRISED SOFTWARE COMPONENT VERSIONS » SAP RTL AFL FOR SAP
HANA 200 3.

O SAP HANA AFL and SAP HANA DATABASE:
These components are provided as part of the SAP HANA Platform. You can find them at http://

support.sap.com/swdc# | Software Downloads By Alphabetical Index (A-Z) » H i SAP HANA
PLATFORM EDITION » SAP HANA PLATFORM EDIT. 1.0 » Support Packages and Patches » DOWNLOADS

> HANA AFL 1.
o |If applicable, other AFLs provided with the SAP HANA Platform that might be relevant for your scenario.
3. Install all AFLs together as described in SAP Note 2377894 # .

1 Note

o |f you want to use the UDF functionality in your scenario, you must additionally do some post-
installation steps. For more information, see Configure Unified Demand Forecast (Optional) [page
154].

o |If you want to use the On-Shelf Availability functionality in your scenario, you must additionally do
some post-installation steps. For more information, see Configure On-Shelf Availability (Optional)
[page 140].

Result

You have successfully installed the CAR RETAIL APPL BUNDLE 2.0 back-end product version. Continue with
the next section.

5.2.2 Set Up SAP Client

Use

In this procedure, you set up a client on your back-end system.
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Procedure for SAP Assortment Planning for Retail or SAP Merchandise
Planning for Retail Scenarios

1. Create the necessary client on your back-end system using client maintenance transaction (scc4).

Caution

If you are performing a client copy, you should only perform the client copy after a successful import of all
related software components. Also, you should only import or transfer Customizing tables after this client
copy is complete, as described in SAP Note 337623 .

2. Specify settings in the Define Logical Systems Customizing activity under |+ SAP Customizing Implementation
Guide ¥ Cross-Application Components # Demand Data Foundation ¥ Basic Settings 3.

1 Note

This option also defines your multiple ERP clients if required, or if you are using a S4/HANA environment.
Review the activity documentation to verify your selection.

Procedure for All Other Scenarios

1. Verify the client numbers in the source SAP Retail or SAP S/4HANA system and in the source systems of
optional products you wish to implement with SAP Customer Activity Repository (such as SAP CRM and SAP
Hybris Marketing).

This installation includes SAP HANA content that provides views on a combination of client-dependent data
authored in these source SAP systems. For instance, sales documents are created in a source SAP Retail
system and are replicated to the repository. Likewise, customer information can be optionally replicated from
a source SAP CRM or SAP Hybris Marketing system.

2. Create the necessary client on your back-end system using client maintenance transaction (scc4).

Caution

If you are performing a client copy, you should only perform the client copy after a successful import of all
related software components. Also, you should only import or transfer Customizing tables after this client
copy is complete, as described in SAP Note 337623

If using the same client number is not possible due to the specifics of your implementation and client setup
rules, you must use SLT transformation rules before replicating data to transform the source SAP Retail or
SAP S/4HANA, and optionally, the source SAP CRM or SAP Hybris Marketing, client(s) to match the client on
your back-end system.

Example

If SAP Retail and SAP CRM (or SAP Hybris Marketing) are set up on client 100 in your implementation, you
should also set up your installation on client 100. If, for any reason, you are unable to do so, you can
transform the source client to 100 using SLT transformation rules.
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Cross-system information is client-dependent. As a result, it is required to use the SAP Client (MANDT)
attribute as one of the join attributes in the SAP HANA views to combine cross-system sales and master data.
All data (whether created or replicated) must be affiliated with the same client number.

More Information

For more information, see http://help.sap.com/nw75|p Application Help  Function-Oriented View  Application
Server » Application Server ABAP » Other Services ¥ Services for Administrators j» Client Concept 3.

5.2.3 Create/Replicate Source Master Data System Tables

Create, and optionally replicate, SAP Retail (SAP ERP) and/or SAP S/4HANA tables required for your scenario.

Context

In this procedure, you can decide whether to:

e Simply create the list of tables that is required to activate the SAP HANA Content required by your
implementation scenario. This will allow you proceed with the installation without replicating data from source
systems.

1 Note

If you are planning to implement SAP Smart Business for Multichannel Sales Analytics, you will also need
to create the tables required for SAP HANA Live for SAP ERP. For more information, see the Install SAP
HANA Live for SAP ERP section in the Common Installation Guide.

e Replicate the list of tables that is required by your implementation scenario. This will allow you to activate the
SAP HANA content and immediately replicate data from the source systems. This is recommended for
shortened installation projects.

The tables to create and/or replicate depend on your source master data system:

e SAP Retail: SAP Note 2385706, for installations based on the SAP_ECC schema
e SAP S/4HANA: SAP Note 2388669#% , for installations based on the SAP_S4H schema

Procedure

1. Ensure that the SAP Landscape Transformation component (SAP LT Replication Server) is installed.

2. Configure access from the SAP LT Replication Server to the source SAP Retail or SAP S/4HANA system (RFC
connection) and from SAP LT Replication Server to the target SAP HANA database.
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http://help.sap.com/hanalr SAP HANA » SAP HANA Options » SAP HANA Real-Time Replication » SAP
HANA Trigger-Based Data Replication Using SAP LT Replication Server ¥ System Administration and
Maintenance Information » ( <Technical Prerequisites and Authorization Aspects>and
<Accessing the Configuration and Monitoring Dashboard>) 1

3. Ensure that your back-end system is connected to SAP HANA studio.

If necessary, set the connection as follows:

1. Logonto SAP HANA studio.
2. Right-click in the Navigator pane and select Add System.
3. Enter the required information the Specify System dialog:
o Host Name
o Instance Number
o System Description
4. Specify your system User Name and Password in the Connection Properties dialog.

4. Ensure that a database catalog schemas are created on the target SAP HANA database. These are the
schemas on your SAP HANA database to which the SAP Retail and/or SAP S/4HANA data will be replicated.

For more information, see: http://help.sap.com/hana_platform|p Development and Modeling » SAP HANA
Developer Guide j Setting up the Persistence Model ¥ Creating the Persistence Model with HDBTable
Creating a Schema 3

5. If necessary, map the authoring schema(s) to your particular physical database schema(s).

For more information, see: http://help.sap.com/hana_platform|p Development and Modeling » SAP HANA
Modeling Guide » Importing Table Definitions and Data » Map Authoring Schema to the Physical Schema J.
6. Create the tables that are required for your scenario. If you want to immediately replicate the tables
required by your scenario, proceed to the next step.
1. Logontothe SAP SLT Replication server.
2. Calltransaction LTRC.
3. Define and select your replication configuration.
For more information, see http://help.sap.com/hana_platformhttp://help.sap.com/sapslt20-spll
| Application Help » Replicating Data to SAP HANA ¥ Replicating Data from ABAP-Based SAP Systems to
SAP HANA » Creating a Configuration 4
Press "Execute (F8)". The next screen will show the details of this replication configuration.
Select the "table overview" tab. On top the function "data provisioning" will get visible.
Execute the function "data provisioning". On the subsequent pop-up select the function for table creation.
Press the multiple selection push button besides the table name field.

© N o ok

The following screen allows the entry of multiple table names. It also allows to upload the list of table
names from a text file. Make sure, that the text file only contains table names and no other information/
data.

9. Upload a text file with the table names and press "Copy (F8)" to return to the previous screen.
10. Press "Execute (F8)" to trigger the table creation.

7. Create the tables that are required for your scenario.

1. Create and save a CSV file of the required tables.
2. Make any necessary adjustments to remove or add tables for replication.
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3. Openthe SAP HANA Studio, select the Modeler perspective. If the Quick Launch panel does not display
by default, select Help --> Quick Launch from the main SAP HANA Studio menu.

4. Inthe Quick Launch page, under Data, select Data Provisioning to open the Data Provisioning Editor.

5. Inthe Data Provisioning Editor, select the appropriate source system as well as the target schema for
replication.

6. Select Replicate to open the Replicate Request screen.
7. Select Load from file and browse to the location where you stored the CSV file.

8. The tables in the file will be added to the Selected column on the right-side. Select Finish to continue.
In the Data Provisioning Editor, the action status of the tables can be monitored using Data Load
Management.

5.3 Install ABAP Front-End Server

5.3.1 Install ABAP Front-End Server

The ABAP front-end server contains the complete Ul layer consisting of the SAP NetWeaver Gateway, the central
SAP Fiori Ul component, and the product-specific SAP Fiori Ul component. To set up the ABAP front-end server,
proceed as described in the following sections.

5.3.1.1 Install SAP NetWeaver Gateway on the ABAP Front-
End Server

Use

The complete Ul layer consisting of the central SAP Fiori Ul component, the product-specific SAP Fiori Ul
components and the SAP NetWeaver Gateway is contained in the ABAP front-end server. SAP NetWeaver
Gateway handles the communication between the client and the ABAP back-end server. For a visualization of how
these components interact, see the Overall System Planning section in the Common Installation Guide.

When you are implementing the central hub deployment option, you use separate servers for the back-end and
front-end components in your landscape.

Procedure

1. Ensure that the necessary SAP NetWeaver version is installed on your front-end server. For more information,
see SAP Library for SAP Fiori on SAP Help Portal at http://help.sap.com/fiori_implementation|# Required
System Landscape ¥ <Your SAP NetWeaver Version> » Setup of SAP Fiori System Landscape with SAP HANA
Database ¥ Installation 3.
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5.3.1.2 Install Central SAP Fiori Ul Component
Use

The complete Ul layer consisting of the central SAP Fiori Ul component, the product-specific SAP Fiori Ul
component, and the SAP NetWeaver Gateway is contained in the ABAP front-end server. The central SAP Fiori Ul
component contains the SAPUIS control library and the SAP Fiori launchpad.

When you are implementing the central hub deployment option, you use separate servers for the back-end and
front-end components in your landscape. Your front-end server must have the required central SAP Fiori Ul
component version.

Procedure

1. Ensurethat SAP FIORI FRONT-END SERVER 2.0 SPS4isinstalled on your front-end server.
For more information, see the Prerequisites section in this guide.

5.3.1.3 Install Product-Specific SAP Fiori Ul Component

The ABAP front-end server contains the complete Ul layer, which consists of the SAP Gateway, the central SAP
Fiori Ul component, and the product-specific SAP Fiori Ul component.

Use

You use the Maintenance Planner tool to plan your system landscape and generate a stack XML file based on the
required product versions. You install or upgrade components based on this stack XML file using the Software
Update Manager (SUM) tool.

Caution

Note that it may be possible to install or upgrade components using the SAP Add-On Installation Tool as an
alternative, but this alternative procedure is not described in this guide. For more information on whether this is
possible for your implementation scenario and on how to proceed, see SAP Note 1803986 .

For more information about Maintenance Planner, see SAP Help Portal at http://help.sap.com/
maintenanceplanner.
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Create the Stack XML Using Maintenance Planner

12.
13.

14.
15.
16.
17.
18.
19.

Consult SAP Note 2377015# . This is the Release Information Note (RIN) for SAP Customer Activity
Repository retail applications bundle 2.0. It provides up-to-date information on the current release, together
with a list of important SAP Notes that you must apply to complete the installation process.

Log into the Maintenance Planner tool at https://support.sap.com# | Keys, Systems, & Installations »
Maintenance Planner 3.

Choose Plan a New System.

Choose Plan.

Choose a system type and enter a three-character system ID.

Choose Install a SAP NetWeaver System.

Select a valid product version (for example, SAP NETWEAVER 7.5) and a valid support package stack.
Select a valid instance (for example, Application Server ABAP).

Choose Confirm Selection.

. Choose Install or Maintain an Add-On..
. Selectthe SAP FIORI FOR SAP CARAB 3.0 front-end product versionand the Initial Shipment

Stack instance.

Selectthe UT for SAP CARAB 3.0 instance.

Selectthe SAP FIORI FRONT-END SERVER 3.0 productversionandthe Initial Shipment Stack
instance.

Choose Confirm Selection.

Choose Next.

Select the operating system and database for your implementation scenario.

Choose Confirm Selection.

Review the details of your stack dependent and independent files, then choose Next.

Choose Download Stack XML.

Download and Install the Stack XML Using Software Update Manager (SUM)

The Software Update Manager (SUM) tool installs your add-on product using the stack XML file created during
the previous procedure.

For detailed instructions on using the SUM tool for your specific operating system/platform and database, see
http://help.sap.com/sltoolset|r System Maintenance » Software Update Manager (SUM) 1.0 » Guides for SUM

103

You have now completed the stack XML installation. To finalize the installation of the back-end product version,
you must additionally do some manual steps. Continue with the next section.

1 Note

If you are using SAP Assortment Planning for Retail, consult SAP Note 2383938#%, which lists the SAP Notes
relevant for your release.

If you are using SAP Allocation Management for Retail, consult SAP Note 2331499#
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5.4 Install Alternate Storage (Optional)

The following section only requires implementation if you plan on using the Table Content Aging report delivered
with SAP Customer Activity Repository. This report allows you to copy your transaction log (TLOG) data and its
extensions from your SAP HANA database to an alternate storage technology such as SAP 1Q or Hadoop, thereby
reducing your total cost of hardware ownership.

For more information, see SAP Help Portal at http://help.sap.com/carl <your release> » Application Help » SAP
Customer Activity Repository » POS Data Transfer and Audit » Implementing a POS Transaction Data Storage
Strategy ¥ Using the Table Content Aging Report 3.

1 Note

When modeling and forecasting demand using the Unified Demand Forecast (UDF) module, we recommend
retaining the historical sales data in memory.

Process Flow

In order to successfully install alternate storage, you must execute the following procedures:

1. Do one of the following:
o Install and set up integration with SAP 1Q, or
o Install and set up integration with Apache Hadoop, or
o Install and set up integration with SAP HANA Dynamic Tiering
2. Create the remote source in SAP HANA studio (not applicable for integration with SAP HANA Dynamic
Tiering).
3. Create the virtual table.
4. Set the deploy mode in SAP HANA Transport for ABAP.

5.4.1 Install and Set Up Integration with SAP IQ

You use these procedures to install and set up SAP IQ to support the Table Content Aging report
(transaction /CAR/TABLE AGING) delivered with SAP Customer Activity Repository.

The SAP HANA database points to your SAP |Q database using SAP HANA smart data access (SDA), which
exposes data from SAP 1Q remote sources as virtual tables.

For more information, see SAP Help Portal at http://help.sap.com/carlp <your release> » Application Help
POS Data Transfer and Audit » Implementing a POS Transaction Data Storage Strategy # Using the Table Content
Aging Report .
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Install SAP I1Q

A detailed procedure is described in the SAP IQ 16.0 SPOS8 Installation and Configuration Guide.

For more information, see SAP Help Portal at http://help.sap.com/iql608|p Installation and Upgrade Information
» Installation and Configuration Guide for <your operating system> J.

Configure SAP IQ

1. Allocate sufficient space into which your data will be loaded.

1 Note

The default DBSpaces provided during installation are intended to be used for SAP 1Q system
management. You should create your own DBSpace under the Main store with a DB File that is large
enough to satisfy your sizing requirements.

For more information, see SAP Help Portal at http://help.sap.com/iql608|j¢ Reference Administration
Operations Information #» Reference:Statements and Options » SQL Statements » CREATE DBSPACE
Statement .

2. Create anin-memory row-level versioning (RLV) store.
For more information, see SAP Help Portal at http://help.sap.com/iql608| System Administration and
Maintenance Information  Application Operations Guides ¥ Administration: In-Memory Row-Level Versioning
» About In-Memory Row-Level Versioning 3.

3. Create a database under the content created at the beginning of this procedure.

1 Note

Ensure the following:

o The SAP IQ stores are configured with a large enough cache configuration, main memory, and
temporary memory.

o The page size should be set to 128KB.

o The concurrency aligns with the amount of processes that will be triggered during the data copy.

For more information, see SAP Help Portal at http://help.sap.com/iql608|l Configuration and Deployment
Information » Configuration Guide 3.

4. Create tables /POSDW/TLOGF, /POSDW/TLOGF EXT and /POSDW/TLOGF_X tables in the DBSpace created at
the beginning of the procedure.

1 Note

These tables should have the same structure as the tables in your SAP HANA system. One possible way is
to export the table structure via Export SQL on the SAP HANA side, and import it on the SAP 1Q side using
the SQL console.
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The SQL statement requires some modifications, such as:

o Converting all the column names in the exported SQL statement to lower case (for example,
“RETAILSTOREID becomes “retailstoreid”).
You can simply convert the entire SQL statement into lower case and then only convert the table name
to upper case to keep the table name unchanged.

o Renaming of NVARCHAR to VARCHAR.

o Removing references to CS_* (for example, CS_FIXED).

5. Enable the RLV for the tables you just created.
6. Set the snapshot versioning property of the transaction to row-level.

Example

set option Snapshot Versioning = 'Row-level';

7. Enable connection blocking and set the blocking timeout threshold.

Example
set option blocking = 'On';
set option blocking timeout = '0';

Install SAP IQ Drivers

Install and configure the ODBC database drivers required to connect to the remote source.

1 Note

Each data source driver setup is described in its own section. The prerequisites are given as a simple guide; you
will need to consult the original driver documentation provided by the driver manufacturer for more detailed
information.

A detailed procedure is described in the SAP HANA Administration Guide.

For more information, see SAP Help Portal at http://help.sap.com/hana_platform|l System Administration ¥
SAP HANA Administration Guide » SAP HANA Data Provisioning » SAP HANA Smart Data Access » Setting Up
Database Drivers » SAP |Q Driver Setup 3.

5.4.2 Install and Set Up Integration with Apache Hadoop

You use these procedures to install and set up Apache Hadoop to support the Table Content Aging report
(transaction /CAR/TABLE AGING) delivered with SAP Customer Activity Repository.

The SAP HANA database points to your Hadoop cluster using SAP HANA smart data access (SDA), which
exposes data from Hadoop remote sources as virtual tables.
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For more information, see SAP Help Portal at http://help.sap.com/car|p <your release> j» Application Help ¥

POS Data Transfer and Audit » Implementing a POS Transaction Data Storage Strategy » Using the Table Content

Aging Report 3.

Process Flow

To successfully install and set up integration with Apache Hadoop, you must execute the following procedures:

1. Install Apache Hadoop.
2. Do one of the following:
o Install and set up the Apache Hive ODBC driver, or
o Install and set up the SAP HANA Spark controller.
3. Create and partition tables in Apache Hive.
4. Create a NFS mount on SAP NetWeaver.

Install Apache Hadoop

According to the SAP HANA Administration Guide, SAP HANA smart data access is supported by Hortonworks
Distribution for Apache Hadoop: version 2.3 (supported on Intel-based hardware platforms only).

For more information on integration between SAP HANA and Apache Hadoop, see SAP Help Portal at http://
help.sap.com/hana_platform|p System Administration » SAP HANA Administration Guide » SAP HANA Data
Provisioning » SAP HANA Smart Data Access 4.

For more information on installing Apache Hadoop, see http://docs.hortonworks.com # |» All  HDP » 2.3 »
HDP2.3.0 (GA) 3.

Install and Set Up Apache Hive ODBC Driver

1 Note

Integration between SAP HANA and Apache Hadoop requires either an Apache Hive ODBC driver or an SAP
HANA Spark controller.

Implement this procedure only if you wish to integrate SAP HANA with Apache Hadoop via the Apache Hive
ODBC driver.

1. According to the SAP HANA Administration Guide, SAP HANA smart data access is supported by

Hortonworks Distribution for Apache Hadoop: version 2.3 (This includes Apache Hadoop version 1.0.3 and

Apache Hive 0.9.0; supported on Intel-based hardware platforms only).

For more information on integration between SAP HANA and Apache Hadoop, see SAP Help Portal at http://
help.sap.com/hana_platform|p System Administration » SAP HANA Administration Guide » SAP HANA Data

Provisioning ¥ SAP HANA Smart Data Access 4.
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For more information on installing the Apache Hive ODBC driver, see http://docs.hortonworks.com # [ All »

HDP » 2.3 » HDP2.3.0 (GA) 1.
2. Setupthe driver as described in the SAP HANA Administration Guide at http://help.sap.com/hana_platform

|» System Administration » SAP HANA Administration Guide » SAP HANA Data Provisioning » SAP HANA
Hadoop Integration j Hive ODBC Driver 3.

Install and Set Up the SAP HANA Spark Controller

1 Note

Integration between SAP HANA and Apache Hadoop requires either an Apache Hive ODBC driver or a SAP
HANA Spark controller.

Implement this procedure only if you wish to integrate SAP HANA with Apache Hadoop via the SAP HANA
Spark controller.

1. Read SAP Note 2290350#% to confirm the right combination of versions required between SAP HANA,
Apache Spark, and the SAP HANA Spark controller.
2. Install and set up the SAP HANA Spark controller as described in SAP Note 2273047 far .

For more information on installing and setting up the SAP HANA Spark controller, see SAP Help Portal at http://
help.sap.com/hana_platform|p System Administration » SAP HANA Administration Guide » SAP HANA Data
Provisioning » SAP HANA Hadoop Integration » SAP HANA Spark Controller 3.

Create and Partition Tables

Create the SAP schema, tables, and table partitions as described in SAP Note 2317597 #r .

Create a NFS Mount on SAP NetWeaver

The TLOG data and its extensions are copied from your SAP HANA database to Hadoop using the HDFS NFS
Gateway on your Hadoop system. To enable this you must create a mount point on your SAP NetWeaver system
for the data files to be created directly in the Hadoop File System (HDFS).

1 Note

The following steps are only guidelines which provide an example of how to mount Network File System (NFS)
on an SAP NetWeaver Linux-based client.
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1. Make sure the NFS client is installed based on the examples provided:

Table 22:

Red Hat, CentOS sudo yum install nfs-utils
Ubuntu sudo apt-get install nfs-common
SUSE sudo zypper install nfs-client

2. Listthe NFS shares exported on the server.
Example
showmount -e <host>

3. Setupamount point for an NFS share.
Example
sudo mkdir <folder>

1 Note

You must ensure that the folder paths share the same naming conventions, as follows:

Table 23:
Temporary data folder /tmp/tct csv_out/temp
Data folder /tmp/tct_csv_out/data

4. Mount the cluster using NFS.
Example
sudo mount -o hard, nolock <host> <folder>

On your HDFS, the different tables are stored under a folder using the following convention:

<data directory>/<schema>/<table>/<businessdaydate=partition value>/{files}

On the SAP NetWeaver file system, the Hadoop files are stored under a physical path and file name that is derived
from a customer-definable logical path or file name. The configuration is provided via the FILE transaction. Inside
the FILE transaction, you also need to make use of parameters PARAM 1 and PARAM 2. PARAM 1 will be
populated during runtime by the program (generated file name) and PARAM 2 will be populated by the program
during runtime <schema>/<table>/<businessdaydate=partition value>.

Example (Data Directory)

If the Hadoop data files are stored in Unix/Linux folder /tmp/tct _csv_out/data/hdp/apps/hive/
warehouse/<schema>/<table>/businessdaydate=partition value/{files}, the data directory should
point to physical file PARAM 1.cCSV and physical directory /tmp/tct csv_out/data/hdp/apps/hive/
warehouse/<PZ—\RZ—\M_2><FILENAME>.
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You create the following logical path in the FILE transaction as follows:

Table 24:
Logical path /CAR/HDFS_DATA
Name HDFS Data
Syntax group UNIX
Physical path /tmp/tct _csv_out/data/hdp/apps/hive/warehouse/
<PARAM 2><FILENAME>

You create the following logical file in the FILE transaction as follows:

Table 25:
Logical file /CAR/HDFS_DATA
Name HDFS Data
Physical file <PARAM 1>.CSV
Data format WK1
Application area IS
Logical path /CAR/HDFS_DATA

Example (Temporary Directory)

On top of the Hadoop data files, you also need to provide a temporary directory in which the program will populate
script files and also temporarily store data files to be compressed.

If the temporary files are stored in Unix/Linux folder /tmp/tct _csv_out/temp/{files}, you create the
following logical path in the FILE transaction as follows:

Table 26:
Logical path /CAR/HDFS_TEMP
Name HDFS Temp
Syntax group UNIX
Physical path /tmp/tct csv_out/temp/<FILENAME>

You create the following logical file in the FILE transaction as follows:

Table 27:
Logical file /CAR/HDFS_TEMP
Name HDFS Temp
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Physical file <PARAM 1>.SH

Data format

Application area IS

Logical path /CAR/HDFS_TEMP

5.4.3 Install and Set Up Integration with SAP HANA Dynamic
Tiering

You use these procedures to install and set up SAP HANA Dynamic Tiering to support the Table Content Aging
report (transaction /CAR/TABLE AGING) delivered with SAP Customer Activity Repository.

SAP HANA Dynamic Tiering adds the SAP HANA dynamic tiering service to your SAP HANA system. You use this
service to create the extended store and extended tables. Extended tables behave like all other SAP HANA tables,
but their data resides in the disk-based extended store.

For more information, see SAP Help Portal at http://help.sap.com/carlp <your release> » Application Help
POS Data Transfer and Audit  Implementing a POS Transaction Data Storage Strategy » Using the Table Content
Aging Report 3.

Install SAP HANA Dynamic Tiering

A detailed procedure is described in the SAP HANA Dynamic Tiering: Installation and Update Guide.

For more information, see SAP Help Portal at http://help.sap.com/hana_options_dt|l Installation and Update
Installation and Update 3.

Create Extended Storage

A detailed procedure is described in the SAP HANA Dynamic Tiering: Administration Guide.

For more information, see SAP Help Portal at http://help.sap.com/hana_options_dt|l System Administration ¥

SAP HANA Dynamic Tiering: Administration Guide 3 and consult the following subsections:

e |p System Administration » Managing Extended Storage ¥ Create Extended Storage

e |p System Administration » Managing Tables j» Extended Store Tables » Convert HANA Tables to Extended
Store Tables Using the SAP HANA Cockpit J
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5.4.4 Create the Remote Source in SAP HANA Studio

1 Note

This step is not applicable if you are integrating the alternate storage feature with SAP HANA Dynamic Tiering.

Create a remote source by selecting the appropriate adapter and configuring the connection properties and user
credentials.

A detailed procedure is described in the SAP HANA Administration Guide.

For more information, see SAP Help Portal at http://help.sap.com/hana_platform|l System Administration
SAP HANA Administration Guide » SAP HANA Data Provisioning  SAP HANA Smart Data Access » Creating and

Configuring Remote Data Sources » Create Remote Data Sources 3.

5.4.5 Create the Virtual Table

Create the following virtual tables to access the data stored in remote tables:

Table 28:
Virtual Table Remote Table
VT_TLOGF_NLS /POSDW/TLOGF
VT_TLOGF_X_NLS /POSDW/TLOGF_X
VT_TLOGF_EXT_NLS /POSDW/TLOGF_EXT

A detailed procedure is described in the SAP HANA Administration Guide.

For more information, see SAP Help Portal at http://help.sap.com/hana_platform|l System Administration »
SAP HANA Administration Guide » SAP HANA Data Provisioning » SAP HANA Smart Data Access » Creating
Virtual Tables 7.

5.4.6 Set the Deploy Mode in SAP HANA Transport for ABAP

In your back-end system, start the SAP HANA Transport for ABAP ( SCTs_HTA) transaction.
Enter sap.is.retail.car.nls inthe SAP HANA Repository Package field and choose Execute.
Choose F6 to select all synchronizable packages and objects.

Choose | Utilities » Deploy Mode 3.

Choose Mode P.

o wN e
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For more information, see SAP Help Portal at http://help.sap.com/nw74|» Application Help j» Function-Oriented
View ¥ Solution Lifecycle Management » Software Logistics » Transport Scenarios for SAP HANA Content » SAP
HANA Transport for ABAP » Deploy Mode in SAP HANA Transport for ABAP
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6 Post-Installation

6.1 SAP Allocation Management for Retail

Post-installation of SAP Allocation Management for Retail.

1 Note

Some of the activities in this section may have already been performed in the corresponding section under SAP
Customer Activity Repository. Such activities do not need to be repeated during the setup and installation of
consuming applications.

6.1.1 Configure Backend System

SAP Allocation Management for Retail uses master data and time series data stored in the Demand Data
Foundation (DDF). As such, prior to using the SAP Allocation Management for Retail application, you must
ensure that DDF is fully configured and operational.

This procedure highlights key configuration steps required to use the SAP Allocation Management for Retail
application.

Procedure

1. Follow the steps of procedure Configure Demand Data Foundation (Optional) [page 149] to configure the
DDF module in SAP Customer Activity Repository.

2. Ensure that you have activated all the required event type linkages and have enabled the specified event
queues in transaction SWETYPV.
This ensures that the product hierarchy and location hierarchy flattener structures get created. For more
information, see SAP Note 1425876 .

3. Make sure to set up the Customizing for Demand Date Foundation in the SAP Customizing Implementation
Guide by choosing |lF SAP Customer Activity Repository » Demand Data Foundation 3.

4. To use SAP Allocation Management for Retail, you must define several application-specific settings in the
Customizing. Define the settings in the SAP Implementation Guide by choosing | Cross-Application
Components  Allocation Management for Retail 3.
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6.1.2 Verify Users, Privileges, and Roles

Prior to proceeding with the post-installation steps for the application, you need to ensure that the required
database users and back end application users have all the required privileges, roles, and authorizations.

Procedure

1. Ensure that the SAP HANA database users exist and that they have the required additional roles and
privileges.

2. Ensure that your back end application user has the SAP_ ISR _DDF MASTER and your front-end users have the
role SAP AMR BCR ALLOCATOR T.

3. Ensure that the user names of each individual user on the SAP HANA database level, on the back end system
level, and on the front-end server (SAP NetWeaver Gateway) are identical on these three levels.
Furthermore, verify that the front-end application user has all the necessary roles assigned. Here, refer in
particular to the SAP Allocation Management for Retail specific authorization object /AMR/BE.

1 Note

For more information, see the Security Information section in the SAP Allocation Management for Retail
Administration Guide.

6.1.3 Create SAP ERP Tables

In this step, you must create the new SAP ERP tables that are required for SAP Allocation Management for Retail.
Specify which SAP ERP tables to create using information from 2385706 # for installations based on the
SAP_ECC schema.

1 Note

You must create the tables before proceeding. Failure to do so will result in SAP HANA content activation and
deployment failures.

6.1.4 Activate SAP HANA Content for SAP Allocation
Management for Retail

In this procedure, you perform the initial activation of SAP HANA content (views, stored procedures, and AMDPs)
required by the SAP Allocation Management for Retail application.
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1 Note

For general information on SAP HANA Content activation, refer to section Activate SAP HANA Content [page
1387 in chapter | Post-Installation » SAP Customer Activity Repository 4 in this Common Installation Guide.

Prerequisites

e Asamandatory prerequisite you must run the report /CAR/ACTIVATE HTA and ensure that the following has
been activated for all SAP HANA content for SAP CARAB:
o SAPERP
o  SAP Fashion Management
o Customer Activity Repository
© Demand Data Foundation
e Use transaction SAP HANA Transport for ABAP - Deployment (SCTS_HTA DEPLOY) to deploy repository
package SAP.IS.DDF.CROSS including the subpackages. The deployment is a prerequisite for the successful
execution of report Activate SAP Allocation Management for Retail HANA Content /MR /
ACTIVATE HANA CONTENT.
e Furthermore, apply SAP Note 2298340 # (SAP HANA DB: CDS views with external views as base objects
cannot be created in the DB).

Procedure

1. Ensurethatthe SYs REPO user has the authorizations required to successfully activate SAP HANA content.
1. Provide user sys REPO with object privilege SELECT, with option "Grantable to others", on the following
physical DB schemas:
o Physical database schema of your back-end system, typically this is called SAP<SID>.
o Physical database schema that contains the SAP ERP tables.

You can use the following example SQL statement to grant the required privilege:
GRANT SELECT ON SCHEMA <Your schema name> TO _SYS REPO WITH GRANT OPTION;

2. Runprogram /AMR/ACTIVATE HANA CONTENT intransaction SE38 to activate SAP Allocation Management

for Retail HANA content.
3. Runprogram RADMASGO in transaction sE38 for collective CDS and external view activation.

6.1.5 Configure Data Replication

SAP Allocation Management for Retail uses master data, such as product, store, and product hierarchy, and so
on, that is replicated from SAP ERP to DDF using DRFOUT.
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1 Note

Not all of the master data is replicated into DDF using the DRFOUT framework. Some data must be replicated
separately using SLT replication.

For detailed information on the SLT replication procedure, refer to section Replicate SAP ERP Tables in chapter
Follow-Up Activities for SAP Customer Activity Repository within the Common Upgrade Guide.

You can refer t02385706#% for further information on SLT replication for SAP Allocation Management for
Retail.

6.15.1 Initial Load of Data to DDF Using DRFOUT

Prerequisites

Prior to replicating data from SAP ERP to DDF using DRFOUT, the following prerequisites must be fulfilled:
e Your SAP ERP installation is SAP Enhancement Package 6 for SAP ERP SPO7 or higher or SAP Enhancement
Package 5 for SAP ERP SP10 or higher.
e The following business functions are activated in SAP ERP:
O ISR APPL OUTBOUND DMF
© ISR RETAIL OUTBOUND_ DMF

Procedure

1. SAP Allocation Management for Retail specifically requires that the following master data is replicated
sequentially from a connected SAP ERP system usingDRFOUT:

Table 29:
Sequence Master Data Technical Details For more information, see:
) o SAP ERP Description: Material
1 Product Hierar- } http://help.sap.com/carl} <your
h Group Hierarchy
o DRFOUT Outbound Implementa- release> > Application Help } Demand
tion: PMCH Data Foundation # Integration
o DDF Inbound Interface: /DuME/ Information } Inbound Interfaces For
MDIF_PROD_HIER_INBOUND Remote Function Call (RFC)

Communication > Product Hierarchy

Master Data 4
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Sequence

Master Data

Technical Details

o SAP ERP Description: Material

For more information, see:

2 Product http://help.sap.com/car] <your
o DRFOUT Outbound Implementa- o
tion: PMAT release> » Application Help » Demand
o DDF Inbound Interface: /DMF/ Data Foundation  Integration
MDIF PRODUCT INBOUND Information } Inbound Interfaces For
Remote Function Call (RFC)
Communication > Product Master
Data }
) o SAP ERP Description: Plant
3 Location http://help.sap.com/carl} <your
©  DRFOUT Outbound Implementa- o
tion: PPLT release> > Application Help > Demand
o DDF Inbound Interface: /DMF/ Data Foundation > Integration
MDIF LOCATION INBOUND Information > Inbound Interfaces For
Remote Function Call (RFC)
Communication > Product Location
Master Data ]
) o SAP ERP Description: Material/
4 Product Location Plant http://help.sap.com/carl} <your
an
o DRFOUT Outbound Implementa- release> ¥ Application Help # Demand
tion: PMPL Data Foundation # Integration
o DDF Inbound Interface: /DMF/ Information > Inbound Interfaces For
MDIF_ PROD_LOC_INBOUND Remote Function Call (RFC)
Communication > Product Location
Master Data }
) o SAP ERP Description: Sales Price o
5 Product Location http://help.sap.com/carl} Application
o DRFOUT Outbound Implementa- .
tion: PSER Help » Demand Data Foundation
o DDF Inbound Interface: /DMF/ Integration Information > Inbound
MDIF_PROD LOC INBOUND Interfaces For Remote Function Call
(RFC) Communication # Product
Location Master Data }
o SAP ERP Description: Inventory
6 Inventory http://help.sap.com/carl} <your
o DRFOUT Outbound Implementa- o
tion: PTNV release> > Application Help > Demand
o DDF Inbound Interface: /DMF/ Data Foundation # Integration
OPIF_INVENTORY_ INBOUND Information # Inbound Interfaces For
Remote Function Call (RFC)
Communication > Inventory Master
Data 1
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Sequence Master Data Technical Details For more information, see:
. o SAP ERP Description: Source of
7 Transportation Suppl http://help.sap.com/car|p <your
upply
Lane At
o DRFOUT Outbound Implementa- release> ¥ Application Help » Demand
tion: Psos Data Foundation ¥ Integration
o DDF Inbound Interface: /DMF/ Information > Inbound Interfaces For
MDIF LANE INBOUND Remote Function Call (RFC)
Communication > Transportation Lane
Master Data }
} o SAP ERP Description: Vendor
8 Location http://help.sap.com/carl} <your
©  DRFOUT Outbound Implementa- o
tion: PVEN release> > Application Help > Demand

o  DDF Inbound Interface: /DM Data Foundation } Integration

MDIF_ LOCATION_INBOUND Information ¥ Inbound Interfaces For
Remote Function Call (RFC)

Communication > Location Master

Data 1
) o SAP ERP Description: Article Hierar- o
9 Product Hierar- h http://help.sap.com/carl} Application
chy
chy ;
o DRFOUT Outbound Implementa- | /P # Demand Data Foundation »
tion: PAHY Integration Information # Inbound

o DDF Inbound Interface: /DMF/ Interfaces For Remote Function Call

MDIF_PROD_HIER_INBOUND (RFC) Communication » Product

Hierarchy Master Data }

You can import the data into staging tables, and then transfer this data to production tables using
report /DMF/PROCESS STAGING TABLES. Or you can skip the staging tables, and import the data directly
into the production tables. For more information, see:

o http://help.sap.com/carlp <your release> » Application Help » Demand Data Foundation j Integration
Information » Inbound Processing 4

o http://help.sap.com/car| <your release> » Application Help » Demand Data Foundation ¥ General
Services » Monitor Imports ¥ Process Inbound Staging Tables 3

More Information

For more information on monitoring the replication, see:

e http://help.sap.com/car [ <your release> » Application Help » Demand Data Foundation » General Services
» Monitor Imports 3
e Periodic Tasks (5.2.4) section of the Administrator's Guide, SAP Allocation Management for Retail 1.0
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6.1.5.2 Load of Time-Dependent Article

SAP Allocation Management for Retail supports the use of time-dependent article hierarchies.

Procedure

To enable the use of time-dependent article hierarchies in SAP Allocation Management for Retail, do the following:

1. Implement SAP Notes 2196323 and 2196351 in the connected SAP ERP system.

2. Ifyour hierarchy is already a time-dependent hierarchy, you need to re-import the product hierarchies into
SAP Allocation Management for Retail using the DRFOUT framework.

o  SAP ERP Description: Article Hierarchy
o DRFOUT Outbound Implementation: pPAHY
© DDF Inbound Interface: /DMF/MDIF PROD HIER INBOUND

6.1.5.3 Delta Load of Data to DDF Using DRFOUT

When performing a delta load of master data from SAP ERP using the DRFOUT framework, you must ensure that
the product location data required to enhance the sales records with historical sales cost is loaded prior to the
sales data.

Furthermore, we recommend that you schedule a weekly periodic task to replicate inventory data (outbound
implementation PINV) from the SAP ERP system to the system for SAP Allocation Management for Retail. This
replication builds up the inventory history data that is needed by SAP Allocation Management for Retail.

6.1.6 Configure SAP Gateway

6.1.6.1 Perform General SAP Gateway

Prior to connecting the SAP Gateway on your front-end server to your back-end system, you need to perform a
series of general SAP Gateway configuration steps. These configuration steps include the setting of profile
parameters, ICF (Internet Communication Framework) services, language settings, and so on.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.
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Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o  SAP Gateway for SAP NetWeaver 7.31
See http://help.sap.com/nwgateway20|l¢ Application Help » SAP NetWeaver Gateway Configuration
Guide » Basic Configuration Settings .
o SAP Gateway for SAP NetWeaver 7.40
See http://help.sap.com/nw74|l Application Help ¥ Function-Oriented View ¥ SAP NetWeaver Gateway
Foundation (SAP_GWFND) » SAP NetWeaver Gateway Foundation Configuration Guide » General
Configuration Settings 3.
o SAP Gateway for SAP NetWeaver 7.50
See http://help.sap.com/nw75 [ Application Help » Function-Oriented View » SAP NetWeaver Gateway
Foundation (SAP_GWFND) » SAP NetWeaver Gateway Foundation Configuration Guide » General
Configuration Settings 3.

6.1.6.2 Connect SAP Gateway to Your Back-End System

In this procedure, you configure the OData Channel, that is, set up a connection between SAP Gateway on your
front-end server and your back-end system.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.

Procedure

1. Setup the required roles on the front-end server and assign your user to these roles.
For more information, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/
netweaver <your release>
|» Application Help » Function-Oriented View » SAP NetWeaver Gateway Foundation (SAP_GWFND) » SAP
NetWeaver Gateway Foundation Configuration Guide » SAP Gateway Configuration ¥ User, Developer, and

Administrator Roles .
2. Specify the connection settings on the SAP Gateway hub system, which include:
o Connection from the SAP Gateway to consumer systems
These settings allow the connection between the SAP Gateway host and the consumer systems (clients
from which you access the SAP Fiori user interfaces).
o Connection from the SAP Gateway to SAP back-end system
These settings allow the connection between SAP Gateway to your back-end system.
These settings include:
o Creating a type 3 connection from the SAP Gateway host to your back-end system.
o Defining a trust relationship between your back-end system and the SAP Gateway host.
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o Configuring your back-end system to accept SAP assertion tickets from the SAP Gateway host.
o Configuring your SAP Gateway host to accept SAP assertion tickets from your back-end system.
o Configuring the necessary system aliases.

More Information

For SAP NetWeaver 7.31, see SAP Library for SAP NetWeaver Gateway on SAP Help Portal at http://
help.sap.com/nwgateway20|p Application Help » Support Package Stack » SAP NetWeaver Gateway
Configuration Guide ¥ OData Channel Configuration » Connection Settings on the SAP NetWeaver Gateway Hub
System 3.

For SAP NetWeaver 7.4, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw74
|» Application Help ¥ Function-Oriented View » SAP NetWeaver Gateway Foundation (SAP_GWFND) » SAP
NetWeaver Gateway Foundation Configuration Guide » SAP Gateway Configuration » Connection Settings for the
SAP Gateway Hub System 1.

For SAP NetWeaver 7.5, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw75
|» Application Help ¥ Function-Oriented View » SAP NetWeaver Gateway Foundation (SAP_GWFND) » SAP
NetWeaver Gateway Foundation Configuration Guide » General Configuration Settings 3.

6.1.6.3 Activate SAP Gateway

Before you can use SAP Gateway functionality, you have to activate it globally on your front-end server.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.

Procedure

1. Determine the SAP NetWeaver version of your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o SAP Gateway for SAP NetWeaver 7.31
See http://help.sap.com/nwgateway20|l Application Help ¥ SAP NetWeaver Gateway Configuration
Guide » OData Channel Configuration ¥ Activating SAP NetWeaver Gateway 3.
o SAP Gateway for SAP NetWeaver 7.4
See http://help.sap.com/nw74|l Application Help ¥ Function-Oriented View » SAP NetWeaver Gateway
Foundation (SAP_GWFND) » SAP Gateway Foundation Configuration Guide » SAP Gateway Configuration
» Activating SAP Gateway 3.
o  SAP Gateway for SAP NetWeaver 7.5
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See http://help.sap.com/nw75|r Application Help ¥ Function-Oriented View » SAP NetWeaver Gateway
Foundation (SAP_GWFND) » SAP Gateway Foundation Configuration Guide » SAP Gateway Configuration
» Activating SAP Gateway 4.

6.1.6.4 Activate Common OData Services

A number of OData services are required to run the SAP Fiori launchpad. These OData services are delivered with
the central Ul component (SAP_UI 750 SP12 or equivalent).

For security reasons, all OData services are delivered in an inactive state. To use the SAP Fiori launchpad, you
must activate the common SAP Fiori OData services.

Procedure

—

Log on to your front-end system (your SAP Gateway system).
2. Goto Customizing (transaction SPRO).

3. Navigate to [ SAP NetWeaver » Gateway » OData Channel » Administration » General Settings ¥ Activate
and Maintain Services 1.
You are presented with the service catalog. This is a list of all the services that are currently active on your
SAP Gateway.
4. Get common SAP Fiori OData services:
1. Choose Add Service.
The Add Service screen is displayed.
2. Enter the system alias of your local front-end system.
This is the alias created in the Connect SAP Gateway to Your Back-End System [page 71] procedure. For
example, LOCAL.
3. Enter /u1i2*inthe Technical Service Name field.
4. Choose Get Services.
The Add Selected Services screen is displayed.
5. Select the common SAP Fiori OData services that you would like to activate, and choose Add Selected
Services.

Table 30:

Service Name

/UI2/PAGE BUILDER CONF

/UI2/PAGE BUILDER CUST

/UI2/PAGE_BUILDER PERS

/UI2/TRANSPORT
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Service Name

/UI2/INTEROP

The selected OData services are now active in your SAP Gateway.

More Information

e For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at http://
help.sap.com/nw-uiaddon20| Application Help » SAP Fiori Launchpad ¥ Setting Up the Launchpad ¥
Activating SAP Gateway OData Services 3.

e For SAP NetWeaver 7.40, see the documentation on SAP Help Portal at http://help.sap.com/nw74
|+ Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 740 ¥ SAP Fiori Launchpad » Setting Up
the Launchpad ¥ Activating SAP Gateway OData Services 4.

e For SAP NetWeaver 7.5, see the documentation on SAP Help Portal at http://help.sap.com/nw75
| Application Help Ul Technologies in SAP NetWeaver with SAP_UI 750 ¥ SAP Fiori Launchpad ¥ Setting Up
the Launchpad ¥ Activating SAP Gateway OData Services 3.

6.1.7 Configure Index Calculation

The SAPUI5 application index provides an indexing and caching mechanism for information related to SAPUI5
apps, components, and libraries that are contained in SAPUI5 repositories on the SAP NetWeaver Application
Server for ABAP. This index, calculated by the Calculation of SAPUI5 Application Index for SAPUI5 Repositories
report ( /UI5/APP_INDEX CALCULATE), makes it possible to retrieve and find this information significantly faster
than when carrying out the calculations each time it's requested.

We recommend that you schedule the Calculation of SAPUI5 Application Index for SAPUI5 Repositories report as
to run as a background job on your front-end server.

Following any changes to the content of the SAPUI5 ABAP repository (for example, installation of a new version of
the SAPUI5 distribution layer or implementation of an SAP Note containing changes to a SAPUI5 app), the
SAPUI5 application index should be updated using the calculation report. This report has to be executed in every
system whenever the content of the SAPUI5 ABAP repository has changed.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o  SAP Gateway for SAP NetWeaver 7.31
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o http://help.sap.com/nw-uiaddon20l} Application Help » SAPUI5: Ul Development Toolkit for HTML5
» Developing Apps ¥ The SAPUI5 ABAP Repository and the ABAP Back-End Infrastructure  SAPUI5

Application Index 3
o SAP Gateway for SAP NetWeaver 7.40: http://help.sap.com/nw74
o SAP Gateway for SAP NetWeaver 7.50: http://help.sap.com/nw75

| Application Help » Ul Technologies in SAP NetWeaver with SAP_UI <your release> » SAPUI5: Ul

Development Toolkit for HTML5 » Using the SAPUI5 Repository #» SAPUI5 Application Index 3
Alternatively, you can launch the Calculation of SAPUI5 Application Index for SAPUI5 Repositories report

(/UI5/APP_INDEX CALCULATE) from Customizing under | SAP NetWeaver # Ul Technologies # SAP
Fiori ¥ Initial Setup ¥ Schedule SAPUI5 Application Index Calculation 3.

6.1.8 Configure Central Ul Component

The central Ul component (delivered as part of the SAP Fiori front-end server) contains the SAP UI5 control
library and the SAP Fiorilaunchpad. Prior to being able to use the SAP Fiori apps that constitute the user interface
of the retail applications described in this guide, you may need to configure the SAP Fiori launchpad.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.

For more information, see the Prerequisites section in this guide.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o  SAP Gateway for SAP NetWeaver 7.31
o http://help.sap.com/nw-uiaddon20l}+ Application Help » SAP Fiori Launchpad 3, and
o http://help.sap.com/nw-uiaddon20|p System Administration and Maintenance Information
Administrator's Guide ¥ Configuration and Operations ¥ Content Administration  SAP Fiori Launch
Page ¥ Setting Up the SAP Fiori Launch Page 3
o SAP Gateway for SAP NetWeaver 7.40
o http://help.sap.com/nw74lp Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 740
» SAP Fiori Launchpad 3, and
o http://help.sap.com/nw74lr Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 740
» SAP NetWeaver User Interface Services » Configuration and Operations » Content Administration »
SAP Fiori Launchpage ¥ Setting Up the SAP Fiori Launch Page 3
o SAP Gateway for SAP NetWeaver 7.50
o http://help.sap.com/nw75|p Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 750
» SAP Fiori Launchpad 3, and
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o http://help.sap.com/nw75|r Application Help * Ul Technologies in SAP NetWeaver with SAP_UI 750
» SAP NetWeaver User Interface Services » Configuration and Operations # Content Administration
SAP Fiori Launchpage ¥ Setting Up the SAP Fiori Launch Page 3

6.1.9 Activate SAP Allocation Management for Retail OData
Services

A number of OData services are required to run the SAP Allocation Management for Retail application.

For security reasons, all OData services are delivered in an inactive state. You must activate these application-
specific OData services to use the SAP Fiori user interface of the SAP Allocation Management for Retail
application.

Procedure

1. Logonto your front-end system (your SAP NetWeaver system).
2. Go to Customizing (transaction SPRO).

3. Navigate to |+ SAP NetWeaver » Gateway » OData Channel » Administration » General Settings # Activate

and Maintain Services J.
You are presented with the service catalog. This is a list of all the services that are currently active on your
SAP Gateway.
4. Get SAP Allocation Management for Retail OData services:
1. Choose Add Service.
The Add Service screen is displayed.
2. Enter the system alias of your back-end system.
This is the alias created for your back-end system in the Connect SAP Gateway to Your Back-End System
[page 71] procedure. For example RTLCLNT100.
3. Enter /DMF* in the Technical Service Name field.
4. Choose Get Services.
The Add Selected Services screen is displayed.

5. Select the SAP Allocation Management for Retail OData services you would like to activate, and choose
Add Selected Services.

Table 31:

OData Service Description

/DMF/DIST CURVE OData Service for Configure Distribution Curves

The selected OData services are now active in your SAP Gateway.

6. Enter /AMR* in the Technical Service Name field.
7. Choose Get Services.
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The Add Selected Services screen is displayed.
8. Select the SAP Allocation Management for Retail OData services you would like to activate, and choose

Add Selected Services.

Table 32:
/BAMR/OD_ALLOCATIONPLAN SRV OData service for My Allocation Plans
/AMR/OD_COMMON SRV Common OData service used by multiple apps
/AMR/OD MARKETUNIT SRV OData service for Manage Market Units
/AMR/OD_PARAM SRV OData service for Manage Allocation Parameters
/AMR/OD_WORKLOAD_ SRV OData service for My Allocation Workload

More Information

e For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at http://
help.sap.com/nw-uiaddon20| Application Help » SAP Fiori Launchpad ¥ Setting Up the Launchpad ¥

Activating SAP Gateway OData Services 3.
e For SAP NetWeaver 7.4, see the documentation on SAP Help Portal at http://help.sap.com/nw74

|+ Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 740 » SAP Fiori Launchpad  Setting
Up the Launchpad j Activating SAP Gateway OData Services .
e For SAP NetWeaver 7.5, see the documentation on SAP Help Portal at http://help.sap.com/nw75

| Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 750 » SAP Fiori Launchpad » Setting Up
the Launchpad ¥ Activating SAP Gateway OData Services 3.

6.1.10 Activate SAP Allocation Management for Retail ICF
Services

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Allocation
Management for Retail application are made available in an inactive state.

You have activated the central ICF services in the Perform General SAP Gateway [page 70] and Configure Central
Ul Component [page 75] procedures. This procedure provides the instructions to activate ICF services required
for the SAP Allocation Management for Retail SAP Fiori apps.
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Procedure

1. Logontoyour front-end server.

2. Open service maintenance (transaction SICF).

3. Inthe Maintain Service screen, select the Location Clustering service by specifying the following:
o Hierarchy Type: SERVICE
© Virtual Host: DEFAULT HOST
o Service Path: /sap/bc/ui5_ui5/sap/amr_alloplan/

4. Choose Execute.

o

To activate the service, choose Service/host Activate.

6. Repeat steps 3to 5 to ensure that all of the following services are activated:
© /sap/bc/ui5 ui5/sap/amr_allo_params

© /sap/bc/uib uiS5/sap/amr dist config

© /sap/bc/ui5 uiS5/sap/amr lib reuse

© /sap/bc/ui5 uib5/sap/amr marketunit

0 /sap/bc/uib ui5/sap/amr_ workload

6.1.11 Assign Roles, Catalogs, and Groups in SAP Fiori
Launchpad

To be able to access SAP Fiori apps that constitute the SAP Allocation Management for Retail user interface from
the SAP Fiori launchpad, your front-end system user must have the necessary roles assigned. Based on the roles
assigned to your user, you can access certain business catalogs and business catalog groups.

Your SAP Allocation Management for Retail application is delivered with a predefined role, catalog, and group.
These include technical content as well as business content:

Table 33:
Front-End Server Business Content Front-End Technical Content
Business Role Business Catalog Business Catalog Group Technical Role Technical
Catalog
SAP AMR BCR_ SAP _AMR BC A SAP AMR BCG ALLOCATOR T |SAP AMR TCR_ T SAP AMR TC
ALLOCATOR T LLOCATOR T T

To test the installation of SAP Allocation Management for Retail from the SAP Fiori launchpad, you need to assign
the roles above to your user on the front-end system.

Procedure

1. Logonto your front-end system.
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2. Launch User Maintenance (transaction su01).

3. Enter your user name in the User field and choose Change.

4. Onthe Roles tab, assign the roles SAP_ AMR_BCR_AP_ALLOCATOR to your user.
Caution

If you already have an SAP Fiori launchpad open, you must clear your browser cache to apply any
modifications made to your user roles. Otherwise, your changes will not be reflected in the SAP Fiori user
interface.

More Information

Security Information section of the SAP Allocation Management for Retail Administration Guide.

6.2 SAP Assortment Planning for Retail

1 Note

Some of the activities in this section may have already been performed in the corresponding section under SAP
Customer Activity Repository. Such activities do not need to be repeated during the setup and installation of
consuming applications.

The following diagram depicts the post-installation process for SAP Assortment Planning for Retail 2.0.
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Figure 9: General Post-Installation Flow

6.2.1 Configure the Back-End System

6.2.1.1 Configure Demand Data Foundation

Use

SAP Assortment Planning for Retail uses master data and time series data stored in Demand Data Foundation
(DDF). As such, prior to using the SAP Assortment Planning for Retail application, you must ensure that DDF is
fully configured and operational.

This procedure highlights key DDF configuration steps required to use the SAP Assortment Planning for Retail
application.

Procedure

1. Read the Configure Demand Data Foundation (Optional) [page 149] section or this guide.
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Ensure that you have carried out all the necessary configuration listed in this section, in particular, that you
have activated all the required event type linkages and have enabled the specified event queues in transaction
SWETYPV. This ensures that the product hierarchy and location hierarchy flattener structures get created. For

more information, see SAP Note 1425876 # .

2. Perform the necessary configuration steps in DDF.
The Configuring Demand Data Foundation (DDF) lists all of the Customizing activities that must be configured
for DDF. DDF Customizing activities that are explicitly relevant for SAP Assortment Planning for Retail are also

referenced under | SAP Customizing Implementation Guide ¥ Cross-Application Components » Assortment

Planning for Retail  Imported Demand Data Foundation Settings 3.

6.2.1.2 Configure Assortment Planning for Retail

Use

To use SAP Assortment Planning for Retail, you must define several application-specific settings in Customizing.

Procedure

1. Verify that the DDF Customizing activities have been configured.
DDF Customizing activities are accessible under |# SAP Customizing Implementation Guide » Cross-
Application Components » Demand Data Foundation 3. Activities that are explicitly relevant for SAP
Assortment Planning for Retail are also available under | SAP Customizing Implementation Guide » Cross-
Application Components ¥ Assortment Planning for Retail » Imported Demand Data Foundation Settings 3.

1 Note

In the | SAP Customizing Implementation Guide » Cross-Application Components » Assortment Planning

for Retail » Imported Demand Data Foundation Settings » Basic Settings » Define Default Values 3
Customizing activity, you do not need to maintain the Logical System ID or the Hierarchy ID settings. These
are only required in an upgrade scenario.

2. Define the required number ranges.
You must set all of the number ranges under |+ SAP Customizing Implementation Guide #» Cross-Application
Components ¥ Assortment Planning for Retail  Number Range 3.

3. Verify the default implementations of BAdIs under [+ SAP Customizing Implementation Guide » Cross-

Application Components ¥ Assortment Planning for Retail % Enhancements Using Business Add-Ins 3, and if
necessary, provide custom implementations.
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6.2.1.3 Configure Unified Demand Forecast (Optional)

Use

During the installation, you have installed SAP RTL AFL FOR SAP HANA 200, which includes the functinality for
the Unified Demand Forecast (UDF) module. For more information, see Install SAP Customer Activity Repository
Retail Applications Bundle [page 44].

Currently, SAP Assortment Planning for Retail does not use the demand forecasting services provides by the UDF
module, and only uses the sales projection functionality provided in the DDF module. As a result, the
implementation (or configuration) of UDF is not mandatory.

Procedure

1. If you do wish to use UDF outside of the context of SAP Assortment Planning for Retail, see the following:

o Features: http://help.sap.com/car|r <Your Release> j Application Help ¥ Unified Demand Forecast

(UDF) 3
o Setup: Configure Unified Demand Forecast (Optional) [page 154] section, earlier in this guide.

6.2.2 Verify Users, Privileges, and Roles

Use

Prior to proceeding with the post-installation steps for the application, you need to ensure that the required
database users and back-end application users have all the required privileges, roles, and authorizations.

Prerequisites

You have read and implemented the procedure described in Verify SAP HANA User and Privileges [page 40].

Procedure

1. Ensure that the SAP HANA database users listed below exist and that they have the required additional roles/
privileges.
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Table 34:

User

SAP<SID>

This is the generic database user speci-
fied for the connection from the SAP
NetWeaver back-end server to the SAP
HANA database.

Role/Privilege

o

o

Privilege EXECUTE on procedure TRUNCATE PROCEDURE OBJECTS

Privilege EXECUTE on procedure GET PROCEDURE OBJECTS

_SYS_REPO

<Your User Name>*

o

Privilege REPO.READ on package bw2hana/SAP<SID> /RAP/
<InfoCube> REPORTING

The corresponding privileges will be created automatically when activating

Bl Content.
Session Client of this database user has to be set to the appropriate back-
end system client.
1. Logonto SAP HANA studio.
2. Openthe Modeler perspective and use the Navigator to access your
back-end system.
3. Under Security, select a user.
4. Set the Session Client to the client number created in Set Up SAP Cli-
ent [page 47].
This step is necessary to use the SAP Assortment Planning for Retail

planning framework, where SAP BusinessObjects Analysis, edition for

Microsoft Office workbooks obtains data from SAP HANA views.

For more information, see the Assign Default Client section in the SAP

HANA Modeling Guide.

must be identical.

*The user name on SAP HANA database level, back-end system, and on the front-end server (SAP NetWeaver Gateway)

2. Ensure that your back-end application user has the following roles/authorizations.
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3.

Table 35:

User Role/Authorization

<Your User Name>* 0 SAP ISR DDF MASTER

0 SAP ISR AP MASTER

o /RAP/BW_AP WORKBOOKS

o Set SAP HANA User Mapping to C ( DBMS user, else SAP HANA user with
same name as BW user) in transaction RS2HANA VIEW.

o Verify that authorizations for generating SAP HANA views out of local Bl
Content objects is set up by running transaction RS2HANA CHECK.
For more information, see http://help.sap.com/nw75|} Application Help
> Function-Oriented View > SAP Business Warehouse > Using the SAP
HANA Database > Data Modeling When Using a SAP HANA > Modeling and
Analysis for Business Users > Mixed Modeling (SAP BW and SAP HANA) >
Generating SAP HANA Views from the BW System # Authorizations for

Generating SAP HANA Views }
o The user profile must have the following parameters maintained (transac-
tion su3, Parameters tab):

Table 36:
Parameter Value
RSPLS HDB PE TRACE Y
RSPLS_HDB_SUPPORT HDB_ON

*The user name on SAP HANA database level, back-end system, and on the front-end server (SAP NetWeaver Gateway)

must be identical.

Ensure that your front-end application user name is identical to the user name on SAP HANA database level
and on the back-end system. Furthermore, verify that the front-end application user has all the necessary
roles assigned. For more information, see the Security Information section in the SAP Assortment Planning for
Retail Administrator's Guide.

6.2.3 Activate SAP Assortment Planning for Retail Planning

Framework Content

The planning framework used by SAP Assortment Planning for Retail consists of the following elements:

84

Business Intelligence Content (Bl Content) Objects: A collection of local Bl Content objects is used as the
basis for the SAP BusinessObjects Analysis, edition for Microsoft Office workbooks.

SAP BusinessObjects Analysis, edition for Microsoft Office workbooks are designed to consume data from Bl
Content objects. The local Bl Content objects that are provided with the SAP Assortment Planning for Retail
applications use the integrated planning engine in SAP Business Warehouse (SAP BW). These local Bl
Content objects are used as an interface between the SAP HANA views and the SAP BusinessObjects
Analysis, edition for Microsoft Office workbooks.
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1 Note

The local Bl Content provided with the SAP Assortment Planning for Retail application is entirely
independent of the SAP Business Warehouse Bl Content and Bl Content Extensions add-on. You can use
this local Bl Content directly in SAP Assortment Planning for Retail.

e SAP BusinessObjects Analysis, edition for Microsoft Office Workbooks: Microsoft Excel-based
spreadsheets that you use to plan assortments for the different locations in your retail business.

This section of the guide provides information on the SAP HANA content activation, Bl Content activation and
configuration, and data upload activities required to set up the SAP Assortment Planning for Retail planning
framework.

1 Note

If you have already activated SAP HANA content for SAP Customer Activity Repository, as described in
Activate SAP HANA Content [page 138], you can proceed to the Activate SAP HANA Content for SAP
Assortment Planning for Retail - Part 1 [page 85] procedure.

6.2.3.1 Activate SAP HANA Content for SAP Assortment
Planning for Retail - Initial Activation

Use

In this procedure, you activate all SAP HANA Transport for ABAP (HTA) content required for SAP Assortment
Planning for Retail. For each SAP HANA content package, there is one HTA object.

Caution

This initial activation results in a partial activation of the SAP HANA content for SAP Assortment Planning for
Retail. Several SAP HANA views depend on local Bl Content objects, and as such, have to be activated following
the activation of these Bl Content objects. For more information, see Activate SAP HANA Content for SAP
Assortment Planning for Retail - Final Activation [page 93].

Prerequisites

e You must have successfully completed all of the procedures listed in the previous sections of this guide.

e You must have created all the necessary tables, as described in the Create/Replicate Source Master Data
System Tables section of the Common Installation Guide.

e You have implemented SAP Notes 2395997, 2383066#% , 2390790#% , 2392194 s .
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Procedure

In your back-end system, start transaction SE38.
Enter /CAR/ACTIVATE HTA and choose Execute.

. Select all applicable source master data systems, the Assortment Planning business scenarios, and external

systems for which you wish to activate HTA content.

Optionally, choose the Perform Prerequisite Check option to validate the processing and read the system log
prior to applying any database changes.

Choose Execute.

More Information

If you encounter issues during the activation, see the Troubleshooting [page 166] section for possible
solutions.
For more information about activating SAP HANA content in SAP HANA studio, see http://help.sap.com/

hana_platform|r Development and Modeling » SAP HANA Developer Guide (For SAP HANA Studio) ¥ Setting

Up the Analytic Model ¥ Creating Views » Activating Objects 3.

For more information about HTAs, see the Application Help for SAP NetWeaver 7.5 at https://help.sap.com/
saphelp_nw75/helpdata/en/ff/7652bd542849b18b218efe8d2f2373/content.htm?frameset=/en/34/
dfb3083df34453beb5eb8ade7bd4ed/frameset.htm&current_toc=/en/4e/
bfa9a86e391014adc9fffede204223/plain.ntm&node_id=7&show_children=false.

6.2.3.2 Activate SAP Assortment Planning for Retail Local Bl

Content

6.2.3.2.1 Activate Technical Content

Use

The first time you enter the Data Warehousing Workbench, the system runs a background job to activate
technical content. Technical content consists of technical information that is generated by the system, for
example, data required for the general operation of Bl Content, or time data.

Procedure

86

On your back-end system, open the Data Warehousing Workbench (transaction RSA1).

If prompted, in the Replicate Metadata dialog box, choose Only Activate.

If a message appears that you are only authorized to work in client ... (Brain 009), then refer to SAP Note
316923 (do not import the support package, but use the description under section Workaround).
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4. Select Do not show this question Again in the dialog that appears.

5. Choose Yes.
Make sure that the current job has finished before you proceed with the next step. Check the status of the
background job using transaction sM37or SLG1. If there are problems, you must first solve them.
You can use transaction RSTCO_ADMIN to restart the activation of the technical content and to verify the
status of the activation.

1 Note

In the case that you get the shot-dump "RAISE_EXCEPTION" when installing InfoObjects from the Bl
content, see SAP Note 1637935#% for a possible solution.

Also, see SAP Notes 2090845/% and 2056106#% for important information on technical content
activation.

Following activation, you can locate the technical content in the Data Warehousing Workbench as follows:
1. Selecting Modeling in the left-hand frame.

2. Expand InfoObjects.

3. Intheright-hand frame, locate Technical Content.

6.2.3.2.2 Activate Application Bl Content

Use

In this procedures, you perform a sequential, step-by-step activation of the local Bl Content objects delivered with
the SAP Assortment Planning for Retail application.

1 Note

To ensure correct activation of the local Bl Content objects, carry out the activation sequentially, as specified in
the following procedures.

Also, the default Bl setting to collect and activate all dependencies must not be disabled by the user. The
instructions below activate a minimum subset of objects, and it assumed that all their dependencies will be
collected and activated.

Procedure

1. Onyour back-end SAP Assortment Planning for Retail system, open the Data Warehousing Workbench
(transaction RSA1).
2. Verify transport connections.
1. Select Transport Connection in the left-hand frame.
2. Select Object Types.
3. Expand Source System.
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Data Warehousing Workbench: Transport Connection
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v B nfoObject

+ D Transformation

v & InfoSource

T
+ B Date Flow
» @) InfoPackage

» [ Data Transfer Process
v Process Chain

» (23 Processes

» 23 Planning

& ][ Grouping ,WRH? Package || Collection Mode .|| Displar »

Collected objects

Figure 10: Selecting Source Systems
Use Select Objects to ensure that the back-end system is selected as the source system.

T | Technical name | Elevated... Last.. L

At the top of the right-hand frame, above the list of Collected objects, choose Grouping and select Only

Necessary Objects.

At the top of the right-hand frame, choose Collection Mode and select Collect Automatically.
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Data Warehousing Werkbench: Transport Connection
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« & InfaOhiscts hv InfoAreas + @l infapackane

Figure 11: Grouping and Collection Settings
3. Select Bl Content in the left-hand frame.
4. Determine your Bl Content installation requirements and apply these to each subsequent step.
If you are carrying out a brand new installation, proceed to the next step.

= Recommendation

If, however, you have previously installed/activated any of the /rap/* Bl Content, you need to apply
special considerations to the installation/activation of Bl Content following a system upgrade.

o |If you have modified any of the previously installed /rRap/* Bl Content objects, we recommend that for
the modified objects, you enable the Match (X) or copy option. When this options is selected, you will
be asked to carry out an additional Transfer selections step during which you select to install the Active
Version (that is, your modified version) or the Content Version (that is, the SAP delivered, and possibly
updated version of the object).

o If you have not modified any of the previously installed /rRap/* Bl Content objects, you do not need to
enable the Match (X) or copy option for any of the Bl Content objects, and you don't need to choose
whether to install the Active Version or the Content Version of the objects.

5. Activate InfoObject catalogs.
1. Expand InfoObject Catalog.
2. Use Select Objects to select the /RAP/CHAR CAT and the /RAP/KYF CAT catalogs, thatis, all the
InfoObject catalogs that starting with /raP/ *.
3. Choose Transfer Selections.
4. Inthe right-hand frame, in the list of Collected objects, verify that both InfoObject catalogs are listed.
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5. Right-click on each of the InfoObject catalogs, and choose Install all Bellow.

6. Choose Install.
If an information dialog box appears, choose Continue. Choose Local Object or enter a package if you
need to transport the objects.

6. Activate Variable /RAP/DISTM_MSM_01.

Expand Query Elements.

Use Select Objects to select the /RAP/DISTM MSM 01 Variable.
Choose Transfer Selections.

AW

In the right-hand frame, in the list of Collected objects, verify that the /RAP/DISTM MSM 01 Variable is
listed and that the option in the Install column is enabled .

5. Choose Install.

If an information dialog box appears, choose Continue. Choose Local Object or enter a package if you
need to transport the objects.

7. Select Modeling in the left-hand frame.
8. Maintain version master data.
1. Expand InfoObjects.

2. Search for InfoObject /RAP/VERSN, located under [+ Assortment Planning for Retail » RAP Character

InfoObject Catalog 3.
3. Right-click the InfoObject /RAP/VERSN, choose Maintain Master Data from the context menu, and
maintain the following entries on the Time Independent tab:

Table 37:

Version

AP1

AP2

AW1

AW2

APF

OP1

OP2

PRJ

REF

000

# - An empty version value that you must maintain

The supported planning versions are described in detail in the Maintain Customizing Table /RAP/
RS_VARCUST [page 95] procedure.
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1 Note

If you encounter problems opening the master data maintenance WebDynpro application, ensure that

you have implemented SAP Note 20346237 .

9. Select Bl Content in the left-hand frame.

10. Activate DataStore Objects.

Expand |j» More Types » DataStore Object (Classic)

Use Select Objects to select all DataStore Objects starting with /rAP/ *.
Choose Transfer Selections.

A w e

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a

package if you need to transport the objects.

If during the installation, you are presented with a dialog asking you to add objects to a personal list,

select No.
If activation warnings similar to the ones displayed below appear, you can ignore them.

Date/ Time/User
+ & Attribute _RAP_CLSET: Conversion routine ALPHA ignor
* N Attribute _RAP_CLUST: Compounding ignored
+ A Attribute _RAP_LOCAT: Conversion routine ATINM ignor
* & Attribute _RAP_PRDCT: Conversion routine ALPHA ignor
* & Attrbute _RAP_VARNT: Conversion routine ALPHA igno
« & Attribute _RAP_VERSN: Conversion routine ALPHA ignor
* @ Creating column view of type IDS for object /RAP/DS01...
~ & Column view activated for object /RAP/DS01
*+ @ DataStore Object (classic) /RAP/DS01 activated
¥ M Post Processing/Checking the Activation for DataStore Object (
~ £ Creating Export DataSource and dependent Objects
* @ Reading the Metadata of [RAP/DS02 ...
* @ Creating DataSource /RAP/8DS02 ...
* & The short text of DataSource /RAP/8DS02 is not mainta
* & The short text of DataSource /RAP/8DS02 is not mainta

* @ Writing of object catalog entries (TADIR)
* @ Program ID 90L57 YJIGBIW YCOBV7UB1WV YK retrieved for O
¥ & Initial entry written on the status of data of the InfoProvider
v A Activate external SAP HAMNA view for object /RAR/DS02
* @ Creating column view of type IDS for object /RAP/DS02...
¥ & Column view activated for object /RAP/DS02
« [0 DataStore Object (classic) /RAP/DS02 activated
¥ {4 Post Processing/Checking the Activation for DataStore Object (.
» & Initial entry written on the status of data of the InfoProvider

= B Fenmtinn cnbimn ssimes af s TAEC far ahiact IDARIRCAD

Figure 12; Warnings
11. Activate InfoCubes.

1. Expand InfoCube.
2. Use Select Objects to select all InfoCubes starting with /RAP/RC*.
3. Similarly, select InfoCubes /RaP/vC20 and /RAP/VC21.
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4. Choose Transfer Selections.

5. Inthelist of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

6. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.
If activation warnings similar to the ones displayed below appear, you can ignore them.
* 5 Column view activated for object /RAP/RCO1
* O Activate external SAP HANA view for object /RAP/RCO1
- @ Package: system-ocal.bw.bw2hana.rap, type: Analytic View, name: R
« M Attribute _RAP_ASRTP: Conversion routine ALPHA ignored
+ M Attribute _RAP_CLSET: Conversion routine ALPHA ignored
« N Attribute _RAP_CLUST: Compounding ignored
« M Attribute  RAP_|LOCAT: Conversion routine ATINM ignored
« M Attribute _RAP_PRDCT: Conwversion routine ALPHA ignored
« M Attribute _RAP_VARMT: Conversion routine ALPHA ignored
« N Attribute _RAP_VERSHN: Conversion routine ALPHA ignored
« & Attribute OFISCPER: Conversion routine PERI7 ignored
« M Attribute OFISCPER: Compounding ignored
« M Attribute OREQUID: Conversion routine RQUID ignored
« M Atkribute OUNIT: Conversion routine BUNIT ignored
Figure 13: Warnings
12. Activate Aggregation Levels.
1. Expand|}» Planning » Aggregation Level
2. Use Select Objects to select the following Aggregation Levels:
© /RAP/D20A01
© /RAP/R20A02
o /RAP/R20A06
© /RAP/R20A08
© /RAP/R20A11
© /RAP/R20A12
o /RAP/R20A15
© /RAP/R20A17
3. Choose Transfer Selections.

4. Inthe list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

13. Activate Planning Sequence Objects.

1. Expand|» Planning » Planning Sequence

2. Use Select Objects to select the following Planning Sequences:
© /RAP/C21A01 PSO1
© /RAP/D23A01 PsO1
© /RAP/D24A01 PSO1
© /RAP/R20A08 PSO1

3. Choose Transfer Selections.
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4. Inthe list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.
14. Activate Workbooks.

Expand |F More Types » Analysis Office Excel Workbook 4.
Use Select Objects to select the following workbooks:
© /RAP/PLANASSORTMENT

N

© /RAP/PLANOPTIONS
3. Choose Transfer Selections.

4. Inthelist of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

15. Choose Exit to leave the transaction.

6.2.3.3 Activate SAP HANA Content for SAP Assortment
Planning for Retail - Final Activation

Use

In this procedure, you perform the final activation of SAP HANA content (views and stored procedures) required
by the SAP Assortment Planning for Retail application. This final activation results in a full activation of the SAP
HANA content for SAP Assortment Planning for Retail. Several SAP HANA views depend on local Bl Content
objects, and as such, have to be activated following the activation of these Bl Content objects, as described in this
procedure.

Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Assortment Planning for
Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide. In
particular, Activate SAP HANA Content for SAP Assortment Planning for Retail - Initial Activation [page 85].

Procedure

1. Inyour back-end system, start transaction SE38.
2. Enter /CAR/ACTIVATE HTA andchoose Execute.

3. Select all applicable source master data systems, the Assortment Planning (Final) business scenarios, and
external systems for which you wish to activate HTA content.
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4. Optionally, choose the Perform Prerequisite Check option to validate the processing and read the system log

prior to applying any database changes.

5. Choose Execute.

More Information

If you encounter issues during the activation, see the Troubleshooting [page 166] section for possible
solutions.

For more information about activating SAP HANA content in SAP HANA studio, see http://help.sap.com/
hana_platforml|pr Development and Modeling » SAP HANA Developer Guide (For SAP HANA Studio) ¥ Setting
Up the Analytic Model  Creating Views # Activating Objects 3.

For more information about HTAs, see the Application Help for SAP NetWeaver 7.5 at https://help.sap.com/
saphelp_nw75/helpdata/en/ff/7652bd542849b18b218efe8d2f2373/content.htm?frameset=/en/34/
dfb3083df34453beb5eb8ade7bd4ed/frameset.htm&current_toc=/en/4e/
bfa9a86e391014adc9fffe4e204223/plain.htm&node_id=7&show_children=false.

6.2.3.4 Configure SAP Assortment Planning for Retail Local

Bl Content

6.2.3.4.1 Enable the Planning Application Kit (PAK)

Use

To be able to use the SAP BusinessObjects Analysis, edition for Microsoft Office workbooks provided as part of
the SAP Assortment Planning for Retail planning framework content, you must enable the Planning Application

Kit.

Procedure

1. Read SAP Note 1637199 # .

2. Inyour back-end system, launch table/view maintenance (transaction smM30).

3. Enter RSPLS HDB ACT in the Table/View field and choose Maintain.

4. Choose New Entries.

5. Inthe HANA Integratn. Active column select Deep HANA Integration Active and inthe Functn. Active

94

column, enable the checkbox.
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6.2.3.4.2 Maintain Customizing Table /RAP/RS_VARCUST

Use

In this procedure, you maintain entries in the variable customizing table /RAP/RS_VARCUST in the back-end
system. For each SAP Assortment Planning for Retail query, the entries of this table specify a mapping of a data
version (for example, actual data versus planning data) to the source of data (InfoCube).

Procedure

1. Logonto your back-end system.

2. Runreport /RAP/SEED BW CUSTOMIZING DATA (transaction SE38).

3. Determine whether you want to overwrite the existing entries in the /RAP/RS_VARCUST table.
If you do want to overwrite the contents of the table, enable the Remove Existing Entries option. If you don't
want to overwrite the contents of the table, but want to append the new entries, disable the Remove Existing
Entries option.

1 Note

Duplicate entries can potentially be created if you choose to disable the Remove Existing Entries option.
This could result in an error.

4. Enable the Test option and choose Execute to run the report in test mode.
Running the report in test mode allows you to verify that you can successfully update the /RAP/RS_ VARCUST
table. No entries are persisted in the table as a result.

5. Once you have successfully executed the /RAP/SEED BW CUSTOMIZING DATA reportin test mode, disable
the Test option and choose Execute to run the report.

6. Optionally, once the report has finished executing, you can verify the entries of the /RAP/RS_VARCUST
variable customizing table.
If required, you can make changes to any of the entries made by the /RAP/SEED BW CUSTOMIZING DATA

report by doing the following:
1. Open the Data Browser (transaction SE16).
2. Enter /RAP/RS_VARCUST in the Table Name field and choose Create Entries.

3. Choose Execute followed by Create.
On the Table /RAP/RS_VARCUST Insert screen, you will be able to make the following entries:

Table 38:

Field Name User Entry

COMPID SAP Assortment Planning for Retail technical query name.

For example, /RAP/C23A01 IRQO1.
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Field Name User Entry
VNAM ICUBE InfoCube variable name.
For example, /RAP/INFOPROV_ESM 21.
INFOCUBE InfoCube identifier.
For example, /RAP/RC21.
VNAM VERS Version variable name.
For example, /RAP/VERSN MSM 21.
VERSION Version Identifier.
There are several supported planning versions:

o AP1:Location level version 1. Version that is typically used as the planning version.

o aP2: Location level version 2. Version typically used to simulate different scenarios without
having to change your planned version.

o awWl: Week level version 1. Version that is typically used as the planning version.

o aw2: Week level version 2. Version typically used to simulate different scenarios without having
to change your planned version.

o op1: Option plan version 1. Version that is typically used as the planning version.

o op2: Option plan version 2. Version typically used to simulate different scenarios without hav-
ing to change your planned version.

o APF: Final version (planned data). After completing the planning, the user will select the plan
they want to finalize and review in the Plan Weekly Sales and Receipts workbook. Only the APF
version is available in Plan Weekly Sales and Receipts.

o REF: Reference version (past data). This is historical data for the items from the time frame of
the reference period. This data is used to pre-populate the planning version by using the copy
function. This allows the planner to have a baseline when starting the planning process. It is
recommended to seed the planning version with the REF data.

o 000: Actual version (current data). The user can see current inventory values with this such as
Actual Inventory and Open Orders.

o PRJ: Sales projection version.

F4HELP Flag that specifies whether the field provides F4 help or not.

4. Maintain entries in the /RAP/RS VARCUST table as required.
For example you can change the InfoCube used as the source of data for a particular planning version.

5. Choose Save.
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6.2.3.4.3 Maintain Fiscal Year Variant

Use

In this procedure you maintain the required fiscal year variant ( 0FISCVARNT 'RW'). SAP Assortment Planning
for Retail uses time objects 0FISCPER (fiscal year period) and 0FISCVARNT (fiscal year variant), provided as part
of the technical Bl Content, and activated in the Activate Technical Content [page 86] procedure.

Caution

You must maintain fiscal year variants for at least one year past the years for which you are planning. For
example, if your assortment plans extend to December 2018, you must maintain fiscal year variants until
December 2019.

The steps provided in this procedure allow you to maintain OFISCVARNT 'RW' using the standard 4-5-4 calendar
entries. If you are using alternative fiscal periods in your retail business, for example, each week starting on a
Sunday instead of Saturday, you can provide your own entries instead of the ones suggested in this guide.

Procedure

1. Logonto your back-end system.
2. Launch fiscal year variant maintenance (transaction GVAR).

3. Choose New Entries.
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4. Onthe New Entries: Overview of Added Entries screen make the following sets of entries:

Fiscal year variants

FV | Description Year-depen... Calendar yr Number of postin... No.ofspecialperi
RW Assort. Plan Week [v] O 53 =
r t

Figure 14: Create New Fiscal Year Variant
5. Choose Enter.
An information message is displayed about creating more than 16 periods, choose Continue.
6. Choose Back.
You can see the newly created entry.

7. Mark the entry RW and double-click on Shortened Fiscal Years from the Dialog Structure.

8. Enter 2012 in the Fiscal year field and choose Continue.

9. Choose New Entries.

10. Enter 52 in the No. of posting periods field in the Shortened Fiscal Years section.

11. Choose Back twice.

12. Open SAP Note 2112634#%, locate the entries for year 2012, and enter the data by copy-and-paste.

13. Repeat steps 7-12 to maintain the weekly fiscal year variant for years 2013, 2014, 2015, 2016, 2017, 2018,
2019, and 2020, entering each year as shortened fiscal year. The corresponding tables are available in SAP
Note 2112634 .

14. Choose Save after you have finished the maintenance for year 2020.
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6.2.3.5 Activate External Views

Use

During the activation of SAP HANA content for SAP Assortment Planning for Retail, several external views are not
automatically activated.

Procedure

1. Read and implement SAP Note 2067030 to manually activate external views.
You can use either transaction SE11 or SE80 to activate the views.

6.2.3.6 Verify the Connection Between SAP Assortment
Planning for Retail System and SAP BusinessObjects
Analysis, edition for Microsoft Office

Use

The SAP Assortment Planning for Retail application includes several SAP BusinessObjects Analysis, edition for
Microsoft Office workbooks. These workbooks, which are installed on your back-end system as part of the local Bl
Content, can only be opened using SAP BusinessObjects Analysis, edition for Microsoft Office.

In this procedure, you verify that you can open an SAP Assortment Planning for Retail workbook from SAP
BusinessObjects Analysis, edition for Microsoft Office.

Prerequisites

You have installed SAP BusinessObjects Analysis, edition for Microsoft Office as a prerequisite to the installation
of the SAP Assortment Planning for Retail application, as described in the Prerequisites [page 32] section.

Procedure

1. Open SAP BusinessObjects Analysis, edition for Microsoft Office from | Start » All Programs » SAP Business
Intelligence » SAP BusinessObjects Analysis » Analysis for Microsoft Excel .
2. From the File menu, select | Analysis » Open Workbook (Open Workbook from SAP NetWeaver) .

3. Select your back-end system.
Tip: The list of systems corresponds to the systems available in your SAP Logon.
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4. If single sign-on is not configured provide your user information.
5. Search for /RAP/* on the Search tab.
Alternatively, open the Folder tab and navigate to |» Assortment planning workbooks ¥ Workbooks 3.

6. Open any of the workbooks from the list of SAP Assortment Planning for Retail workbooks.
The opening of the workbook indicates that there are no issues with the connection between your back-end
system and SAP BusinessObjects Analysis, edition for Microsoft Office.

6.2.3.7 Specify Analysis Workbooks Settings

SAP Assortment Planning for Retail is delivered with a number of SAP BusinessObjects Analysis, edition for
Microsoft Office workbooks. These are template workbooks that you can adapt to use in your retail business.

For an example of how to create customized versions of the workbooks, see Workbook Design Example [page
220].

6.2.3.7.1 Enable Macros

Use

In this procedure, you enable your SAP BusinessObjects Analysis, edition for Microsoft Office workbooks to use
macros.

Procedure

1. Open SAP BusinessObjects Analysis, edition for Microsoft Office from |j» Start » All Programs » SAP
Business Intelligence » SAP BusinessObjects Analysis » Analysis for Microsoft Excel 3.

Choose |l File ¥ Options ¥ Customize Ribbon 3.

Under Customize the Ribbon, select Main Tabs.

Enable the entry Developer and confirm by choosing OK.

Now you will see the new Developer tab in your SAP BusinessObjects Analysis, edition for Microsoft Office.
Select the Developer Tab and choose Macro Security.

No gk wDn

Choose Enable all macros.
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6.2.3.7.2 Set Language for Ribbons and Buttons in

Workbooks

Use

In this procedure, you can set the desired language of the following user interface objects that are specific to the
workbooks of SAP Assortment Planning for Retail:

Ribbons Planning Functions, Refinement Functions, and Extended Features
Tooltips for planning functions

Message texts

Buttons.

The content of the workbooks consists of multiple parts:

The language of the standard menus and standard ribbons depends on the language set for Microsoft Excel.
The language of the contents in the cells (mainly KPIs) depends on the user-selected system language of the
back-end system.

The language of the user interface objects that are specific to the workbooks of SAP Assortment Planning for
Retail, is not set by the selected system language of the back-end system, but you can change it for each
workbook according to the following procedure. The default language is English.

Procedure

Unhide the worksheet SAP_TEXT_CUSTOMIZING using standard functionality of Microsoft Excel.

On the worksheet SAP_TEXT_CUSTOMIZING, copy the column of the desired language to column B - Custom
Text.

3. Hide the worksheet SAP_TEXT_CUSTOMIZING.

4. Save your changes in the worksheet on the SAP NetWeaver Server by choosing |# File » Analysis ¥ Save

Workbook to SAP NetWeaver 3.

1 Note

To allow for correct interpretation of the texts by screen readers, make sure that the language for all parts of
the workbooks is set to the same desired one. Set the language as described in this section.
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6.2.3.7.3 Set ResultSetSizeLimit Registry Setting

Use

By default, SAP BusinessObjects Analysis, edition for Microsoft Office workbooks are set to display 500,000 cells.
This setting might not be sufficient for the productive use of SAP Assortment Planning for Retail. For example, if
you have more than 300 products in your assortment plan, you might encounter the following error message:

[E' B9 -¢-|s

“ Home Insert Page Layout Formulas Data Review

j * Verdana -8 dAa = = - g
E - IR —
Paste o [B]Zz u-|EH- 2-A- E® W FEEE
Clipboard & Font ~ Alignment
v @ £
A B C D

1 Assortment Plan Status |Reference fi
2 Spring 2014 1234510102 01.08.2013
3

4

5 |Size limit of result set exceeded

Figure 15: Size Limit Error

To resolve this issue, you need to increase the default setting of the ResultSetsSizelLimit registry setting.

Procedure

Read and implement SAP Note 1662968 # .

1 Note

As the administrator overseeing the installation of SAP Assortment Planning for Retail, you need to carry out
the steps listed in this procedure on the workstation of each SAP Assortment Planning for Retail user.
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6.2.4 Configure Data Replication

SAP Assortment Planning for Retail uses master data, sales history data, inventory data, and merchandise
planning data originating from connected systems, such as SAP Retail (SAP ERP) or SAP BW.

The general flow of data in the SAP Assortment Planning for Retail is illustrated in the diagram below.

SAP BW
i ; SAP Merchandise Aggregated
— SAP Assortment Planning for Retail ‘ : . IS
Planning for Retail K |8 .
=
ge
1 slR al
B! b
il c E
=[5 S
22 M E
= HE

Read and Map
Merchandise Plan
Data in DDF

Generate Inventory
History
DDF Master Data
Inbound

SAP S/AHANA or
SAP ERP/Fashion
Management Data

POS Sales

Data
Create Time Replication
Series o -

SAP Customer ActivityRepository

SAP S/AHANA or SAP ERP/Fashion

Management

SAP HANA

Consumes SAP HANA views / procedures directly from the SAP HANA database

DDF Data

AFL
SAP Assortment SAP Merchandise Az itinne
O il Planning for Planning for Retail
Retall Data Data
[

Figure 16:; Data Flow to SAP Assortment Planning for Retail

POS

The following subsections describe the data replication tasks that you carry out to configure the data flow to the
SAP Assortment Planning for Retail application.

6.2.4.1 Initial Load of Data to DDF Using DRFOUT

Use

SAP Assortment Planning for Retail uses master data, such as product, location, and product hierarchy, that is
replicated from SAP Retail or SAP S/4HANA to DDF using DRFOUT. SAP Assortment Planning for Retail only
works with imported product hierarchies of type article hierarchy, maintained in the the source master data
system (SAP Retail or SAP S/4HANA). When configuring the import of product hierarchies, you must ensure to
import article hierarchies.
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1 Note

Not all of the master data is replicated into DDF using the DRFOUT framework. Some data must be replicated
separately using SLT replication, as described in Replicate SAP Retail or SAP S/4HANA Tables for SAP
Assortment Planning for Retail [page 110].

Prerequisites

Prior to replicating data from SAP Retail or SAP S/4HANA to DDF using DRFOUT, the following prerequisites must
be fulfilled:

e You must maintain the required article hierarchy(ies) in the source master data system (SAP Retail or SAP S/
4HANA) to be imported and used to perform planning in SAP Assortment Planning for Retail.

® Your SAP Retail installation is SAP Enhancement Package 6 for SAP ERP SPO7 or higher or SAP
Enhancement Package 5 for SAP ERP SP10 or higher.

e The following business functions are activated in SAP Retail or SAP S/4HANA:
©0 ISR APPL OUTBOUND DMF
© ISR RETAIL OUTBOUND DMF

® You have noted the different terms for the following objects:

Table 39:
SAP Retail or SAP S/4HANA SAP Retail DDF/SAP Assortment Planning for
Retail
Material Article Product
Plant Site Location
Procedure

. Read Enabling Demand Data Foundation and Creating Demand Forecast.
2. Read Configuring Data Replication from SAP ERP to DDF.
3. Replicate the required data.
If you are using SAP Promotion Management for Retail and SAP Assortment Planning for Retail, define a
replication model as described in Configuring Data Replication from SAP ERP to DDF. Otherwise, see the
additional instructions below.
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SAP Assortment Planning for Retail requires that the following master data is replicated sequentially from a
connected SAP Retail or SAP S/4HANA system using DREFOUT:

Table 40:
Sequence Master Data Technical Details For more information, see:
) o SAP Retail or SAP S/4HANA De-
1 Product Hierar- o ) ) http://help.sap.com/carl} <your
h scription: Material Group Hierarchy
o DRFOUT Outbound Implementa- release> > Application Help > Demand
tion: pMCH Data Foundation ¥ Integration
o DDF Inbound Interface: /DMF/ Information > Inbound Interfaces For
MDIF PROD HIER INBOUND Remote Function Call (RFC)
Communication > Product Hierarchy
Master Data ]
o SAP Retail or SAP S/4HANA De-
2 Product o _ http://help.sap.com/car|pF <your
scription: Material
o DRFOUT Outbound Implementa- release> ¥ Application Help » Demand
tion: PMAT Data Foundation ¥ Integration
o DDF Inbound Interface: /DMF/ Information > Inbound Interfaces For
MDIF_PRODUCT INBOUND Remote Function Call (RFC)
Communication > Product Master
Data }
) o SAP Retail or SAP S/4HANA De-
3 Location o http://help.sap.com/carl} <your
scription: Plant
o DRFOUT Outbound Implementa- release> > Application Help > Demand
tion: PPLT Data Foundation # Integration
o DDF Inbound Interface: /DMF/ Information ¥ Inbound Interfaces For
MDIF LOCATION_INBOUND Remote Function Call (RFC)
Communication > Product Location
Master Data ]
) o SAP Retail or SAP S/4HANA De-
4 Product Location o ) http://help.sap.com/carl} <your
scription: Material/Plant
o DRFOUT Outbound Implementa- release> ¥ Application Help # Demand
tion: PMPL Data Foundation # Integration
o DDF Inbound Interface: /DME/ Information > Inbound Interfaces For
MDIF PROD LOC_INBOUND Remote Function Call (RFC)
Communication > Product Location
Master Data }
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Sequence Master Data Technical Details For more information, see:
) o SAP Retail or SAP S/4HANA De- o
5 Product Location o , http://help.sap.com/car| Application
scription: Sales Price
o DRFOUT Outbound Implementa- Help > Demand Data Foundation >
tion: PSPR Integration Information > Inbound
o DDF Inbound Interface: /DMF/ Interfaces For Remote Function Call
MDIF PROD LOC INBOUND (RFC) Communication # Product
Location Master Data 1
o SAP Retail or SAP S/4HANA De-
6 Inventory o http://help.sap.com/carl} <your
scription: Inventory
o DRFOUT Outbound Implementa- release> > Application Help > Demand
tion: pINV Data Foundation @ Integration
o  DDF Inbound Interface: /DMF/ Information > Inbound Interfaces For
OPIF_INVENTORY INBOUND Remote Function Call (RFC)
Communication > Inventory Master
Data 1
) o SAP Retail or SAP S/4HANA De- o
7 Product Location o ‘ _ http://help.sap.com/carlr Application
scription: Moving Average Price
o DRFOUT Outbound Implementa- Help > Demand Data Foundation >
tion: pMAP Integration Information > Inbound
o DDF Inbound Interface: /DMF/ Interfaces For Remote Function Call
MDIF PROD LOC INBOUND (RFC) Communication  Product
Location Master Data 4
) o SAP Retail or SAP S/4HANA De-
8 Transportation o http://help.sap.com/carl} <your
L scription: Source of Supply
ane o
o DRFOUT Outbound Implementa- release> > Application Help > Demand
tion: PSOS Data Foundation * Integration
o  DDF Inbound Interface: /DMF/ Information > Inbound Interfaces For
MDIF LANE_INBOUND Remote Function Call (RFC)
Communication > Transportation Lane
Master Data ]
) o SAP Retail or SAP S/4HANA De-
9 Location L http://help.sap.com/carl} <your
scription: Vendor
o DRFOUT Outbound Implementa- release> > Application Help > Demand
tion: PVEN Data Foundation @ Integration
o DDF Inbound Interface: /DMF/ Information > Inbound Interfaces For
MDIF LOCATION INBOUND Remote Function Call (RFC)
Communication > Location Master
Data }
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Sequence Master Data Technical Details For more information, see:
) o SAP Retail or SAP S/4HANA De- o
10 Product Hierar- L . ) http://help.sap.com/carl} Application
h scription: Article Hierarchy
chy ;
o DRFOUT Outbound Implementa- Help > Demand Data Foundation >
tion: PAHY Integration Information } Inbound

o DDF Inbound Interface: /DMF/ Interfaces For Remote Function Call

MDIF PROD HIER INBOUND (RFC) Communication  Product

Hierarchy Master Data ]

You can import the data into staging tables, and then transfer this data to production tables using
report /DMF/PROCESS STAGING TABLES. Or you can skip the staging tables, and import the data directly
into the production tables. For more information, see:

o http://help.sap.com/carl| <your release> }» Application Help » Demand Data Foundation  Integration
Information j Inbound Processing 4

o http://help.sap.com/carlp <your release> » Application Help » Demand Data Foundation » General
Services » Monitor Imports ¥ Process Inbound Staging Tables 3

More Information

For more information on monitoring the replication, see:

e http://help.sap.com/car|p <your release> » Application Help » Demand Data Foundation » General Services

» Monitor Imports 3
® Perijodic Tasks section under Management

6.2.4.2 Load of Time-Dependent Article Hierarchies

Use

SAP Assortment Planning for Retail supports the use of time-dependent article hierarchies.

Procedure

To enable the use of time-dependent article hierarchies in SAP Assortment Planning for Retail, do the following:

1. Implement SAP Notes 2196323#% and 2196351# in the connected SAP ERP system.

2. If your hierarchy is already a time-dependent hierarchy, you need to re-import the product hierarchies into
SAP Assortment Planning for Retail using the DRFOUT framework.

o SAP ERP Description: Article Hierarchy
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o DRFOUT Outbound Implementation: PAHY
© DDF Inbound Interface: /DMF/MDIF PROD HIER INBOUND

6.2.4.3 Initial Load of Sales Data

Use

The initial load of historical sales data can vary depending on your particular landscape.

Procedure

Initial Load from SAP BW

If you have accumulated large amounts of historical sales data using SAP POS Data Management or SAP
Customer Activity Repository, it is possible that you are storing these large data sets in a connected SAP BW
system. In such a case, you can perform the initial load of the sales time series (historical POS data) data into DDF
using the Bl Interface for Time Series report.

Log on to your back-end system.
Execute transaction SE38.
Specify /DMF/BI_IF_TS inthe Program field and choose Execute.

A w oo

Read the documentation associated with the report, carry out the described Customizing, and run the report
accordingly.

= Recommendation

Specify ORPA €01, ORPA C02,and ORPA C03 data sources in the Bl DataSource field of the Interface for
Initial Data from Bl to Time Series - Profile Customizing activity.

Initial Load from SAP Customer Activity Repository

If you are using SAP Customer Activity Repository and storing your historical sales data in the /POSDW/TLOGF
table, you can use the standard outbound task 0050 to send data to DDF. This outbound task sends data using an
RFC connection and the /DMF/BI SALES DATA function module.

For more information, see http://help.sap.com/car|p <your release> » Application Help » POS Data Transfer and
Audit » Task Processing # Tasks for Sending Data to Follow-On Applications » Sending Data to DMF-Based
Applications .

Enhancements for Historical Cost

Once the initial load of sales data is complete, we recommend that you enhance the sales records with the
historical cost of the products at the locations where they were sold. As illustrated in the diagram below, you add
the historical cost to the sales records using the BAdI: Determination of Purchase Price for Sales History Record.

This BAdI is located in Customizing under [+ Cross-Application Components » Demand Data Foundation
Imported Data » Time Series j» Enhancements Using Business Add-Ins 3.
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Figure 17: Adding Historical Cost to Sales Records

More Information

http://help.sap.com/car{¢ <your release> » Application Help » Demand Data Foundation ¥ Integration

Information » Inbound Interfaces For Remote Function Call (RFC) Communication j» Sales Time Series

6.2.4.4 Delta Load of Data to DDF Using DRFOUT

When performing a delta load of master data from SAP Retail or SAP S/4HANA using the DRFOUT framework,
you must ensure that the product location data required to enhance the sales records with historical sales cost is
loaded prior to the sales data.

Furthermore, we recommend that you schedule a weekly periodic task to replicate inventory data (outbound
implementation PINV) from the SAP Retail or SAP S/4HANA system to the system for SAP Assortment Planning
for Retail. This replication builds up the inventory history data that is needed by SAP Assortment Planning for
Retail.
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6.2.4.5 Delta Load of Sales Data in SAP Customer Activity
Repository

Use

Once the initial load of historical sales data is completed, or, if you are working on a brand new system
implementation and do not have to perform an initial sales data load, you need to configure the periodic delta load
of sales data in SAP Customer Activity Repository.

Procedure

1. Ensure that you have properly configured the POS Sales Transfer and Audit functionality in SAP Customer
Activity Repository to receive transaction data from your connected POS systems.
For more information, see Performing POS Data Transfer and Audit.

2. Ensure that you have configured the Supply - DMF-Based Applications outbound tasks to load sales data from
POS Sales Transfer and Audit to DDF.

For more information, see http://help.sap.com/carllr <your release> » Application Help *» POS Data Transfer
and Audit » Task Processing » Tasks for Sending Data to Follow-On Applications » Sending Data to DMF-
Based Applications 3.

3. Monitor the transfer of sales time series data as described in http://help.sap.com/carll <your release> »
Application Help » Demand Data Foundation » General Services » Monitor Imports 3.

4. Specify Point of Sale Data as the source of sales data in Customizing under |+ Cross-Application Components
» Assortment Planning for Retail » Imported Demand Data Foundation Settings » Data Maintenance ¥ Define

Time Series Source 4.

More Information

http://help.sap.com/car|l <your release> ¥ Application Help ¥ Demand Data Foundation j Integration

Information * Inbound Interfaces For Remote Function Call (RFC) Communication » Sales Time Series 4

6.2.4.6 Replicate SAP Retail or SAP S/4HANA Tables for
SAP Assortment Planning for Retail

Use

In this procedure, you ensure that all SAP Retail or SAP S/4HANA tables that are relevant for SAP Assortment
Planning for Retail have not only been created but have also been filled with data. More specifically, you replicate
the contents of relevant tables from the source SAP Retail or SAP S/4HANA system to your back-end system.
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1 Note

If you have already replicated the relevant tables in the Create/Replicate Source Master Data System Tables
[page 49] procedure, you can skip this procedure.

The steps outlined in this procedure are required when you are implementing one of the system landscape
variants that require data to be replicated from a source SAP Retail or SAP S/4HANA system. If your source SAP
Retail or SAP S/4HANA system and your back-end system are co-deployed on the same SAP HANA database,
proceed to the next procedure. For more information, see System Landscape Variants.

Procedure

1. Ensure that you have created an SAP Client and specified the required Customzing settings as described in
Set Up SAP Client [page 47].

2. Specify which SAP Retail or SAP S/4HANA tables to replicate using information from one of the two following
sources:

o SAP Note 2385706#%, for installations based on the sap_ECC schema
o SAP Note 2388669#%, for installations based on the SAP_s4H schema
For more information, see:

o http://help.sap.com/hbal Installation, Security, Configuration, and Operations Information
Administrator's Guide  Configuration Steps ¥ Replicate Data (Side-by-Side Only) 3

o http://help.sap.com/hanalr SAP HANA » SAP HANA Options » SAP HANA Real-Time Replication » SAP
HANA Trigger-Based Data Replication Using SAP LT Replication Server  System Administration and
Maintenance Information » Configuration Information and Replication Concepts » ( <Managing the
Replication Process Using the SAP HANA Studio>and <Important Transactions and

Control Tables>) 4

Caution

This procedure includes the replication of tables from your source SAP Retail or SAP S/4HANA system.
Trigger-based replication includes deletion in source tables by archiving activities (since on the database
level it is impossible to distinguish between delete actions caused by archiving and regular deletion of data
records). As aresult, SAP LT (Landscape Transformation) Replication Server replicates archiving activities
as delete actions in the SAP HANA database.

More specifically, when data is archived in your source SAP Retail or SAP S/4HANA system, records are
deleted from their respective database tables. Therefore, when these tables are replicated to another SAP
HANA database, the records that were archived in the source tables are deleted in the target database
tables.

When deciding on the frequency at which to archive data in the source SAP Retail or SAP S/4HANA
system, you must consider and balance the performance requirements of your SAP Retail or SAP S/
4HANA system and the amount of historical data that should be replicated to and available in your back-
end system.
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6.2.4.7 Load Product Attributes into SAP Assortment
Planning for Retail

Use

SAP Assortment Planning for Retail allows you to view product attributes imported from SAP Retail or SAP S/
4HANA. To enable this functionality, you must first run reports that import product characteristics (attributes), as
well as their assignments to products, defined in SAP Retail or SAP S/4HANA .

Procedure

1. Logonto your back-end system.

2. Navigate to | SAP Customizing Implementation Guide » Cross-Application Components # Assortment
Planning for Retail ¥ Imported Demand Data Foundation Settings ¥ Data Maintenance ¥ Attributes 3 and
ensure that you have specified all the required entries in the following Customizing activities:

o Define Function Types
o Maintain Number Range for Attributes
o Maintain Number Range for Attribute Values
If necessary, provide custom implementations for the BAdIs listed in this Customizing node, for example, to
import additional attributes or values.
o BAdI: Support Assignment of User-Defined Attribute Types
o BAdI: Manage Attributes and Function Types
o BAdI: Extraction of Location Attributes
3. Ensure that you have implemented SAP Note 2197010 #% .
4. Runreports /DMF/ATR IMPORT and /DMF/PROD ATR IMPORT (transaction SE38).

More Information

For more information, see Periodic Tasks section of the SAP Assortment Planning for Retail Administrator's Guide.

6.2.4.8 Load Merchandise Planning Data

Use

Merchandise planning data, can be used by the SAP Assortment Planning for Retail application to help set
planning targets. To access merchandise plan data in SAP Assortment Planning for Retail, this data must first be
imported into the DDF module in your back-end system.
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By default, SAP Assortment Planning for Retail is configured to consume merchandise planning data from SAP
Merchandise Planning for Retail, another consuming application of SAP Customer Activity Repository.

If you are using the SAP Planning for Retail, rapid-deployment solution for merchandise planning, KPIs (including
planned sales, open orders, and purchase quantities) are stored in SAP Business Warehouse (SAP BW)
InfoProviders. To access these figures from SAP Assortment Planning for Retail, this data must first be imported
from the SAP BW system to your back-end system, as described in SAP Note 2208191 #& .

Procedure

To consume merchandise planning data from the SAP Merchandise Planning for Retail application, do the
following:

1. Verify that in the Define SAP BW Application for Merchandise Planning Customizing activity, under | Cross-
Application Components » Assortment Planning for Retail  Imported Demand Data Foundation Settings
Integration 3, the default settings are applied as follows:

o Destination: LOCAL
If this field is empty, the application assumes that the InfoProvider exists in the back-end system, which is
the case if SAP Assortment Planning for Retail and SAP Merchandise Planning for Retail are installed on
the same back-end system.

o InfoProvider: /RAP/MPRCO1

2. Remaining in the Define SAP BW Application for Merchandise Planning Customizing activity, specify the same
Fiscal Year Variant as the one maintained under | Cross-Application Components ¥ Assortment Planning for
Retail » Maintain fiscal year variant 4.

3. Verify that in the Define Field Mapping for Merchandise Planning Customizing activity, also under, [ Cross-
Application Components ¥ Assortment Planning for Retail  Imported Demand Data Foundation Settings ¥

Integration 3, the default settings for field-mapping to the SAP Merchandise Planning for Retail InfoProvider
are maintained.

4. Setupthe SAP BW to Merchandise Plan Interface report ( /DMF/BI_IF MERCH PLAN intransaction SE38)to
run as a background job to regularly import any updates from SAP Merchandise Planning for Retail to DDF.

More Information

® http://help.sap.com/mpr

e http://help.sap.com/bicontent|r <your release> j» SAP Library » Bl Content & Bl Content Extensions » Bl
Content  Industry Solutions » Trading Industries * Retail Trade » Merchandise and Assortment Planning »
Retail Planning » MultiProvider » Merchandise Retail Plan 3

e http://service.sap.comtr|l Products » SAP Rapid Deployment Solutions (RDS) » A-Z Index » P » SAP
Planning for Retail rapid-deployment solution 3
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6.2.5 Run the Validation Report

1. Runtransaction /DMF/VAL CAR INSTALL.
Alternatively, run transaction SE38 and execute the /DMF/VALIDATE CAR INSTALLATION report.

2. Select the Assortment Planning scenario and select Execute.
Running this report allows you verify the success of the installation, providing a log of potential issues. For
example, you may be presented with the following results:

el [SIF B EPL) E L) (S JE L) o [@2 Ao [@ o]

Type Message Text LTxt
— Check - Instaled SAP Notes

- Check - Planning Application Kit (PAK)

— Check - Fiscal Calendar

Maintain fiscal year variant 'RW'.

— Check - SAP HANA Time Dimension

Maintain SAP HANA time dim. at least 2 years back and 5 years in future.
— Check - Table /RAP/RS_VARCUST

- Check - BI Master Data for Planning Versions

— Check - BI Technical Content Activation

— Check - BI APR Content Activation

— Check - SAP HANA AFL PAL

— Check - SAP HANA AFL OFL

&

5

DNEERNEmEEEmE

-
) Icﬁ,» Technical Information Jlil Help J@

Figure 18: Validation Report Results

View the long text associated with each message to see the link to the documentation describing the
procedure you need to troubleshoot.

6.2.6 Configure Front-End
6.2.6.1 Configure SAP Gateway
6.2.6.11 Perform General SAP Gateway Configuration

Use

Prior to connecting the SAP Gateway on your front-end server to your back-end system, you need to perform a
series of general SAP Gateway configuration steps. These configuration steps include the setting of profile
parameters, ICF (Internet Communication Framework) services, language settings, and so on.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.
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Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o  SAP Gateway for SAP NetWeaver 7.31
See http://help.sap.com/nwgateway20|}¢ Application Help » SAP NetWeaver Gateway Configuration
Guide » Basic Configuration Settings 3.
o SAP Gateway for SAP NetWeaver 7.40
See http://help.sap.com/nw74|l Application Help ¥ Function-Oriented View ¥ SAP NetWeaver Gateway
Foundation (SAP_GWFND) » SAP NetWeaver Gateway Foundation Configuration Guide ¥ General
Configuration Settings 3.
o SAP Gateway for SAP NetWeaver 7.50
See http://help.sap.com/nw75l Application Help ¥ Function-Oriented View » SAP Gateway Foundation
(SAP_GWFND) » SAP Gateway Foundation Configuration Guide » General Configuration Settings 3.

6.2.6.1.2 Connect SAP Gateway to Your Back-End System

Use

In this procedure, you configure the OData Channel, that is, set up a connection between SAP Gateway on your
front-end server and your back-end system.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.

Procedure

1. Setup the required roles on the front-end server and assign your user to these roles.
For more information, see http://help.sap.com/nw75| Application Help  Function-Oriented View # SAP
Gateway Foundation (SAP_GWFND) » SAP Gateway Foundation Configuration Guide » SAP Gateway

Configuration ¥ User, Developer and Administrator Roles 3.
2. Specify the connection settings on the SAP Gateway hub system, which include:
o Connection from the SAP Gateway to consumer systems
These settings allow the connection between the SAP Gateway host and the consumer systems (clients
from which you access the SAP Fiori user interfaces).
o Connection from the SAP Gateway to SAP back-end system
These settings allow the connection between SAP Gateway to your back-end system.
These settings include:
o Creating a type 3 connection from the SAP Gateway host to your back-end system.
o Defining a trust relationship between your back-end system and the SAP Gateway host.
o Configuring your back-end system to accept SAP assertion tickets from the SAP Gateway host.
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o Configuring your SAP Gateway host to accept SAP assertion tickets from your back-end system.
o Configuring the necessary system aliases.

More Information

For SAP NetWeaver 7.31, see SAP Library for SAP NetWeaver Gateway on SAP Help Portal at http://
help.sap.com/nwgateway20lr Application Help » Support Package Stack » SAP NetWeaver Gateway
Configuration Guide » OData Channel Configuration » Connection Settings on the SAP NetWeaver Gateway Hub
System 1.

For SAP NetWeaver 7.4, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw74
| Application Help ¥ Function-Oriented View » SAP NetWeaver Gateway Foundation (SAP_GWFND) # SAP
NetWeaver Gateway Foundation Configuration Guide » SAP Gateway Configuration » Connection Settings for the
SAP Gateway Hub System 3.

For SAP NetWeaver 7.5, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw75
| Application Help #» Function-Oriented View » SAP Gateway Foundation (SAP_GWFND) » SAP Gateway
Foundation Configuration Guide » SAP Gateway Configuration j» Connection Settings for the SAP Gateway Hub
System 1.

6.2.6.1.3 Activate SAP Gateway

Use

Before you can use SAP Gateway functionality, you have to activate it globally on your front-end server.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.

Procedure

1. Determine the SAP NetWeaver version of your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o  SAP Gateway for SAP NetWeaver 7.31
See http://help.sap.com/nwgateway20lr Application Help » SAP NetWeaver Gateway Configuration
Guide » OData Channel Configuration ¥ Activating SAP NetWeaver Gateway 3.
o SAP Gateway for SAP NetWeaver 7.4
See http://help.sap.com/nw74llr Application Help ¥ Function-Oriented View » SAP NetWeaver Gateway
Foundation (SAP_GWFND) » SAP Gateway Foundation Configuration Guide }» SAP Gateway Configuration
» Activating SAP Gateway 3.
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o SAP Gateway for SAP NetWeaver 7.5
See http://help.sap.com/nw75l Application Help ¥ Function-Oriented View » SAP Gateway Foundation
(SAP_GWFND) » SAP Gateway Foundation Configuration Guide » SAP Gateway Configuration
Activating SAP Gateway 1.

6.2.6.1.4 Activate Common OData Services

Use

A number of OData services are required to run the SAP Fiori launchpad. These OData services are delivered as
part of the SAP Fiori front-end server. For more information, see the Prerequisites section in this guide.

For security reasons, all OData services are delivered in an inactive state. To use the SAP Fiori launchpad, you
must activate the common SAP Fiori OData services.

Procedure

1. Logonto your front-end system (your SAP Gateway system).
2. Go to Customizing (transaction SPRO).
3. Navigate to [ SAP NetWeaver » Gateway » OData Channel » Administration ¥ General Settings » Activate
and Maintain Services 3.
You are presented with the service catalog. This is a list of all the services that are currently active on your
SAP Gateway.
4. Get common SAP Fiori OData services:
1. Choose Add Service.
The Add Service screen is displayed.
2. Enter the system alias of your local front-end system.
This is the alias created in the Connect SAP NetWeaver Gateway to your Back-End System [page 115]
procedure. For example, LOCAL.
3. Enter /u1i2*inthe Technical Service Name field.
4. Choose Get Services.
The Add Selected Services screen is displayed.
5. Select the common SAP Fiori OData services that you would like to activate, and choose Add Selected
Services.

Table 41:

Service Name

/U12/PAGE_BUILDER CONF

/U12/PAGE_BUILDER CUST

Common Installation Guide CARAB 2.0
Post-Installation CUSTOMER 17


http://help.sap.com/nw75

I
Service Name

/UI2/PAGE BUILDER PERS

/UI2/TRANSPORT

/UI2/INTEROP

The selected OData services are now active in your SAP Gateway.

More Information

e For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at http://
help.sap.com/nw-uiaddon20| Application Help » SAP Fiori Launchpad # Setting Up the Launchpad ¥
Activating SAP Gateway OData Services 3.

e For SAP NetWeaver 7.4, see the documentation on SAP Help Portal at http://help.sap.com/nw74
| Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 740 » SAP Fiori Launchpad j Setting Up
the Launchpad ¥ Activating SAP Gateway OData Services 4.

e For SAP NetWeaver 7.5, see the documentation on SAP Help Portal at http://help.sap.com/nw75
|+ Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 750 » SAP Fiori Launchpad » Setting Up
the Launchpad ¥ Activating SAP Gateway OData Services 4.

6.2.6.2 Configure Index Calculation

Use

The SAPUI5 application index provides an indexing and caching mechanism for information related to SAPUI5
apps, components, and libraries that are contained in SAPUI5 repositories on the SAP NetWeaver Application
Server for ABAP. This index, calculated by the Calculation of SAPUI5 Application Index for SAPUI5 Repositories
report ( /UI5/APP_INDEX CALCULATE), makes it possible to retrieve and find this information significantly faster
than when carrying out the calculations each time it's requested.

We recommend that you schedule the Calculation of SAPUI5 Application Index for SAPUI5 Repositories report as
to run as a background job on your front-end server.

Following any changes to the content of the SAPUI5 ABAP repository (for example, installation of a new version of
the SAPUI5 distribution layer or implementation of an SAP Note containing changes to an SAPUI5 app), the
SAPUI5 application index should be updated using the calculation report. This report has to be executed in every
system whenever the content of the SAPUI5 ABAP repository has changed.
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Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o SAP Gateway for SAP NetWeaver 7.31
http://help.sap.com/nw-uiaddon20l+ Application Help » SAPUI5: Ul Development Toolkit for HTML5 ¥
Developing Apps # The SAPUI5 ABAP Repository and the ABAP Back-End Infrastructure » SAPUI5

Application Index J
o SAP Gateway for SAP NetWeaver 7.40

http://help.sap.com/nw74|p Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 740 ¥

SAPUI5: Ul Development Toolkit for HTML5 » Using the SAPUI5 Repository # SAPUI5 Application Index 3
Alternatively, you can launch the Calculation of SAPUI5 Application Index for SAPUI5 Repositories report

(/UT5/APP INDEX CALCULATE) from Customizing under [ SAP NetWeaver » Ul Technologies » SAP
Fiori ¥ Initial Setup ¥ Schedule SAPUI5 Application Index Calculation 3.

o  SAP Gateway for SAP NetWeaver 7.50
http://help.sap.com/nw75|» Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 750 »
SAPUI5: Ul Development Toolkit for HTML5 ¥ Developing Apps # The SAPUI5 ABAP Repository and the
ABAP Back-End Infrastructure » SAPUI5 Application Index 3

6.2.6.3 Configure Central SAP Fiori Ul Component

Use

The central SAP Fiori Ul component (delivered as part of the SAP Fiori front-end server) contains the SAPUI5
control library and the SAP Fiori launchpad. Prior to being able to use the SAP Fiori apps that constitute the user
interface of the retail applications described in this guide, you may need to configure the SAP Fiori launchpad.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.

For more information, see the Prerequisites section in this guide.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o  SAP Gateway for SAP NetWeaver 7.31
o http://help.sap.com/nw-uiaddon20|p Application Help » SAP Fiori Launchpad 3, and
o http://help.sap.com/nw-uiaddon20|p System Administration and Maintenance Information »
Administrator's Guide ¥ Configuration and Operations » Content Administration » SAP Fiori Launch
Page ¥ Setting Up the SAP Fiori Launch Page J
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o SAP Gateway for SAP NetWeaver 7.40
o http://help.sap.com/nw74lr Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 740
» SAP Fiori Launchpad 3, and
o http://help.sap.com/nw74|r Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 740
» SAP NetWeaver User Interface Services » Configuration and Operations » Content Administration »
SAP Fiori Launchpage » Setting Up the SAP Fiori Launch Page 3
o SAP Gateway for SAP NetWeaver 7.50
o http://help.sap.com/nw75|p Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 750
» SAP Fiori Launchpad 3, and
o http://help.sap.com/nw75|p Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 750
» SAP NetWeaver User Interface Services » Configuration and Operations » Content Administration
SAP Fiori Launch Page j Setting Up the SAP Fiori Launch Page 3

6.2.6.4 Activate SAP Assortment Planning for Retail OData
Services

Use

A number of OData services are required to run the SAP Assortment Planning for Retail application.

For security reasons, all OData services are delivered in an inactive state. You must activate these application-
specific OData services to use the SAP Fiori user interface of the SAP Assortment Planning for Retail application.

Procedure

Log on to your front-end system (your SAP NetWeaver system).
2. Goto Customizing (transaction SPRO).

3. Navigate to |+ SAP NetWeaver ¥ Gateway  OData Channel » Administration » General Settings ¥ Activate

and Maintain Services 3.
You are presented with the service catalog. This is a list of all the services that are currently active on your
SAP Gateway.
4. Get SAP Assortment Planning for Retail OData services:
1. Choose Add Service.
The Add Service screen is displayed.
2. Enter the system alias of your back-end system.
This is the alias created for your back-end system in the Connect SAP NetWeaver Gateway to your Back-
End System [page 115] procedure. For example RAPCLNT100.
3. Enter /DMF* in the Technical Service Name field.

4. Choose Get Services.
The Add Selected Services screen is displayed.
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5. Select the SAP Assortment Planning for Retail OData services you would like to activate, and choose Add
Selected Services.

Table 42:

OData Service

/DMF/CURRENCY LIST SRV

/DMF/LOCATION CLUSTERSET SRV

/DMF/MODULE _MANAGEMENT SRV

/DMF/OBJ_ATTRIBUTE SRV

/DMF/SEARCH LOCATIONS SRV

/DMF/SEARCH PRODUCTS_SRV

/DMF/SEASONS_SRV

/DMF/MASTER DATA SRV

The selected OData services are now active in your SAP Gateway.

6. Enter /RAP* in the Technical Service Name field.

7. Choose Get Services.
The Add Selected Services screen is displayed.

8. Select the SAP Assortment Planning for Retail OData services you would like to activate, and choose Add
Selected Services.

Table 43:

OData Service

/RAP/ASSORTMENT LIST SRV/

/RAP/OPTION PLAN SRV

/RAP/PHP MATCH SRV

/RAP/VALIDITY PERIOD SRV

The selected OData services are now active in your SAP Gateway.

More Information

For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at http://
help.sap.com/nw-uiaddon20|» Application Help » SAP Fiori Launchpad ¥ Setting Up the Launchpad * Activating
SAP Gateway OData Services 3.
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For SAP NetWeaver 7.4, see the documentation on SAP Help Portal at http://help.sap.com/nw74|s Application
Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 740 » SAP Fiori Launchpad y Setting Up the Launchpad
Activating SAP Gateway OData Services 3.

For SAP NetWeaver 7.5, see the documentation on SAP Help Portal at http://help.sap.com/nw75|p Application
Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 750 » SAP Fiori Launchpad ¥ Setting Up the Launchpad ¥
Activating SAP Gateway OData Services 3.

6.2.6.5 Activate SAP Assortment Planning for Retail ICF
Services

Use

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Assortment
Planning for Retail application are made available in an inactive state.

You have activated the central ICF services in the Perform General SAP NetWeaver Gateway Configuration [page
1147 and Configure Central Ul Component [page 119] procedures. This procedure provides the instructions to
activate ICF services required for the SAP Assortment Planning for Retail SAP Fiori apps.

Procedure

Log on to your front-end server.
2. Open service maintenance (transaction SICF).
3. Inthe Maintain Service screen, select the Location Clustering service by specifying the following:
o Hierarchy Type: SERVICE
© Virtual Host: DEFAULT HOST
o Service Path: /sap/bc/ui5_ui5/sap/locclsts_v2/
4. Choose Execute.

o

To activate the service, choose Service/host Activate.

6. Repeat steps 3 to 5 to ensure that all of the following services are activated:
© /sap/bc/ui5 uib5/sap/attribmgmt v2/

O /sap/bc/ui5 uiS5/sap/assortlist/

0 /sap/bc/ui5 ui5/sap/ddfreuse v2/

© /sap/bc/uib ui5/sap/locclsts v2/

© /sap/bc/ui5 ui5/sap/modulemgmt v2/

© /sap/bc/ui5 ui5/sap/optionplan v2/

0 /sap/bc/ui5 ui5/sap/phpmatch v2/
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6.2.6.6 Define System Alias for Back-End Transactions

Use

A number of SAP Assortment Planning for Retail SAP Fiori apps, installed on your front-end system, launch
transactions directly on the back-end system. For example, the Manage Products tile actually launches the
Demand Data Foundation (DDF) powL EASY WebDynpro application.

To enable this behavior, you need to create a dedicated RFC connection between the front-end and the back-end
systems.

Procedure

1. Logonto your front-end system, that is, the system where you have installed the user interface (Ul)
components of the SAP Assortment Planning for Retail application.

2. Launch Configuration of RFC Connections (transaction sM59).

3. Create an RFC connection with the RFC Destination set to SAP_ ISR CARAB and Connection Type setto H
(HTTP connection).
Ensure to maintain all of the settings required to connect to your back-end system, in particular, the Target
Host entry on the Technical Settings tab.

4. Create another RFC connection with the RFC Destination setto SAP_ ERP_ ISR CARAB and Connection Type
set to H (HTTP connection).
Ensure to maintain all of the settings required to connect to your front-end system to the SAP Retail or SAP
S/4HANA system, in particular, the Target Host entry on the Technical Settings tab.

5. Save your changes.

6. Open Launchpad Customizing (transaction LPD_CUST).

7. Select the SAP Assortment Planning for Retail role (UIRAP001), and choose Display.
The two catalogs, Assortment Planner and Planning Administrator, are displayed.

8. Ineach of the catalogs, selecting one app at a time, make the following settings:

Table 44:
Catalog App System Alias Description
Assortment View Log SAP ISR CARAB This setting allows the My Assortment Plans (Version 2)
Planner app to launch transaction s1.G1 on the back-end system.

1 Note

This application is only used to configure a link to the
back-end system, you do not need to add this app to
your SAP Fiorilaunchpad.
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Catalog ’ App ’ System Alias Description
View ExtAssort SAP_ERP_ISR CAR | This setting allows the My Assortment Plans (Version 2)
Listing Conditions AB app to launch transaction wsL.10 on the connected SAP
Retail or SAP S/4HANA system.
1 Note
This application is only used to configure a link to the
SAP Retail or SAP S/4HANA system, you do not need
to add this app to your SAP Fiori launchpad.
View External SAP_ERP_ISR CAR | This setting allows the My Assortment Plans (Version 2)
Assortments AB app to launch transaction WRF_wWSOA3 on the connected
SAP Retail or SAP S/4HANA system.
1 Note
This application is only used to configure a link to the
SAP Retail or SAP S/4HANA system, you do not need
to add this app to your SAP Fiori launchpad.
Assortment Manage Category SAP ISR CARAB This setting allows the Manage Category Responsibilities
Planner responsibilities app to launch the corresponding DDF WebDynpro applica-
tion.
Manage Products SAP ISR CARAB This setting allows the Manage Products app to launch the
corresponding DDF WebDynpro application.
Manage Locations SAP_ ISR CARAB This setting allows the Manage Locations app to launch
the corresponding DDF WebDynpro application.

6.2.6.7 Assign Roles, Catalogs, and Groups in SAP Fiori

Use

Launchpad

To be able to access SAP Fiori apps that constitute the SAP Assortment Planning for Retail user interface from
the SAP Fiorilaunchpad, your front-end system user must have the necessary roles assigned. Based on the
role(s) assigned to your user, you can access certain business catalogs and business catalog groups.
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Your SAP Assortment Planning for Retail application is delivered with two predefined roles, catalogs, and groups.
These include technical content as well as business content:

Table 45:
Front-End Server Business Content Front-End Technical Content
Business Role Business Catalog Business Catalog Group Technical Role Technical
Catalog
SAP RAP BCR AP PLA | SAP RAP BC AP PLAN | SAP RAP BCG AP PLANNER SAP_RAP TCR T SAP_RAP TC_
NNER NER T

SAP RAP BCR PLANNI | SAP RAP BC PLANNIN | SAP_RAP BCG PLANNING ADM
NG_ADMIN G_ADMIN N

To test the installation of SAP Assortment Planning for Retail from the SAP Fiori launchpad, you need to assign
the roles above to your user on the front-end system.

Procedure

Log on to your front-end system.
Launch User Maintenance (transaction su01).

Enter your user name in the User field and choose Change.

~w oo

Onthe Roles tab, assign the roles SAP RAP BCR AP PLANNER and SAP RAP BCR PLANNING ADMIN to your
user.

A\ Caution

If you already have an SAP Fiori launchpad open, you must clear your browser cache to apply any
modifications made to your user roles. Otherwise, your changes will not be reflected in the SAP Fiori user
interface.

More Information

Security Information section of the SAP Assortment Planning for Retail Administrator's Guide.

6.2.7 Configure SAP Jam (Optional)

Use

Your retail application uses collaboration SAP UI5 components to define key ABAP-based SAP business object
data that can be consumed by the SAP Jam social collaboration platform.
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If you are using SAP Jam, you can configure the integration between your retail application and SAP Jam. The
integration, enabled by Social Media Integration, allows you to share, or expose, the pre-defined ABAP-based SAP
business object data directly from your retail application with members of your organization, through SAP Jam.

The steps to enable the integration between your retail application and SAP Jam are not specific to this guide and
are described in the User Interface Add-On 1.0 for SAP NetWeaver product documentation referenced below.

Prerequisites

To enable the integration of your retail application with SAP Jam, you must have a license for SAP Jam
Collaboration, enterprise edition, and your SAP Jam instance must be configured for productive use.

Procedure

1. Read the documentation for the user interface add-on available on SAP Help Portal at http://help.sap.com/

netweaver|lr User interface add-on 1.0 for SAP NetWeaver i Application Help ¥ Social Media Integration 3.
This documentation provides important information on configuring the integration of your retail application
with SAP Jam, including the following sections:

o About SAP Jam Integration
Sections under Information for Administrators:

o Understanding the Overall Process for Integrating Collaboration for a Business Object

o Implementation of ABAP Social Media Integration (ABAP SMI)

o Implementation of Collaboration Components

o Connecting to SAP Jam with ABAP SMI

o Configuring ABAP SMI for SAP Fiori Apps

More Information

® Forthe latest updates on SAP Jam, see SAP Help Portal at http://help.sap.com/sapjam.

e For configuration and maintenance information for SAP Jam, see http://help.sap.com/sapjam|p SAP Jam

Collaboration System Administration Information * Administrator Guide 3.

6.3 SAP Customer Activity Repository

The following diagram depicts the post-installation process for SAP Customer Activity Repository 2.0.

Common Installation Guide CARAB 2.0
126 CUSTOMER Post-Installation


http://help.sap.com/netweaver
http://help.sap.com/netweaver
http://help.sap.com/sapjam
http://help.sap.com/sapjam

Activate SAP HAMA Content

A

Co—deplwed""-\_..,____ YES
with SAPERP -
. 0noneHANAT -~

lND

W

Replicate 54F ERP Tables

]

Post-Installation

-
A S

I

Replicate Qptional Tables (Qptional)

Generate Time Data

r

Cownfigure SAP Smart Business for Multichanael
Sales Analrtics (Optiaral)

Configure 240 On-Shelf dvailability (Qptionall

J

Ersure that the CRM sales orders are ‘

transferred o SAPERP (Qpfionall

J

Partition SPOSDWATLOGEE table (Qptionall ‘

Cushomize copies of AP HANS views (Dptiomal)

‘ Configure DOF [Qptianal

Cowfiqure Unified Demand Forecast (Dptional)

‘ Paition Tables for UOF and DOF (Optionall

r

Configure Standalone SAP Fion Apps for 540
Custormer Activity Repositons (Optionall

Use with SAP Custormer Activity Repositons

". Configure Qrarichannel Arkicle Availability for
(Cptional)

Use with ZAP Custormer Ackivity Repositons

". Configure Qrmwichannel Provaction Pricing for
[Optiomal)

Figure 19: Post-Installation Workflow for SAP Customer Activity Repository
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6.3.1 Configure SAP Smart Business for Multichannel Sales
Analytics (Optional)

6.3.11 Install the SAP Smart Business Modeler Apps
Framework

The SAP Smart Business for Multichannel Sales Analytics apps included in this installation are based on the SAP
Smart Business Modeler Apps Framework. Installation and setup of this framework includes the following:

e |[nstallation of SAP Smart Business Modeler apps on the front-end server
e |nstallation of SAP Smart Business products on the SAP HANA Server

e |nstallation of SAP Web Dispatcher

e Communication channels

e Appimplementation

For more information on these topics, see http://help.sap.com/nw-uiaddon| <your release> » Application Help
» SAPUI5: Ul Development Toolkit for HTML5 » SAPUI5 Application Frameworks # SAP Smart Business ¥ Setting
up the SAP Smart Business Modeler Apps Framework 3.

1 Note

If you are installing User Interface Add-On 2.0 for SAP NetWeaver, you must download and install add-on
object UISAFND1 100 as described in SAP Note 2183947 ¥ .

6.3.1.2 Install SAP HANA Live for SAP ERP

This section describes how to install SAP HANA Live under different implementation conditions:

e |f you are implementing a deployment option that requires data to be replicated from a source SAP ERP
system, see Deployment Scenario: SAP Customer Activity Repository Standalone or Co-Deployed with SAP
BW [page 129].

e [fyou are implementing a deployment option in which your source SAP ERP system and SAP Customer
Activity Repository are co-deployed on the same SAP HANA database, see Deployment Scenario: SAP
Customer Activity Repository Co-Deployed with SAP ERP [page 130].

For more information, see System Landscape Variants.
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6.3.1.2.1 Deployment Scenario: SAP Customer Activity
Repository Standalone or Co-Deployed with SAP
BW

Use

SAP Smart Business for Multichannel Sales Analytics requires that SAP HANA Live for SAP ERP is installed,
configured, and connected to the same SAP HANA database that you plan to use for SAP Customer Activity
Repository.

For more information on installing SAP HANA Live for SAP ERP, see http://help.sap.com/hball Installation,
Security, Configuration, and Operations Information » Administrator's Guide 3.

Caution

SAP Customer Activity Repository does not require that you execute all of the installation steps exactly as they
are described in the Administrator's Guide, SAP HANA Live for SAP Business Suite. Prior to executing steps that
describe the creation and replication of SAP ERP tables, be sure to read the additional instructions for SAP
Customer Activity Repository provided in this guide.

Process

1. Ensure that the SAP Landscape Transformation component (SAP LT Replication Server) is installed.
2. Configure access from the SAP LT Replication Server to the source SAP ERP system (RFC connection) and
from SAP LT Replication Server to the target SAP HANA database.
For more information, see:
o http://help.sap.com/hball Installation, Security, Configuration, and Operations Information
Administrator's Guide ¥ Pre-Installation Steps 3.

o http://help.sap.com/hanallr SAP HANA » SAP HANA Options » SAP HANA Real-Time Replication » SAP
HANA Trigger-Based Data Replication Using SAP LT Replication Server » System Administration and
Maintenance Information ¥ ( <Technical Prerequisites and Authorization Aspects>and
<Accessing the Configuration and Monitoring Dashboard>) 4

3. Ensure that your back-end system is connected to SAP HANA studio.
If necessary, set the connection as follows:

1. Logonto SAP HANA studio.

2. Right-click in the Navigator pane and select Add System.

3. Enter the required information the Specify System dialog:

© Host Name
© Instance Number
o System Description
4. Specify your system User Name and Password in the Connection Properties dialog.

4. Ensure that a database catalog schema is created on the target SAP HANA database. This is the schema on
your SAP HANA database to which the SAP ERP data will be replicated.
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For more information, see:

o http://help.sap.com/hball Installation, Security, Configuration, and Operations Information

Administrator's Guide » Pre-Installation Steps 3
o http://help.sap.com/hana_platforml|r Development and Modeling ¥ SAP HANA Developer Guide »

Setting up the Persistence Model i Creating the Persistence Model with HDBTable ¥ Creating a Schema 3
5. Map the authoring schema of the sap.hba.ecc content package to your particular physical database
schema, described in the previous step. If the physical database schema to which the SAP ERP data will be
replicated is already called sap_ECC, this schema mapping is not required.

Table 46:
Authoring Schema Physical Schema
SAP_ECC <Name of Your Schema for Storing SAP ERP
Data>

For more information, see:

o http://help.sap.com/hball Installation, Security, Configuration, and Operations Information ¥
Administrator's Guide ¥ Pre-Installation Steps 3

o http://help.sap.com/hana_platforml| Development and Modeling » SAP HANA Modeling Guide
Importing Table Definitions and Data » Map Authoring Schema to the Physical Schema 3.

6. Create the tables that are required by SAP HANA Live for ERP views on the target SAP HANA database using
the instructions provided in SAP Note 1799313 . The tables that are required to be created are listed in the
following SAP Notes:

o 1782065#
o 1781992##

The creation of the tables on the target SAP HANA database is required so that the content package of SAP
HANA Live for ERP can be deployed and activated correctly.

Caution

You must not replicate any data to these tables at this point. Data replication is performed during
post-installation.

7. Deploy the SAP HANA Live for ERP content package on the SAP HANA database.
For more information, see http://help.sap.com/hball Installation, Security, Configuration, and Operations
Information » Administrator's Guide » Pre-Installation Steps 3.

6.3.1.2.2 Deployment Scenario: SAP Customer Activity
Repository Co-Deployed with SAP ERP

Use

SAP Customer Activity Repository requires that SAP HANA Live for SAP ERP is installed, configured and
connected to the same SAP HANA database that you plan to use for SAP Customer Activity Repository.
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For more information on installing SAP HANA Live for SAP ERP, see http://help.sap.com/hbalp Installation,

Security, Configuration, and Operations Information » Administrator's Guide 3.

Caution

SAP Customer Activity Repository does not require that you execute all of the installation steps exactly as they
are described in the Administrator's Guide, SAP HANA Live for SAP Business Suite. Be sure to read the
additional instructions for SAP Customer Activity Repository provided in this guide.

Process

1. Ensure that your back-end system is connected to SAP HANA studio.
If necessary, set the connection as follows:
1. Logonto SAP HANA studio.
2. Right-click in the Navigator pane and select Add System.
3. Enter the required information the Specify System dialog:
o Host Name
o Instance Number
o System Description
4. Specify your system User Name and Password in the Connection Properties dialog.
2. Map the authoring schema of the sap.hba.ecc content package to your particular physical database
schema. If the physical database schemais already called sap_Ecc, this schema mapping is not required.

Table 47:

Authoring Schema Physical Schema

SAP_ECC <Name of Your Schema for Storing SAP ERP

Data>

For more information, see:
o http://help.sap.com/hball Installation, Security, Configuration, and Operations Information
Administrator's Guide » Pre-Installation Steps 3.
o http://help.sap.com/hana_platforml| Development and Modeling » SAP HANA Modeling Guide ¥
Importing Table Definitions and Data » Map Authoring Schema to the Physical Schema 3.

3. Ensure that all the standard SAP ERP tables listed in SAP Notes 1782065#% and 1781992#% are present on

your SAP HANA database.
The presence of these tables on the SAP HANA database is required so that the content package of SAP

HANA Live for ERP can be deployed and activated correctly.
4. Deploy the SAP HANA Live for ERP content package on the SAP HANA database.
For more information, see http://help.sap.com/hball Installation, Security, Configuration, and Operations

Information » Administrator's Guide » Pre-Installation Steps 3.
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6.3.1.3 Configure SAP NetWeaver Gateway
6.3.1.3.1 Perform General SAP Gateway Configuration

Use

Prior to connecting the SAP Gateway on your front-end server to your back-end system, you need to perform a
series of general SAP Gateway configuration steps. These configuration steps include the setting of profile
parameters, ICF (Internet Communication Framework) services, language settings, and so on.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o SAP Gateway for SAP NetWeaver 7.31
See http://help.sap.com/nwgateway 20| Application Help » SAP NetWeaver Gateway Configuration
Guide ¥ Basic Configuration Settings 3.
o SAP Gateway for SAP NetWeaver 7.40
See http://help.sap.com/nw74|p Application Help ¥ Function-Oriented View » SAP NetWeaver Gateway
Foundation (SAP_GWFND) » SAP NetWeaver Gateway Foundation Configuration Guide » General

Configuration Settings 3.
o SAP Gateway for SAP NetWeaver 7.50

See http://help.sap.com/nw75l Application Help  Function-Oriented View » SAP Gateway Foundation
(SAP_GWFND) » SAP Gateway Foundation Configuration Guide  General Configuration Settings 3.

6.3.1.3.2 Connect SAP Gateway to Your Back-End System

Use

In this procedure, you configure the OData Channel, that is, set up a connection between SAP Gateway on your
front-end server and your back-end system.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.
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Procedure

1. Setup the required roles on the front-end server and assign your user to these roles.
For more information, see http://help.sap.com/nw75| Application Help  Function-Oriented View # SAP
Gateway Foundation (SAP_GWFND) » SAP Gateway Foundation Configuration Guide » SAP Gateway
Configuration ¥ User, Developer and Administrator Roles 3.
2. Specify the connection settings on the SAP Gateway hub system, which include:
o Connection from the SAP Gateway to consumer systems
These settings allow the connection between the SAP Gateway host and the consumer systems (clients
from which you access the SAP Fiori user interfaces).
o Connection from the SAP Gateway to SAP back-end system
These settings allow the connection between SAP Gateway to your back-end system.
These settings include:
o Creating a type 3 connection from the SAP Gateway host to your back-end system.
o Defining a trust relationship between your back-end system and the SAP Gateway host.
o Configuring your back-end system to accept SAP assertion tickets from the SAP Gateway host.
o Configuring your SAP Gateway host to accept SAP assertion tickets from your back-end system.
o Configuring the necessary system aliases.

More Information

For SAP NetWeaver 7.31, see SAP Library for SAP NetWeaver Gateway on SAP Help Portal at http://
help.sap.com/nwgateway20|l Application Help » Support Package Stack » SAP NetWeaver Gateway
Configuration Guide ¥ OData Channel Configuration » Connection Settings on the SAP NetWeaver Gateway Hub
System 3.

For SAP NetWeaver 7.4, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw74
|» Application Help ¥ Function-Oriented View » SAP NetWeaver Gateway Foundation (SAP_GWFND) » SAP
NetWeaver Gateway Foundation Configuration Guide » SAP Gateway Configuration j» Connection Settings for the
SAP Gateway Hub System 1.

For SAP NetWeaver 7.5, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw75
|+ Application Help ¥ Function-Oriented View ¥ SAP Gateway Foundation (SAP_GWFND) » SAP Gateway
Foundation Configuration Guide » SAP Gateway Configuration # Connection Settings for the SAP Gateway Hub
System 1.

6.3.1.3.3 Activate SAP Gateway

Use

Before you can use SAP Gateway functionality, you have to activate it globally on your front-end server.
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These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.

Procedure

1. Determine the SAP NetWeaver version of your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o  SAP Gateway for SAP NetWeaver 7.31
See http://help.sap.com/nwgateway 20|l Application Help ¥ SAP NetWeaver Gateway Configuration
Guide » OData Channel Configuration j» Activating SAP NetWeaver Gateway 4.
o SAP Gateway for SAP NetWeaver 7.4
See http://help.sap.com/nw74|l Application Help ¥ Function-Oriented View ¥ SAP NetWeaver Gateway
Foundation (SAP_GWFND) » SAP Gateway Foundation Configuration Guide » SAP Gateway Configuration
» Activating SAP Gateway 3.
o  SAP Gateway for SAP NetWeaver 7.5
See http://help.sap.com/nw75l Application Help # Function-Oriented View » SAP Gateway Foundation
(SAP_GWFND) » SAP Gateway Foundation Configuration Guide » SAP Gateway Configuration »
Activating SAP Gateway J.

6.3.1.3.4 Activate Common OData Services

Use

A number of OData services are required to run the SAP Fiori launchpad. These OData services are delivered as
part of the SAP Fiori front-end server. For more information, see the Prerequisites section in this guide.

For security reasons, all OData services are delivered in an inactive state. To use the SAP Fiori launchpad, you
must activate the common SAP Fiori OData services.

Procedure

Log on to your front-end system (your SAP Gateway system).
2. Go to Customizing (transaction SPRO).

3. Navigate to |+ SAP NetWeaver » Gateway » OData Channel » Administration » General Settings # Activate

and Maintain Services J.
You are presented with the service catalog. This is a list of all the services that are currently active on your
SAP Gateway.
4. Get common SAP Fiori OData services:
1. Choose Add Service.
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The Add Service screen is displayed.

2. Enter the system alias of your local front-end system.
This is the alias created in the Connect SAP NetWeaver Gateway to your Back-End System [page 115]
procedure. For example, LOCAL.

3. Enter /u1i2*inthe Technical Service Name field.

4. Choose Get Services.
The Add Selected Services screen is displayed.

5. Select the common SAP Fiori OData services that you would like to activate, and choose Add Selected
Services.

Table 48:

Service Name

/UI2/PAGE BUILDER CONF

/U12/PAGE_BUILDER CUST

/UI2/PAGE _BUILDER PERS

/UI2/TRANSPORT

/UI12/INTEROP

The selected OData services are now active in your SAP Gateway.

More Information

e For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at http://
help.sap.com/nw-uiaddon20|j¢ Application Help ¥ SAP Fiori Launchpad ¥ Setting Up the Launchpad ¥

Activating SAP Gateway OData Services 1.
e For SAP NetWeaver 7.4, see the documentation on SAP Help Portal at http://help.sap.com/nw74

| Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 740 » SAP Fiori Launchpad ¥ Setting Up
the Launchpad ¥ Activating SAP Gateway OData Services 3.

e For SAP NetWeaver 7.5, see the documentation on SAP Help Portal at http://help.sap.com/nw75
| Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI 750 » SAP Fiori Launchpad ¥ Setting Up
the Launchpad ¥ Activating SAP Gateway OData Services 3.

6.3.1.4 Configure the SAP Web Dispatcher

To configure the SAP Web Dispatcher, see SAP Help Portal at http://help.sap.com/nw_platform|lk <your release>
» Application Help ¥ Function-Oriented View * Application Server » Application Server Infrastructure »
Components of SAP NetWeaver Application Server » SAP Web Dispatcher » Administration of the SAP Web
Dispatcher .
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If you use any other reverse proxy, see the manufacturer's documentation for more information.

6.3.1.5 Configure Central SAP Fiori Ul Component

Use

The central SAP Fiori Ul component (delivered as part of the SAP Fiori front-end server) contains the SAPUI5
control library and the SAP Fiori launchpad. Prior to being able to use the SAP Fiori apps that constitute the user
interface of the retail applications described in this guide, you may need to configure the SAP Fiori launchpad.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.

For more information, see the Prerequisites section in this guide.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o  SAP Gateway for SAP NetWeaver 7.31
o http://help.sap.com/nw-uiaddon20| Application Help » SAP Fiori Launchpad 3, and
o http://help.sap.com/nw-uiaddon20|p System Administration and Maintenance Information
Administrator's Guide ¥ Configuration and Operations ¥ Content Administration  SAP Fiori Launch
Page ¥ Setting Up the SAP Fiori Launch Page
o  SAP Gateway for SAP NetWeaver 7.40
o http://help.sap.com/nw74lp Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 740
» SAP Fiori Launchpad 3, and
o http://help.sap.com/nw74lp Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 740
» SAP NetWeaver User Interface Services » Configuration and Operations » Content Administration
SAP Fiori Launchpage ¥ Setting Up the SAP Fiori Launch Page 3
o SAP Gateway for SAP NetWeaver 7.50
o http://help.sap.com/nw75|l Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 750
» SAP Fiori Launchpad 3, and
o http://help.sap.com/nw75| Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 750
» SAP NetWeaver User Interface Services » Configuration and Operations » Content Administration
SAP Fiori Launch Page j Setting Up the SAP Fiori Launch Page 3
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6.3.1.6 Configure SAP Jam (Optional)

Use

Your retail application uses collaboration SAP UI5 components to define key ABAP-based SAP business object
data that can be consumed by the SAP Jam social collaboration platform.

If you are using SAP Jam, you can configure the integration between your retail application and SAP Jam. The
integration, enabled by Social Media Integration, allows you to share, or expose, the pre-defined ABAP-based SAP
business object data directly from your retail application with members of your organization, through SAP Jam.

The steps to enable the integration between your retail application and SAP Jam are not specific to this guide and
are described in the User Interface Add-On 1.0 for SAP NetWeaver product documentation referenced below.

Prerequisites

To enable the integration of your retail application with SAP Jam, you must have a license for SAP Jam
Collaboration, enterprise edition, and your SAP Jam instance must be configured for productive use.

Procedure

1. Read the documentation for the user interface add-on available on SAP Help Portal at http://help.sap.com/

netweaver|r User interface add-on 1.0 for SAP NetWeaver » Application Help » Social Media Integration 3.
This documentation provides important information on configuring the integration of your retail application
with SAP Jam, including the following sections:

o About SAP Jam Integration
Sections under Information for Administrators:

o Understanding the Overall Process for Integrating Collaboration for a Business Object

o Implementation of ABAP Social Media Integration (ABAP SMI)

o Implementation of Collaboration Components

o Connecting to SAP Jam with ABAP SMI

o Configuring ABAP SMI for SAP Fiori Apps

More Information

e For the latest updates on SAP Jam, see SAP Help Portal at http://help.sap.com/sapjam.

e For configuration and maintenance information for SAP Jam, see http://help.sap.com/sapjaml|F SAP Jam

Collaboration System Administration Information » Administrator Guide .
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6.3.2 Activate SAP HANA Content

Use

In this procedure, you activate all SAP HANA Transport for ABAP (HTA) content required in your implementation
scenario. For each SAP HANA content package, there is one HTA object.

This activation report can be run as many times as your implementation scenario requires.

Example

You can run this report during your initial implementation which includes only the SAP Business Suite on
HANA and SAP Customer Activity Repository.

Later on in the lifecycle of your implementation project, you can run this report again when you add
Assortment Planning as a new business scenario and integration of customer data with SAP Hybris
Marketing.

When you upgrade your support package stack in the future and decide to migrate your source master
data system from SAP Business Suite on SAP HANA to SAP S/4HANA, you can run this report yet again.

Prerequisites

You have implemented the following mandatory SAP Notes for the activation report: 2388066#%, 2390790
P and 2392194 ¥

You have successfully completed all of the procedures listed in the previous sections of this guide.

You have created all the necessary tables, as described in Create/Replicate Source Master Data System
Tables.

If you want to use UDF forecasting in your scenario, you must first set up the required roles and privileges as
described in Authorization Requirements for Unified Demand Forecast. This ensures that the HTA content for
UDF can be activated correctly.

Additionally, you must select the |» Business Scenarios Activation ¥ Forecasting 3 option in the activation
report.

Procedure

138

In your back-end system, start transaction SE38.
Enter /CAR/ACTIVATE HTA and choose Execute.

. Select all applicable source master data systems, business scenarios, and external systems for which you

wish to activate HTA content.

Optionally, choose the Perform Prerequisite Check option to validate the processing and read the system log
prior to applying any database changes.

Choose Execute.
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More Information

If you encounter issues during the activation, see the Troubleshooting [page 166] section for possible
solutions.

For more information about activating SAP HANA content in SAP HANA studio, see http://help.sap.com/
hana_platforml|pr Development and Modeling » SAP HANA Developer Guide (For SAP HANA Studio) # Setting
Up the Analytic Model  Creating Views ¥ Activating Objects 3.

For more information about HTAs, see the application help for SAP NetWeaver 7.5 at https://help.sap.com/
saphelp_nw75/helpdata/en/ff/7652bd542849b18b218efe8d2f2373/content.htm?frameset=/en/34/

dfb3083df34453beb5eb8ade7bd4ed/frameset.ntm&current_toc=/en/4e/
bfa9a86e391014adcOfffede204223/plain.htm&node_id=7&show_children=false.

6.3.3 Generate Time Data

Use

In this procedure, you generate time data that is required by time-dependent views included in SAP HANA content
for SAP Customer Activity Repository. In particular, time data is required for all query views that are based on one
of the Sales Analysis virtual data models.

Caution

If you are not using the time-dependent views provided in SAP HANA content for SAP Customer Activity
Repository, you do not need to execute this procedure.

For example, if you are using SAP Assortment Planning for Retail, you use the time objects 0FISCPER (fiscal
year period) and 0FISCVARNT (fiscal year variant) provided as part of the technical Bl Content. For more
information, see Activate Technical Content [page 86] and Maintain Fiscal Year Variant [page 97].

Procedure

1
2.

Log on to SAP HANA studio.

In the Modeler perspective, on the Quick Launch tab, select your SAP Customer Activity Repository system
and choose Generate Time Data.

Select the Calendar Type.

SAP HANA views included in SAP HANA content for SAP Customer Activity Repository require the presence
of timedatain sys BI.TIME DIMENSION* SAP HANA database tables. To populate these tables, select
Gregorian as the Calendar Type.

The Fiscal Calendar Type is not recommended. For analytical reports on a particular fiscal period, the SAP
HANA views included in SAP HANA content for SAP Customer Activity Repository do not rely on the

_SYS BI.M FISCAL_CALENDAR SAP HANA database tables. Instead, SAP HANA content for SAP Customer
Activity Repository uses the sap.hba.ecc/Fiscal* views for fiscal period-based reporting.
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4. Enter arange of years that includes all the years of data that you plan to store in SAP Customer Activity
Repository.

Example

If you plan to start using SAP Customer Activity Repository on January 1, 2014, enter 2014 as your starting
year. But if you plan to access sales documents created in SAP ERP that date from January 2013, you
should specify 2013 as your starting year.

5. Define the granularity as Day, which is the minimum granularity required by SAP Customer Activity
Repository. You can choose a finer level of granularity, for example Hour, if necessary.

6. Choose the day that is the first day of the week in your company.
7. Choose Generate.

For more information, see:
e http://help.sap.com/hbalp Installation, Security, Configuration, and Operations Information  Administrator's

Guide » Configuration Steps ¥ Generate Time Data 3

e http://help.sap.com/hana_platform|p Development and Modeling » SAP HANA Developer Guide ¥ Setting Up
the Analytic Model ¥ Creating Views  Create Attribute Views #» Generate Time Data 3

6.3.4 Configure On-Shelf Availability (Optional)

1 Note

The steps in this section and all subsections are entirely optional and depend on your specific implementation
requirements.

Note that configuration of the On-Shelf Availability module is mandatory if you want to generate intraday
forecasts. For more information about this feature, see http://help.sap.com/carlp <your release> »
Application Help » SAP Customer Activity Repository ¥ Unified Demand Forecast » General Services

Generate Intraday Forecasts 3.

On-Shelf Availability (OSA) has its own database schema on the SAP HANA Platform (SAPOSA). To use the OSA
functionality in SAP Customer Activity Repository, perform the following post-installation steps.
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6.3.4.1 Generate Run IDs for OSA Processing Steps

Use

Each scheduled run of an OSA processing step has a generated run ID. This is the unique identification for a job.
The run ID is used to distinguish several runs within one period. Each processing step has its own ID generator:

Table 49:
Processing step Transaction for the Generator
Intraweek Pattern /OSA/NR_IWP
Estimation /OSA/NR_EST
Monitoring /OSA/NR_MON
Analysis /OSA/NR_ANA

For each of the four transactions, you must define the range of run IDs.

Procedure

1. Execute transaction /OSA/NR _ <XXX>. <XXX> represents the part of the transaction name that is specific
for a processing step.
2. Inthe first row of the table, enter the following values for the fields No, From No., and To Number:
o No: 01
©  From No.: 0000000000000001
o To Number: 9999999999999999

6.3.4.2 Check Field Contents in SAP HANA Content for On-
Shelf Availability

Use

There are two OSA-specific SAP HANA views that can be customized:

® AN TRANSACTION
® PROMOTION_ TRANS

You have to check if the fields in these views contain the mappings or formulas you need.
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Caution

If you need to modify any of the views, be aware, that new installation will rewrite the modifications. It is
therefore recommended to back up the modified views.

Procedure

If you want to change the mapping or a formula of a field, perform the following steps:

Define the data foundation that is the source for the view, that is, the table /POSDW/TLOGF.
Define filters for the view.
Map the fields from source to target.

N

Create measures and calculation fields.

For detailed information, see http://help.sap.com/hana_appliance| Development and Modeling 3.
Definitions for a view taking the example of the AN_TRANSACTION view
The following definitions are set by default for the AN TRANSACTION view:

e Source of the view is the table /POSDW/TLOGF
e Examples of filters for the views:
© RECORDQUALIFIER = '5':Only sales records are used
© DATASTATUS in ('2' , '3'"):Onlythoserecords are used which passed the SAP Customer Activity
Repository validation
© RETAILQUANTITY > 0.0:Negative quantities are not used by On-Shelf Availability
0 VOIDEDLINE = '':Cancelledtransactions are not used by On-Shelf Availability
e Examples of the fields mappings:
o MaNDT: Client id. This field is mapped to the MANDT column of the /POSDW/TLOGF table.
o0 STORE_1ID: Storeid. This field is mapped to the RETAILSTOREID column of the /POSDW/TLOGF table.
© BUSINESSDAYDATE: Business day. This field is mapped to the BUSINESSDAYDATE column of the /POSDW/
TLOGF table.
e Examples of measures:
0 RETAILQUANTITY: Amount of sold units. Refers to the saLESUOM (Sales Unit of Measure) field that is also
defined in the /POSDW/TLOGF table. Contains the value of the RETATLQUANTITY field.
o PRICE: Price specified in the store currency. Contains the value of the ACTUALUNITPRICE field.
e Examples of calculated fields:
© TRANS TIME DBL:Value of the TRANS TIME output field of type DOUBLE. The format of the transaction
time that is stored in BEGINTIMESTAMP and ENDTIMESTAMP is “YYYYMMDDhhmmss".
© DISCOUNT: Total relative discount applied on the item.
Calculated as (ITEMDISC + DISTDISC) / (RETAILQUANTITY * ACTUALUNITPRICE). If the price is not
positive number, O is returned.
Definitions:
o DISTDISC: global discount on the whole purchase; currently not used.
o |ITEMDISC: item-specific discount; currently used.
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6.3.4.3 Activate SAP HANA Content for On-Shelf Availability

Use

In this procedure, you activate all SAP HANA content required by On-Shelf Availability.

Procedure

Log on to your back-end system.
. Execute transaction SE38.

1
2
3. Specify SNHI NHDU POST PROCESS in the Program field and choose Execute.
4

. Ifyou are running SAP NetWeaver 7.4 SPS 05 or higher, make the following entries:

Table 50:

Parameter

Transport Container Name

Instruction

/OSA/HCO_POSDMEXT

Activate Delivery Unit Content

Select the checkbox.

Activate HTC

Do not select the checkbox.

5. Choose Execute.

All objects belonging to the delivery unit will be activated in the SAP HANA repository. This process can take

several minutes. Once the activation process is complete, you are notified whether or not the import and
activation of the SAP HANA delivery unity was successful.

6.3.4.4 Verify that SAP HANA Content for On-Shelf

Availability has been activated

Log on to SAP HANA studio.
Open the Modeler perspective.

Expand the Content folder.

I N

O sap.is.retail.posdmext.
O sap.is.retail.posdmext.
O sap.is.retail.posdmext.
O sap.is.retail.posdmext.

O sap.is.retail.posdmext.
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osa.

Oosa.

Oosa.

osa

osa

Expand the package hierarchy by choosing | sap  is  retail » posdmext » osa 4.
Verify that the following views have been activated:

tlog.an transaction
tlog.promotion trans

status_log view

.reporting.MON ANA VIEW

.reporting.STATUS LOG_VIEW

In the Navigator window, expand the database system for which you have activated the views.
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7. Verify that the following procedures have been activated:

1. Proceduresinthe package sap.is.retail.posdmext.osa.common:
© CREATE LOG_ENTRY
© PARSE HOLIDAY STRING
© PARSE TYPE CODE_STRING

2. Procedures in the package sap.is.retail.posdmext.osa.tlog.dao:
© GET TRX FOR PRODUCT
© GET TRX FOR STORE
© GET TRX FOR SUBDEP
© GET TRX FOR SUBDEP WITH MIN
© GET TRX INFO FOR_PRODUCT
© GET TRX FOR SUBDEP CURRENCY

3. Proceduresinthe package sap.is.retail.posdmext.osa.pattern.dao:
O PERSIST
© GET_ INTRA WEEK PATTERN RUNS
© GET INTRA WEEK PATTERN LATEST
© GET INTRA WEEK PATTERN
© GET INTRA WEEK PATTERN FOR PRODUCT

P

Procedures in the package sap.is.retail.posdmext.osa.pattern.runner.internal:
© CALL FUNCTION
© CALL_ALGO FOR_STORE
© CALL ALGO _FOR SUBDEP
o CALL_ALGO_PRODUCT_IN_SUBDEP
5. Procedures in the package sap.is.retail.posdmext.osa.pattern.runner.public:
© RUN _FOR_PRODUCT IN SUBDEP
O RUN_FOR_STORE
© RUN_FOR_SUBDEP
6. Procedureinthe package sap.is.retail.posdmext.osa.pattern.test:
© TEST L INTEGRATION
7. Procedureinthe package sap.is.retail.posdmext.osa.estimation.config:
O GET CONFIG
8. Procedures in the package sap.is.retail.posdmext.osa.estimation.dao:
O PERSIST
© GET PARAMETER
© GET PARAMETERS
9. Procedures in the package sap.is.retail.posdmext.osa.estimation.runner.internal:
o CALL_FUNCTION
© CALL ALGO_PRODUCT IN SUBDEP
10. Procedure in the package sap.is.retail.posdmext.osa.estimation.runner.public:
© RUN_FOR PRODUCT IN SUBDEP
11. Procedure in the package sap.is.retail.posdmext.osa.estimation.test:
© TEST L INTEGRATION
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12. Procedures in the package sap.is.retail.posdmext.osa.monitor.dao:
O PERSIST
© CREATE STATUS LOG ENTRIES
© UPDATE STATUS TABLE
© CREATE STATUS LOG ENTRIES FOR EXCL PRODUCTS
© UPDATE STATUS TABLE FOR EXCL PRODUCTS
13. Procedures in the package sap.is.retail.posdmext.osa.monitor.runner.internal:
© CALL FUNCTION
© CALL ALGO PRODUCT IN SUBDEP
© RUN_FOR PRODUCT IN SUBDEP
14. Procedures in the package sap.is.retail.posdmext.osa.monitor.runner.public:
© GET QUALIFIED PRODUCT FOR RUNNER
© RUN_MONITOR
15. Procedure in the package sap.is.retail.posdmext.osa.monitor.test:
© TEST L INTEGRATION
16. Procedure in the package sap.is.retail.posdmext.osa.analysis.calc:
© COMPUTE LOST SALES
17. Procedure in the package sap.is.retail.posdmext.osa.analysis.dao:
O PERSIST
18. Procedures in the package sap.is.retail.posdmext.osa.analysis.runner.internal:
© CALL FUNCTION
© CALL ALGO PRODUCT IN SUBDEP
19. Procedure in the package sap.is.retail.posdmext.osa.analysis.runner.public:
© RUN_ FOR PRODUCT IN SUBDEP

6.3.4.5 Configure SAP NetWeaver Gateway and Activate
OData Service

Use

This configuration step is only required if you use separate products or developments on top of SAP Customer
Activity Repository that communicate via OData service. After you have installed SAP NetWeaver Gateway,
configure the Gateway system and configure the settings for OData service.

Procedure

The main steps to do this are as follows:

1. Activate SAP NetWeaver Gateway.
2. Define RFC connections from SAP NetWeaver Gateway to your back-end system.
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Define settings for OData service for the SAP NetWeaver Gateway.

Define settings for Push Functionality (optional).

Set up users and Authorizations for SAP NetWeaver Gateway.

Activate the OData Service in the SAP NetWeaver Gateway system (transaction /IWFND/maint service)
for the requested URI (for example: /sap/opu/odata/OSA/ON_SHELF AVAILABILITY/).

o ok W

For detailed information, see SAP Library for SAP NetWeaver Gateway on SAP Help Portal at http://
help.sap.com/nwgatewayllr Application Help » Support Package » SAP NetWeaver Gateway Developer Guide »
OData Channel 3.

6.3.5 Ensure that Third Party CRM Sales Orders are
Transferred to SAP ERP (Optional)

Use

Sales documents are accessed by SAP Customer Activity Repository (either through replication or direct data
access) from a source SAP ERP system. One way that sales documents of type Sales Order can be generated in a
SAP ERP system is through the transfer of sales orders created using an SAP CRM source system or a third party
CRM system.

When customers create sales orders using SAP CRM systems, these sales orders are inherently compatible to the
sales document structure in SAP ERP. They are transferred to SAP ERP via Data Exchange for Sales Orders: CRM
Enterprise - ERP System process. For more information, see SAP Library for SAP CRM on SAP Help Portal at
http://help.sap.com/crm. Select the applicable version of SAP CRM and under Application Help, open SAP

Library and choose | Basic Functions j» Business Transaction » Data Exchange for Business Transactions 3.

Customers who use third party CRM systems to create sales orders, and who want to access these sales orders
from SAP Customer Activity Repository, must ensure that their sales order data:

® |ncludes the information required by SAP Customer Activity Repository
e Has been transferred to SAP ERP prior to being able to access this data from SAP Customer Activity
Repository

Procedure

1. Ensure that the fields required by SAP Customer Activity Repository are filled during the transfer of sales
order data from your third party CRM system to SAP ERP.
2. Ensure that sales order data has been transferred from your third party CRM system to SAP ERP.
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6.3.6 Partition /POSDW/TLOGF Table (Optional)

Use

SAP Customer Activity Repository application contains the Point of Sale Data Management software component
version RTLPOSDM 200 which is used to receive a large volume of data from your connected stores. Point of Sale
Data Management, or more specifically, its POS Inbound Processing Engine (PIPE), processes the incoming
transactions and stores them in the /POSDW/TLOGF table.

Since every transaction line item is stored as a separate row in the /POSDW/TLOGF table, the table can quickly
grow to become very large. To improve standard database operations, such as inserting, updating, deleting and
reading and mass operations, such as archiving or index merging, SAP recommends that you partition the /
POSDW/TLOGF table.

Also, you can select to store extension segments in a dedicated /POSDW/TLOGF EXT table using the Store
Extensions in Separate Table option of the Define General Settings Customizing activity. Table /poSDwW/
TLOGF EXT should be partitioned in the same way as the /pOSDW/TLOGF table.

For more information on extension segments, see the Appendix of the Operations Guide, SAP Customer Activity
Repository.

1 Note

Partitioning is typically used in distributed system, but it may also be beneficial for single-host systems.

Procedure

1. Read the Table Partitioning in the SAP HANA Database section of the SAP HANA Administration Guide.
2. Plan your partition specifications in accordance to the following guidelines:
o A single partition should not contain more than 1 billion rows.
o The total amount of partitions of a single table should not exceed 1000.
o Because the actual act of partitioning a table does use system resources, do not start partitioning the /
POSDW/TLOGF table until its volume has surpassed 250 million rows.
3. Partition your /POSDW/TLOGF (and, optionally the /pOSDW/TLOGF EXT) table according to SAP Note
1719282 .

6.3.7 Customize Copies of SAP HANA Views (Optional)

Use

In this optional procedure, you create copies of views included in SAP HANA Live for SAP ERP or in the SAP HANA
content for SAP Customer Activity Repository. You then customize these copies to reflect your specific data
model extensions.
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Caution

Do not modify standard SAP HANA content.

For example, you would need to execute this procedure if you have extended your POS transaction data model.
The views delivered with the SAP HANA content for SAP Customer Activity Repository are built on the standard /
POSDW/TLOGF table. If you have added custom fields to the /POSDW/TLOGF table, you will have to create views
that expose these fields.

In general, if you have extended any standard SAP data models, you must copy and adapt the standard SAP
HANA content.

Caution

If you have created a copy of a view shipped as part of the standard SAP HANA content and have made
modifications to this copy, a subsequent upgrade of SAP HANA Live for SAP ERP or SAP HANA content for
SAP Customer Activity Repository will not update your copied and modified version of the view. SAP Notes or
enhancements shipped by SAP will also have to be manually implemented on the copied, and subsequently
modified, SAP HANA content.

Procedure

1. Logonto SAP HANA studio.
2. Open the Modeler and use the Navigator to access the folder that contains the view that you want to copy. For

example, |F <Your System Name> j» Content  sap ¥ is ¥ retail ¥ car ¥ Calculation Views 7.
3. lIdentify the view you want to copy. For example, sap.is.retail.car/POSSalesQuery.
4. Use the Auto Documentation feature of SAP HANA studio to identify all reuse and private views that are
consumed by your selected view, as well as any query views that might consume your view. To do so:
1. Right-click on the selected view, and choose Auto Documentation from the context menu.
2. Browse to the location where you want to save the file and choose Finish.
3. Openthe generated *.pdf file, and locate the Cross-References section of the document.
The Cross-References section displays the hierarchy of calculation (query, reuse, and private) views that
are accessed by the selected view. Affected underlying, as well as all consuming views, in this hierarchy
must also be copied and modified as a result of your extension.
For example, calculation views sap.is.retail.car/POSSales, sap.is.retail.car/POSLogIltem,
and sap.is.retail.car/TLOGF ITEM COMare all consumingthe /POSDW/ TLOGF table and are
consumed by the sap.is.retail.car/POSSalesQuery view. Therefore, if you have extended the /
POSDW/TLOGF table, all these views must be copied and modified.
5. Foreach view identified in the previous step, do the following:
1. Inthe Navigator panel, select an object and in the context menu, choose Copy.
2. Navigate to the package where you want to paste the view and choose Paste.

1 Note

You must have write permissions on the target package to which you are pasting the view. Also, you
should copy the view to your own package. Do not modify the original sap package.
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3. Modify the copied view as required.
For more information, see the Creating Views section of the SAP HANA Developer Guide.

4. Right-click on the copied and modified view and select Activate.

6.3.8 Configure Demand Data Foundation (Optional)

In this procedure, you configure the DDF module in SAP Customer Activity Repository as required for your
scenario.

Required Configuration

Caution

The implementation and configuration of DDF is mandatory for the following scenarios:

You want to model and forecast demand using the UDF module in SAP Customer Activity Repository. For
information about setting up UDF, see Configure Unified Demand Forecast (Optional) [page 154].

You want to use the Omnichannel Promotion Pricing module in SAP Customer Activity Repository. For
more information, see Configure Omnichannel Promotion Pricing for Use with SAP Customer Activity
Repository [page 166].

You want to use SAP Allocation Management for Retail.

You want to use SAP Assortment Planning for Retail.

You want to use SAP Merchandise Planning for Retail.

You want to use SAP Promotion Management for Retail.

See the Common Master Guide for additional configurations and integration information. You can find this
guide on SAP Help Portal at http://help.sap.com/car|l <your release> ¥ Installation and Upgrade Information
» Master Guide 3.

For more information, see the following:

http://help.sap.com/car|l <your release> » Application Help » Demand Data Foundation j Integration

Information » Master Data Replication from SAP ERP to Demand Data Foundation 3

SAP Customer Activity Repository Administration Guide, sections Configuring Demand Data Foundation
(DDF), Configuring Data Replication from SAP ERP to DDF, and Configuring DDF Integration Scenarios

Prerequisites

You have consulted SAP Note 2379029#% . This is the Release Information Note (RIN) for SAP Customer Activity
Repository 3.0. It provides up-to-date information on the current release, together with a list of important SAP
Notes that you must apply to complete the installation process.
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6.3.8.1 Activate Business Functions for DDF and UDF

In this procedure, you activate the business functions for DDF and UDF that are relevant for your scenario.

Use

1 Note

As of SAP Customer Activity Repository 2.0 FP3, most of the existing business functions have been set to
obsolete. You no longer need to activate them to be able to use the Demand Data Foundation (DDF) and Unified
Demand Forecast (UDF) modules in SAP Customer Activity Repository. There is now only 1 recommended
business function for DDF, and 2 required business functions for UDF. Nothing will happen if you activate any of
the obsolete business functions by accident. The new, simpler activation procedure is described in the
following.

You must implement DDF in the following scenarios:

® You want to model and forecast demand using UDF.

e You want to use applications residing in the ABAP back-end server that use data acquired and maintained in
DDF.

Procedure

1. Check which business functions are relevant for your scenario:

o For DDF (optional): We recommend that you activate the optional business function Decompression of
Lane Price and Time Dependent Data (/DMF/DDF_IMDB LANE TD) to benefit from optimized memory
usage.

o For UDF (required): If you want to model and forecast demand with UDF, you must activate the following
business functions:

o Activation of Forecast Engine (/DMF /FORECAST)
o Activation of Unified Demand Forecast (/DMF/DDF_UDF)
2. Read the following documentation for each business function that you want to activate:
o Business function description under http://help.sap.com/carl <your release> j» Application Help »
Demand Data Foundation » Business Functions 4

o Execute transaction SFW5, select the business function, and follow the instructions under Release
Information.

3. Execute transaction SFW5 and activate the business functions that are relevant for your scenario.

= Recommendation

o Business functions should be activated by a system administrator.
o Once abusiness function is active, we recommend that you do not deactivate it.
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1 Note

For more information on business functions, see SAP Note 337623 Customizing after installation or
upgrade .

6.3.8.2 Configure Automatic Flattening of Hierarchies

You need to configure the system so it automatically creates and updates flat structures for the product and
location hierarchies in Demand Data Foundation (DDF). The flat structures are required so the consuming
applications can correctly recognize the hierarchies.

Context

Flat structures describe the parent-child relationships of hierarchies in a flattened format. A hierarchy can be
vertically or horizontally flattened. Each row of the resulting flat structure contains one parent-child relationship.

When you create (or update) a product hierarchy, product group, location hierarchy, or location group in DDF, the
system should create (or update) the corresponding flat structure. Without this, you get hierarchy errors in the
consuming applications.

To configure the automatic flattening of hierarchies, follow these steps:

Procedure

1. Carefully read SAP Note 1425876# and follow the instructions.

2. Execute transaction SWETYPV and ensure that you have activated all required event type linkages and have
enabled the specified event queues. In particular, check that the Linkage Activated and Enable Event Queue
options are for each of the following events: LOCATION CREATED, LOCATION UPDATED, CREATE LOC HIER,
CREATE PROD HIER. If you need to change a setting, you can do so in the Details screen of each event.

For more information about event handling, see SAP Note 1098805, in particular sections Events and
Transactions for troubleshooting.

Results

You have set up the automatic flattening of the hierarchies. Whenever you now create (or update) a hierarchy, the
system will automatically run the /DMF/TREE FLATTENER PROD INS report (for product hierarchies) or

the /DMF/TREE FLATTENER LOC INS report (for location hierarchies) and create (or update) the corresponding
flat structure.
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6.3.8.3 Import SAP NetWeaver Portal Roles for DDF

To set up user authorizations for Demand Data Foundation (DDF), you can use the PFCG roles from the SAP
NetWeaver Business Client (NWBC) and from the SAP NetWeaver Portal. Both sets of roles operate in the same
manner. Using the SAP NetWeaver Portal is optional.

Use

The roles have been created for use in SAP NetWeaver Business Client. To use the functions of these roles in SAP
NetWeaver Portal, you must upload the roles from the SAP back-end system to the portal. The uploaded objects
are converted into portal objects.

Procedure

1. Use the Role Upload tool to generate the SAP NetWeaver Portal roles automatically. For more information
about this tool, see SAP Note 1685257 .
You can also enhance the SAP NetWeaver Portal roles; for example, you can create your own iViews.
You can upload the following roles for DDF:

© SAP_ ISR _DDF MASTER
© SAP ISR _DDF READONLY MASTER

For descriptions of these roles and information about maintaining roles in SAP Customer Activity Repository, see
Authorizations section in the SAP Customer Activity Repository 3.0 Administration Guide.

6.3.8.4 Enable Time-Dependent Article Hierarchies

Use

You can create SAP ERP article hierarchies with different statuses (Active, Disabled, Planned). Time-dependent
article hierarchies have status Planned. They only become active during a defined validity period in the future.

If you want to use time-dependent article hierarchies, you must first create them as such in your SAP ERP system.
Then in order for the Demand Data Foundation module in your SAP Customer Activity Repository system to
recognize a time-dependent hierarchy, you must enable it as described in the following.
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Procedure

To enable time-dependent article hierarchies, follow these steps:

1

2.

Make sure that you have implemented the following SAP Notes:
0 2244521¢
o 2245133
0 2245134

In Customizing, activate the time-dependent article hierarchy under | Cross-Application Components

Demand Data Foundation » Data Maintenance » Product Hierarchy » Control Parameters for Product

Hierarchies 3. For more information, see the Customizing activity documentation (transaction SPRO).

More Information

For more information about replicating data to DDF, see the following:

http://help.sap.com/car|l <your release> » Application Help » Demand Data Foundation j Integration
Information » Master Data Replication from SAP ERP to Demand Data Foundation 3
http://help.sap.com/carllr <your release> ¥ Installation and Upgrade Information » Master Guide » Business
Overview » SAP Customer Activity Repository ¥ Introduction to SAP Customer Activity Repository 3

For more information about Customizing for article hierarchies in SAP ERP, see the Customizing activities under

|+ Logistics - General » Article Hierarchy 3.

6.3.8.5 Check Performance-Related Configuration Options

Use

Depending on your implementation scenario, you have additional configuration options for DDF that allow you to
optimize performance.
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Procedure

Check the following options and implement those that are relevant for your scenario:

Table 51:

Use Case Configuration Option

You have an installation on a multiple-host SAP HANA system. | Consider table partitioning. For more information, see Parti-
tion Tables for UDF and DDF (Optional) [page 157].

You want to use the Sales Projection function in SAP Assort- The function relies heavily on the DDF module. You can opti-

ment Planning for Retail and have large data volumes to proc- | mize performance by implementing SAP Note 2080423 .
ess.

More Information

If you encounter issues during the setup, see the Troubleshooting [page 166] section for possible solutions.

6.3.9 Configure Unified Demand Forecast (Optional)

1 Note

The Unified Demand Forecast (UDF) module in SAP Customer Activity Repository supports different
implementation scenarios. The steps in this section and all subsections are optional and depend on your
specific scenario:

Table 52:
Scenario ’ Implement and Configure UDF

SAP Promotion Management for Retail Mandatory (for what-if forecasts)

SAP Allocation Management for Retail Optional
SAP Assortment Planning for Retail

SAP Merchandise Planning for Retail

To enable the UDF functionality for your scenario, perform the following post-installation steps.
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6.3.9.1 Complete UDF Setup

In this procedure, you complete the post-installation tasks for the Unified Demand Forecast module to enable
demand modeling and forecasting in SAP Customer Activity Repository.

Prerequisites

You have installed the SAP RTI, AFL FOR SAP HANA software component as described in the following
sections:

o Forinitial installations: Install SAP Customer Activity Repository Retail Applications Bundle |+ Download
and Install the Application Function Library (AFL) 3
For upgrade scenarios: Upgrade SAP Customer Activity Repository Retail Applications Bundle
| Download and Install the Application Function Library (AFL) 3
The component includes the application functions for UDF.
You have consulted SAP Note 2379029#% . This is the Release Information Note (RIN) for SAP Customer

Activity Repository 3.0. It provides up-to-date information on the current release, together with a list of
important SAP Notes that you must apply to complete the installation process.

You have configured DDF as described in Configure Demand Data Foundation (Optional) [page 149].

You have consulted the Common Master Guide for additional integration and configuration information for
DDF and UDF. You can find this guide on SAP Help Portal for SAP Customer Activity Repository at http://

help.sap.com/car| <your release> ¥ Installation and Upgrade Information 4.
In particular, you are aware that different business processes related to DDF and UDF are available for
different business scenarios:

Table 53:

Business Scenario Business Process ‘ DDF ‘ UDF

SAP Customer Activity Repository | Enabling Demand Data Foundation and Creating Demand | x X
Forecast

SAP Allocation Management for Enabling Demand Data Foundation X

Retail

SAP Assortment Planning for Enabling Demand Data Foundation and Creating Demand | x

Retail Forecast

SAP Merchandise Planning for Enabling Demand Data Foundation X

Retail

SAP Promotion Management for | Enabling Demand Data Foundation and Creating Demand | x x (required

Retail Forecast for what-if

forecasts)

For more information about these scenarios, see again the Common Master Guide, sections Business
Overview and Business Scenarios.

Common Installation Guide CARAB 2.0
Post-Installation CUSTOMER 155


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2379029
http://help.sap.com/car
http://help.sap.com/car

Procedure

Perform Mandatory Configuration Steps
The following steps are mandatory if you want to model and forecast demand with UDF:

1. Setup the users, roles, and privileges for UDF as described in Authorization Requirements for Unified Demand
Forecast.

2. If your source master data system is an SAP S/4HANA system, you must implement SAP Note 2376424 to
enable UDF for this scenario.

3. Activate the SAP HANA content for SAP Customer Activity Repository as described in Activate SAP HANA
Content [page 138].
In particular, make sure to select the Forecasting business scenario in the activation report.

4. Analyze and implement the following SAP Notes:
o 1911141% : Setting UDF-specific performance optimization parameters in the SAP HANA database
o 1898341#% : Configuration changes for demand modeling and forecasting to prevent decomposition
errors
o 2389537#%: Correction of a data issue in demand modeling
5. Check and, if necessary, change the default setting for how the covariance matrix is generated during
modeling.
In Customizing (transaction SPRO), navigate to [ Cross-Application Components » Demand Data Foundation

» Modeling and Forecasting # Define Modeling Control Settings 3. Depending on your scenario, you can
choose between the “full” covariance matrix (default setting) and the “reduced” covariance matrix:

Table 54:

Your scenario is... What to do...

You want to use the forecast confidence index (FCI) func- | Leave the default setting for all the time series sources.

tionality in SAP P tion M t for Retail.
fonatityn romotion Management for Retal The full covariance matrix is mandatory for the FCI. For

more information on how to configure the FCI, see Configur-
ing Unified Demand Forecast.

o Youwant to use SAP Promotion Management for Re-
tail, but without the FCI.

o Youdo not want to use SAP Promotion Management
for Retail.

For sizing reasons, we strongly recommend that you select
the Reduced Covariance Matrix option for all the time series

sources.

For more information, see the Customizing activity documentation.

Perform Optional Configuration Steps
You have the following additional options:

1. Analyze the following optional SAP Notes and implement the notes that are relevant for your scenario:
o 2176058 : Performance-related note that you must implement if you want to forecast complex offers
(such as Buy X Get Y) in production mode
o 2161484#% : Information about an ABAP report that you can use to validate the input data for modeling
and forecasting and identify potential issues
2. Setup table partitioning for your scenario.
For more information, see Partition Tables for UDF and DDF (Optional) [page 157].
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3. Setup the generation of intraday forecasts.
If you want to generate intraday forecasts, you must configure both the UDF module and the OSA module in
SAP Customer Activity Repository:
1. Consult the Implementation Considerations section in http://help.sap.com/carlp <your release> »
Application Help » SAP Customer Activity Repository » Unified Demand Forecast » General Services »
Generate Intraday Forecasts 3.

2. Configure UDF as described here in this guide. At a minimum, you must perform the mandatory
configuration steps listed above.

3. Configure OSA as described in Configure On-Shelf Availability (Optional) [page 140].
4. Do the Customizing (transaction sPRrO) for UDF and OSA that you need for your scenario:
o For UDF, see the activities and their documentation under |+ Cross-Application Components
Demand Data Foundation # Modeling and Forecasting 4.
o For OSA, see the activities and their documentation under [ SAP Customer Activity Repository » On-
Shelf Availability 3.

4. Consult the Configuring Unified Demand Forecast section in the SAP Customer Activity Repository
Administration Guide for additional configuration options for UDF features.

5. Set up forecast visualization with the Analyze Forecast SAP Fiori app:
This analytical app is provided as part of the SAP FIORI FOR SAP CARAB front-end product version, which
you have already installed. To set up forecast visualization with this app, proceed as described in Configure
the Analyze Forecast App [page 159].

For more information about the app, see http://help.sap.com/carlp <your release> » Application Help » SAP
Customer Activity Repository » Additional Content » Standalone SAP Fiori Apps for SAP Customer Activity
Repository ¥ Analyze Forecast 3, including all subsections.

More Information

If you encounter issues during the setup, see the Troubleshooting [page 166] section for possible solutions.

6.3.10 Partition Tables for UDF and DDF (Optional)

Use

1 Note
This section is only relevant for installations on multiple-host SAP HANA systems.
If you have an installation on a single-host SAP HANA system, you can skip this section.
To forecast consumer demand, you use the Unified Demand Forecast (UDF) and Demand Data Foundation (DDF)

modules in SAP Customer Activity Repository. UDF provides the actual modeling and forecasting services. DDF
provides the required data layer (for the import, export, and maintenance processes, for example).
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If your forecasting scenario involves large numbers of products and locations, the relevant UDF and DDF tables
can become very large. To improve standard database operations (such as inserting, updating, deleting, and
reading) and mass operations (such as archiving or index merging), we therefore recommend that you set up
partitioning for those tables.

As the UDF application functions run directly in the SAP HANA database, much of the partitioning guidance for
SAP HANA systems also applies to forecasting scenarios with UDF and DDF. Your main reference, therefore, is
the SAP HANA Administration Guide, which you can find under http://help.sap.com/hana_platform|p System

Administration 3. Make sure to select the guide for your specific SAP HANA Platform SPS (if necessary, choose
Earlier releases in the navigation tree on the left).

Prerequisites

® You have installed and configured UDF and DDF as described in this guide.

® You have the system privileges and object privileges required to perform table partitioning operations. For
more information, see the Tile Catalogs for Administration and Monitoring section of the SAP HANA
Administration Guide.

® You are aware of the limitations for table partitioning. For more information, see the Partitioning Limits
section of the SAP HANA Administration Guide.

Procedure

1. Read sections Table Partitioning and Optimize Table Partitioning of the SAP HANA Administration Guide to
learn about the partitioning of SAP HANA systems.

2. Read SAP Note 2190377#% to learn which UDF and DDF tables are relevant for partitioning and what
partitioning aspects to consider.
3. Partition the tables as described in the note.

= Recommendation

To help you with the partitioning decisions, consult the sizing information for your system landscape. For
example, check the number of records estimated for the large tables to decide which tables to partition and
how many partitions you need.

For more information on system sizing and a sizing questionnaire for SAP Customer Activity Repository, see

http://help.sap.com/car|p <your release> » Additional Information } Sizing 3.
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6.3.11 Configure Standalone SAP Fiori Apps for SAP Customer
Activity Repository (Optional)

1 Note

The steps in this section and all subsections are optional and depend on your specific implementation
requirements.

6.3.11.1 Configure the Analyze Forecast App

In this procedure, you perform several implementation tasks on the front-end server and the back-end server to
configure the Analyze Forecast SAP Fiori app in SAP Customer Activity Repository. You can use the app to
visualize detailed demand modeling and forecasting information for performing in-depth analyses.

Prerequisites

1 Note

Depending on your implementation scenario, several of the following prerequisites might already be fulfilled in
your system landscape.

General Prerequisites
e Front-end server: To determine which version of SAP FIORI FRONT-END SERVER you heed, see the
prerequisites for this release:
o Forinitial installations: Prerequisites section in the Common Installation Guide
o For upgrade scenarios: Prerequisites section in the Common Upgrade Guide
e SAP Fiori system landscape: You have set up the landscape as described under http://help.sap.com/
fiori_implementation|r Required System Landscape » With SAP NetWeaver 7.4 » Setup of SAP Fiori System
Landscape with SAP HANA XS 3.
For system landscape diagrams of supported scenarios, see http://help.sap.com/fiori_bs2013|y General
Implementation » Setup of SAP Fiori System Landscape for SAP Business Suite » Setup of SAP Fiori System
Landscape for SAP Business Suite with SAP HANA XS 3.
e SAP Fiorilaunchpad: You have set up the launchpad as described under http://help.sap.com/
fiori_implementation|r Configuration Information » With SAP NetWeaver 7.4 » Setup of SAP Fiori

Launchpad 3.
The SAP Fiorilaunchpad is the access point to apps on desktop or mobile devices. Users can access an app
via its corresponding tile on the launchpad. For more information, see http://help.sap.com/
fiori_implementation|r Additional Information % SAP Fiori Launchpad 3.

e SAP Fiorilaunchpad designer: You have set up this administrator tool as described under http://

help.sap.com/netweaver | User interface add-on 2.0 for SAP NetWeaver » Application Help » SAP Fiori
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Launchpad # Setting up the Launchpad 3 and Using the Launchpad Designer. In the procedure below, you will
later do app-specific configuration settings in the designer.

SAP NetWeaver Gateway: You have installed and configured the gateway. In particular, make sure that you
have done the following:

o Performed the general SAP Gateway configuration and activated the central Internet Communication
Framework (ICF) services (SAP Note 1560585/ and Perform General SAP Gateway Configuration [page
1147).

You can skip the Connect SAP Gateway to your Back-End System section because the back-end for
Analyze Forecast is provided via SAP HANA Extended Application Services (SAP HANA XS).

o Activated SAP Gateway on your front-end server (Activate SAP Gateway [page 116]).

o Activated the common OData services so you can use the SAP Fiori launchpad (Activate Common OData
Services [page 117]).

SAP Web Dispatcher: You have configured the dispatcher and set up the routing rules for browser requests as
described in the following:

o Configure the SAP Web Dispatcher [page 135]

o Section Configuring SAP Web Dispatcher of the Central Implementation Information at http://
help.sap.com/saphelp_hba/helpdata/en/5e/9d0c52bcc19b33e10000000a44538d/content.htm (in
particular, see step Configure SAP Web Dispatcher for SAP HANA XS)

For a configuration example, see http://help.sap.com/fiori_implementation|r Additional Information » SAP

Fiori Launchpad ¥ Setting Up the Launchpad ¥ Configuring SAP Web Dispatcher 3.
Central SAP Fiori Ul component: This component contains the SAPUI5 control library and the SAP Fiori
launchpad. You have configured it as described in Configure Central SAP Fiori Ul Component [page 119].
SAP Jam (optional): You have integrated the SAP Jam collaborative environment as described in the
following:

o Configure SAP Jam (Optional) [page 125]

o http://help.sap.com/fiori_implementation|p Configuration Information » With SAP NetWeaver 7.4 »
Configuration of SAP Fiori Infrastructure ¥ Integrating SAP Jam (Optional) 3

Prerequisites Specific to SAP Customer Activity Repository Retail Applications Bundle

160

DDF: You have configured the DDF module as described in Configure Demand Data Foundation (Optional)
[page 149].

UDF: You have configured the UDF module as described in Configure Unified Demand Forecast (Optional)
[page 154].

SAP HANA content: You have activated all SAP HANA content for SAP Customer Activity Repository, as
described in Activate SAP HANA Content [page 138].

Note that with this step, you have also activated the SAP HANA content for Analyze Forecast. In SAP HANA
studio, you can find this content under | Content » sap.hba.t.rtl.udf.afc 3.

Front-end server: You have installed the server as described in the Install ABAP Front-End Server section of
the Common Installation Guide. This installation must include the SAP NetWeaver Gateway, the central SAP
Fiori Ul component, and the product-specific SAP Fiori Ul component.

As Analyze Forecast is a standalone app, you do not need the SAP Smart Business Modeler Apps Framework.
You have implemented SAP Note 2372802# , which fixes a time zone issue in the app.
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Procedure

To configure Analyze Forecast, follow these steps:

1. Read the app-specific information on SAP Help Portal for SAP Customer Activity Repository at http://
help.sap.com/car | <your release> » Application Help » SAP Customer Activity Repository » Additional

Content » Standalone SAP Fiori Apps for SAP Customer Activity Repository # Analyze Forecast J, including all
subsections.

2. Configure user access to the SAP HANA data for the app.

1 Note

You can find the general SAP Fiori Help section for this step at http://help.sap.com/fiori_implementation
| App Implementation Information » With SAP NetWeaver 7.4 » App Implementation for Analytical Apps »
Configuring Access to SAP HANA Data 3.

Use this section as your starting point. However, to configure Analyze Forecast, you only need to perform a
subset of the steps described there. Proceed as follows:

1. Synchronize the SAP HANA database users. Each user requires both a user in the ABAP front-end server
(to enable navigation in the SAP Fiori launchpad) and a database user in SAP HANA (to enable access to
the relevant views).

Follow the steps in |# Configuring Access to SAP HANA Data » Synchronizing SAP HANA Database
Users 3.

2. Assign the app-specific SAP HANA role
sap.hba.t.rtl.udf.afc.roles::AnalyzeForecast.hdbrole to the users of the app. The role
enables them to access the app-specific SAP HANA data to be able to analyze sales and forecast values.
Follow the steps in [ Configuring Access to SAP HANA Data # Assigning Roles for Accessing SAP HANA
Data 3.

3. Create the analytic privileges to give the users read-only access to the SAP HANA views for the app. You
can find all these views inthe sap.hba.t.rtl.udf.afc.v folderin your SAP HANA studio. Without the
correct analytic privileges, the users only see empty views.

Follow the steps in [ Configuring Access to SAP HANA Data » Creating Analytic Privileges 3.
For more information about analytic privileges, see the following:

o http://help.sap.com/hana_platform|p Development and Modeling » SAP HANA Modeling Guide (For
SAP HANA Studio) ¥ Defining Data Access Privileges ¥ Create Classical XML-based Analytic
Privileges

o http://help.sap.com/hballr SAP HANA Live Tools » SAP HANA Live Authorization Assistant 3, in
particular sections Generating Analytic Privileges and Updating Analytic Privileges

3. Customize the navigation target for the app in the SAP Fiori launchpad on the front-end server.
In Launchpad Customizing (transaction LPD_CUST), choose [p UICAROOI TRANSACTIONAL »

AnalyzeForecast 4 and make the following app-specific settings:

O

Link Text: AnalyzeForecast

[¢]

Application Type: URL

o

URL: /sap/bc/ui5_ui5/sap/analyzfcst_v2

o

Application Alias: AnalyzeForecast
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o Additional Information: SAPUI5.Component=retail.udf.analyzeforecastv2

o Portal Parameters: Leave the default settings.

o Switch Support: Leave the default settings.
For more information about navigation targets, see the following:

o For SAP NetWeaver 7.31: http://help.sap.com/nw-uiaddon20|» Application Help ¥ SAP Fiori Launchpad
» Configuring Navigation ¥ Configuring Target Mappings ¥ Customizing Navigation Targets in
LPD_CUST 3

o For SAP NetWeaver 7.4: http://help.sap.com/nw74|p Application Help # Ul Technologies in SAP
NetWeaver with SAP_UI 740 » SAP Fiori Launchpad ¥ Configuring Navigation ¥ Customizing Navigation

Targets J

4. Configure the SAP Fiori launchpad designer for Analyze Forecast.

1. Launchthe SAP Fiori launchpad designer with one of the following URLSs:

o

In CUST mode:

https://<server>:<port>/sap/bc/uib5 uib/sap/arsrvc_upb admn/main.html#/
Catalog/X-SAP-UI2-CATALOGPAGE:SAP ISR CAR TC A

Use this mode for client-specific configurations, specifying the respective client.

In CONF mode:

https://<server>:<port>/sap/bc/ui5 ui5/sap/arsrvc_upb admn/main.html ?sap-
client=<client>&scope=<CONF/CUST>#/Catalog/X-SAP-UI2-

CATALOGPAGE:SAP ISR CAR TC A

Use this mode for global configurations across all clients. In this URL, you additionally specify the
scope parameter.

2. Configure the app tile in the SAP Fiori launchpad designer.
If the tile for Analyze Forecast has not yet been created, create it as a static tile using the following
settings:

o

o}

o

o

o

o

o

Title: Analyze Forecast

Icon: sap-icon://Fiori5/F0812

Use semantic object navigation: Select this option.
Semantic Object: ForecastDemand

Action: showUDFAnalyzeForecast

Parameters: bk-client=<backend client>

Leave the other options empty.

For more information about configuring tiles, see http://help.sap.com/nw74|k Application Help ¥ Ul
Technologies in SAP NetWeaver with SAP_UI 740 » SAP Fiori Launchpad ¥ Using the Launchpad Designer
» Setting Up Catalogs, Tiles, and Groups ¥ Catalogs and Tiles » Configuring Tiles ¥ Static App Launcher
Tiles 3.

3. Configure the target mapping in the SAP Fiori launchpad designer.

If the target mapping has not yet been created, choose Target Mappings and create a new entry with the
following settings:

o

o

o

Semantic Object: ForecastDemand

Action: showUDFAnalyzeForecast

Application Type: SAP Fiori App using LPD_CUST
Launchpad Role: UICAR001

Launchpad Instance: TRANSACTIONAL
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o Application Alias: AnalyzeForecast
o Device Types: Select Desktop and Tablet.
o Allow additional parameters: Select this option.
For more information about configuring target mappings, see http://help.sap.com/nw74l Application
Help #» Ul Technologies in SAP NetWeaver with SAP_UI 740 » SAP Fiori Launchpad » Configuring
Navigation  Configuring Target Mappings 3.
5. Complete the implementation on the front-end server.

1 Note

You can find the general SAP Fiori Help section for this step at http://help.sap.com/fiori_implementation
|» App Implementation Information » With SAP NetWeaver 7.4 » App Implementation for Analytical Apps
Implementation Tasks on Front-End Server .

Use this section as your starting point. However, to configure Analyze Forecast, you only need to perform a
subset of the steps described there. Proceed as follows:

1. InLaunchpad Customizing (transaction LPD_cUST), choose | UICAROOI TRANSACTIONAL »
AnalyzeForecast 3 and check that both app-specific ICF services are active:
O /sap/bc/bsp/sap/analyzfcst v2
O /sap/bc/ui5 ui5/sap/analyzfcst v2
If a service is not active, activate it as follows:
Execute transaction SICF, specify the <service path/service name> in Service Path, and execute
the search. Under Virtual Hosts / Services, select the analyzfcst v2 entry and choose [ Service/Host
» Activate 1.
For more information on how to activate ICF services and OData services, see [ Implementation Tasks on
Front-End Server » Front-End Server: Activate ICF Services of SAPUI5 Application 3.
2. Add the start authorizations for the app-specific OData service

(sap.hba.t.rtl.udf.afc.odata::AnalyzeForecast.xsodata) to the role onthe front-end server.
The users need the start authorizations for the activated OData service to be able to launch the app.
Follow the steps in |l# Implementation Tasks on Front-End Server » Add Start Authorizations for OData
Services to Role on Front-End 3.

3. Createthe sap_car TCR_A PFCG role on the front-end and assign the required launchpad catalogs and

groups. SAP_ CAR TCR_As the back-end server authorization role delivered for all analytical apps in SAP
Customer Activity Repository.

1 Note

If you already have an SAP Fiori launchpad open, you must clear your browser cache to apply any
modifications made to your user roles. Otherwise, your changes will not be reflected in the SAP Fiori
user interface.

Follow the steps in [ Implementation Tasks on Front-End Server » Create PFCG Role on Front-End and
Assign Launchpad Catalogs and Groups 3.

4. Set up the catalogs, groups, and roles in the SAP Fiori launchpad.
Follow the steps in |# Implementation Tasks on Front-End Server » Setup of Catalogs, Groups, and Roles
in the SAP Fiori Launchpad 3.
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5. Take the front-end PFCG role that you have created before and assign it to the users of the app. The role
contains the catalogs, groups, and start authorizations for the OData service that the users need.

Follow the steps in |» Implementation Tasks on Front-End Server # Front-End Server: Assign Roles to
Users 3.

Result

You have successfully configured the Analyze Forecast app.

More Information

e You can extend the app with custom content. For more information, see http://help.sap.com/car| <your
release> » Application Help » Additional Content » Standalone SAP Fiori Apps for SAP Customer Activity
Repository » Analyze Forecast » App Extensibility: Analyze Forecast .

e For generic information about implementing SAP Fiori apps, see http://help.sap.com/fiori_implementation.

e |f you encounter issues during the implementation, see the Troubleshooting [page 166] section for possible
solutions.

6.3.12 Configure Omnichannel Article Availability and Sourcing
for Use with SAP Customer Activity Repository
(Optional)

You need to integrate SAP Retail, SAP Customer Activity Repository, SAP Hybris Commerce, and SAP Hybris
Commerce, integration package for SAP for Retail, as well as set up asynchronous order management and the
data replication between SAP Retail and SAP Customer Activity Repository.

6.3.12.1 Set up Data Replication Between SAP Retail and SAP
Hybris Commerce

In SAP Retail and SAP Hybris Commerce, set up the asynchronous order management scenario as follows:

1. Setup asynchronous replication of articles via the Data Hub from SAP Retail to SAP Hybris Commerce.
For more information, see the documentation for SAP Hybris Commerce at https://help.hybris.com/
6.2.0/hcd/8bcob884866910148532f2e1e500f95f.html Getting Started with SAP ERP Integration. Follow the
steps for the asynchronous order management scenario.

2. Setup asynchronous replication of orders via the Data Hub from SAP Hybris Commerce to SAP Retail (see
link above).

3. Configure asynchronous order management.
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For more information, see the documentation for SAP Hybris Commerce at https://help.hybris.com/
6.2.0/hcd/8b8ac51b866910148e68c3be8963eb96.html Configuring Asynchronous Order Management.

6.3.12.2 Set up Data Replication Between SAP Retail and SAP
Customer Activity Repository

1. In SAP Retail, create an RFC connection between SAP Retail and SAP Customer Activity Repository
(transaction sM59).
2. In SAP Customer Activity Repository, set up SLT replication from SAP Retail to SAP Customer Activity
Repository (see SAP Note 2385706 ).
For OAA, the following tables must be replicated via SLT:
o Tables used diretly by OAA:

Table 55:

Table Used for

MARA Check whether article exists in SAP Customer Activity Repository

MARM Quantity conversion (conversion of sales unit into base unit)

LFAL Input help for eligible vendors in Customizing of OAA profiles. Used to check
whether the vendor exists that was entered as eligible vendor.

EINA Input help for eligible vendors in Customizing of OAA profiles. Used to check
whether purchasing info records exist for the vendor that was entered as eligible
vendor.

VBAK Database trigger that updates temporary reservations when a sales order is repli-
cated from SAP Retail to SAP Customer Activity Repository

TOO1W Database trigger that updates temporary reservations when a sales order is repli-
cated from SAP Retail to SAP Customer Activity Repository

OAA ATP PROFILE Input help for ATP parallelization profile in Customizing of OAA profiles

VBAP Calculation of dynamic rough stock indicators

VBUP Calculation of dynamic rough stock indicators

o Tables required for Inventory Visibility view
InventoryVisibilityWithSalesOrderReservedQuantity, suchasMARD and VBFA
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6.3.12.3 Set Up Data Replication Between SAP Hybris
Commerce and SAP Customer Activity Repository

1. In SAP Hybris Commerce, in the Backoffice application under [» SAP Integration » HTTP Destination 3, create
the HTTP destination of SAP Customer Activity Repository that is used for availability calculation and
sourcing.

2. In SAP Hybris Commerce, in the Backoffice application under |+ SAP Integration » SAP Global Configuration
Backend Connectivity 3, enter the HTTP destination of SAP Customer Activity Repository created before.

1 Note

In the standard Solr configuration for products in SAP Hybris Commerce,
ProductStoreStockValueProvider is used to replicate the store availability situation from the Hybris

database into the Solr index.

If you use OAA, availability information is provided through synchronous calls into SAP Customer Activity
Repository for every article/store combination instead. If your product catalog is rather large, this is why
indexing the complete product catalog can take very long. In this case, we recommend to either deactivate the
value provider or to create a custom one. If you deactivate the value provider, faceted search according to
store availability is not possible in the product catalog. OAA functionality is not affected.

6.3.13 Configure Omnichannel Promotion Pricing for Use with
SAP Customer Activity Repository

1. In Customizing for SAP Customer Activity Repository, under | Omnichannel Promotion Pricing ¥ Configuring
Omnichannel Promotion Pricing 3, activate and configure Omnichannel Promotion Pricing.

2. Intransaction SFW5, activate business function MDG_ FOUNDATION.
This activates Data Replication Framework (DRF) functionality. You need DRF to be able to send regular
prices and OPP promotions to an external system via IDocs.

3. Touse the central promotion pricing service, you have to install the XS Advanced (XSA) Runtime. For
information about the installation of the XS Advanced runtime, see the SAP HANA Server Installation and

Update Guide|l Installing an SAP HANA System » Installing XS Advanced Runtime 3.

6.3.14 Troubleshooting

Use

This section proposes possible solutions to issues that may occur when you install and implement your SAP
Customer Activity Repository solution. It also provides guidance on how you can improve the system
configuration for specific use cases. If you need to report a customer incident, see the information in the final
section.
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Table 56:
Areas

Installation / Up-
grade

Issues

You want to download a revision
of software component sAp
RTL AFL FOR SAP HANA.

Explanations

You need the exact download path
on the SAP Support Portal at
http://support.sap.com#e .

Possible Solutions

e Forinitial installations: Install
SAP Customer Activity Repo-
sitory Retail Applications Bun-
dle

® Forupgrade scenarios: Up-
grade SAP Customer Activity
Repository Retail Applications
Bundle

You get an error indicating that
software component SAP RTL
AFL FOR SAP HANA is not
compatible.

You must install compatible re-
leases (“revisions") of the follow-

ing:

® SAP RTL AFL FOR SAP
HANA

® SAP HANA AFL

e SAP HANA database

e Forinitial installations: Install
SAP Customer Activity Repo-
sitory Retail Applications Bun-
dle

® For upgrade scenarios: Up-
grade SAP Customer Activity
Repository Retail Applications
Bundle

You want to know what AFL
components are installed and
active in your SAP HANA data-
base.

For example, you want to check if
an AFL component was installed
or upgraded correctly.

SAP Note 2188129

You want to install or upgrade
an application function library
(suchas sAP RTL AFL FOR
SAP HANA) and are experienc-
ing issues with the SAP HANA
Lifecycle Management tool
(hdblcmor hdblcmgui).

You need information on possible
causes and solutions.

e SAP Note 2078425/

e SAP Note 2082466

e Seethe SAP HANA Server In-
stallation and Update Guide
for your SAP HANA Platform
SPS. You can find this guide
on SAP Help Portal under

| 3 <your SPS> » Installation
and Update }

You get syntax errors whenin- | You need guidance on whetherto | SAP Note 2089829 #
stalling the cAR RETAIL APPL | take action. The answer depends

BUNDLE back-end product ver- | on your implementation scenario.

sion.

You get animport error when in- A program error must be fixed. SAP Note 2377525/

stalling the RTLAPPS software
component of the CAR RETAIL
APPL BUNDLE back-end prod-
uct version.
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Areas Issues Explanations Possible Solutions
You get the error SAP DBTech You are using software compo- SAP Note 2022080 %
JDBC: [258]: insufficient nent SAP HANA AFL 1.0and
privilege: Not authorized. have performed an upgrade of
your SAP HANA Platform. Previ-
ously assigned privileges might
have been lost during the upgrade.
In an upgrade or when imple- Anissue in the SAP HANA content | SAP Note 2298340 /%
menting a transport, you get must be fixed.
one of the following errors:
e Retcode 512: SQL-error
"259-invalid table name:
Could not find table/view
® Retcode 512: SQL-error
"328-invalid name of
function or procedure
In an upgrade, you get the fol- An issue that affects CDS views SAP Note 2340418 "
lowing error when running pro- | must be fixed.
gram RUTDDLSCREATE:
3 ETW678Xstart export of
R3TRDDLS<CDS Viewname> ...
3WETWOOO DDLS <CDS
Viewname> is not activated.
2EETWIS0 "DDLS" <CDS
Viewname> has no active
version.
4 ETW679 end export of
R3TRDDLS<CDS View name>.
SAP HANA content | You want to check the depend- | You might need this informationto | ® In SAP HANA studio: Select
encies of a specific view. solve a dependency or activation the view and choose Auto
issue. Documentation from the con-
text menu. This generates a
file with detailed information
on the view. Consult the
Cross References section.
e [fyou are using the SAP
HANA Live View Browser app:
Select the view and choose
Cross References.
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Areas Issues Explanations Possible Solutions
You get an error indicating that | You have not installed software e Forinitial installations: Install
you are attempting to access in- | component SAP RTL AFL FOR SAP Customer Activity Repo-
active or invalid SAP HANA con- | sap HANA. This component con- sitory Retail Applications Bun-
tent. tains back-end functionality for dlel’- Download and Install
the Unified Demand Forecast the Application Function
module and the On-Shelf Availabil- Library (AFL) 1
it dule. Even if don'tin-
Ly r;? ue tr\]/em yoz Ion n ® Forupgrade scenarios: Up-
en ; 9 utsﬁl those moay es,tyou grade SAP Customer Activity
must install the component.
P Repository Retail Applications
Bund/elb Download and
Install the Application
Function Library (AFL) 4
You are trying to activate the SAP | Follow the steps in Activate SAP
HANA content using the wrong HANA Content [page 138].
SAP Note.
You get the error Table ABAP:/ | A program error must be fixed. e SAP Note 2218875
DMF_ORG_ASSIGN not found. e SAP Note 2224582
You get the error Object A program error must be fixed. SAP Note 2224582
DDF_ORG_ASSIGN (Calculation
View), package
sap.is.ddf.udf.data_validation,
was processed with errors.
You get the error SQLScript: A program error must be fixed. SAP Note 2125672 ¥
Could not derive table type for
variable "UDF_FC_HORIZON".
SAP HANA view A program error must be fixed. SAP Note 2203930 #&
sap.is.ddf.fms does not ac-
tivate properly.
SAP HANA Plat- You want to use omnichannel You cannot install XSA as long as | SAP Note 2388443 M
form promotion pricing but cannot SAP HANA dynamic tiering is ac-
install the SAP HANA XS ad- tive on the same host.
vanced (XSA) runtime in your
SAP Customer Activity Reposi-
tory system.
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Areas Issues Explanations Possible Solutions
Customizing You cannot see the Customizing | You might not have activated all Activate Business Functions for
activities for Unified Demand required business functions for DDF and UDF [page 150]
Forecast (UDF) in the SAP Cus- | UDF.
tomizing Implementation Guide
(transaction SPRO).
Either the activities are not dis-
played at all or you see different
activities. When you try to dis-
play the correct activities by ac-
tivating business functions in
the Switch Framework (transac-
tion SFW5), you get an error.
Hierarchies You get errors when creating or | The system does not generate the | ®  Follow the steps in Configure
updating location hierarchies flat structures for the hierarchies. Automatic Flattening of Hier-
. ) ) archies [page 151].
and/or product hierarchies. You need to do some configura-
tion steps so that the hierarchies * Consuitthe following sections
get flattened automatically. in the SAP Customer Activity
Repository Administration
Guide:
o Configuring Demand
Data Foundation (DDF)
o Configuring Data Replica-
tion from SAP ERP to
DDF
You get errors when importing | A program error must be fixed. e SAP Note 2244521
article hierarchies from your e SAP Note 2245134#%
master data system.
You want to know which loca- You can implement an easy en- SAP Note 2208619 ¥
tions are included in each ver- hancement for table /DMEF/
sion of an offer. OFR_LG LOC.
An error occurs for a DDL SQL A program error must be fixed. SAP Note 2377525
view when you execute the
CREATE VIEW statement.
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Areas

Modeling and fore-
casting

Issues

You get the error 905
Structured Query Language
(SQL) exception detected:
&1&2&3&4.

Explanations

An SQL error must be fixed.

Possible Solutions

Use the system log (transaction
SM21) to find the underlying SQL
exception:

e To help find the correct log
entries, specify the user and
the approximate time frame.

e | ook for entries with the
same error as in this mes-
sage.

e Note that the log may span
several lines. This is indicated
by a red priority icon and an
initial “>".

e Attempt to determine the
root cause and a corrective
action based on the message
texts of the applicable log en-
tries.

You get the errors 901 Failed
execution for &1 and 926 Failed
decomposition.

You most likely have a data issue,
such as:

® Theload balancing settings
are not correct.

e Orthere are no active prod-
uct locations.

e See the message long texts
(transaction SE91).

e SAP Note 1898341#%

You get the errors 901 Failed
execution for &1 and 905
Structured Query Language
(SQL) exception: &1&2&3&4
and 926 Failed decomposition.

You most likely have an SQLScript
error.

See the message long texts
(transaction SE91).

You get the error Could not
execute 'call _SYS_AFL... or the
error Repository: Internal error
during statement execution....

The privileges for calling applica-
tion function libraries (AFLs) are
not assigned correctly or are in-
complete.

SAP Note 18461944
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Areas

Issues

You get one of the following er-
rors during modeling or fore-
casting:

® 1341 Procedure versions
validation failed: Procedure
version is not matched with
given version number #

® 1341 Procedure versions
validation failed: Version
validation is not enabled for
this procedure

Explanations

An SAP HANA version check
might be out of sync.

Possible Solutions

e Tryrunning the failed model-
ing or forecasting process
again several times. This al-
lows the SAP HANA version
management to synchronize
the versions. If the error oc-
cured during modeling, also
run forecasting again.

e SAP Note 1972414#% (for de-
velopment experts)

tion framework
(transaction
DRFOUT)

the /DMF/D_VENDOR table but
this deletion is not replicated to
the master data system.

You want to forecast complex You must set up a specific task de- | SAP Note 2176058 ¥
offers (such as Buy X Get Y). composition to run production
forecasts with the Unified Demand
Forecast (UDF) module.
You are using the Update Sales | You can enhance the performance | SAP Note 2080423
Projection function in SAP As- by implementing an SAP Note.
sortment Planning for Retail
(workbooks Product Planning
and Size Planning). You are ex-
periencing performance issues
when using the function with
large data volumes.
DRF datareplica- | You have deleted a vendor from | A program error must be fixed. SAP Note 1872136 "

You get an error when using the
DRF with the pMpPL, SAP ERP

outbound implementation.

A program error must be fixed.

e SAP Note 1904782
e SAP Note 2167629%%

® See the application help for
SAP Customer Activity Repo-
sitory at http://

help.sap.com/carlb <your
release> > Application Help
> Demand Data Foundation >

Integration Information >
Master Data Replication from
SAP ERP to Demand Data

Foundation ]
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Areas

Issues

You get the error Product &1,
location &2: The Valid From time
for &3 must be 00:00:00 (mes-
sage 364 in message

class /DMF/MSG_HL).

Explanations

A program error must be fixed.

Possible Solutions

SAP Note 2163602#

You have changed the listing in-
formation in your master data
system and replicated the
changes to your SAP Customer
Activity Repository system.
However, the listing information
there is not updated correctly.

A program error must be fixed.

SAP Note 1932525

Performance

You are experiencing perform-
ance issues in your SAP HANA
database.

You need information on how to
troubleshoot and resolve those is-
sues and how to enhance per-
formance in general.

See the SAP HANA Troubleshoot-
ing and Performance Analysis
Guide under http://help.sap.com/

hana_platform |} <your SAP
HANA SPS>  System

Administration }

You get a runtime error or exit
message and need information
about possible causes and solu-
tions.

Different causes are possible.

Use the ABAP dump analysis
(transaction ST22) to search for
short dumps and call up detailed
error information.

Remote Function
Calls (RFCs), func-
tion mdules

You are experiencing workflow
issues when executing an RFC
function module.

Different causes are possible.

SAP Note 10988054 (detailed
troubleshooting information for
different causes, tips & tricks)

Common Installation Guide CARAB 2.0

Post-Installation

CUSTOMER

173


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2163602
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1932525
http://help.sap.com/hana_platform
http://help.sap.com/hana_platform
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1098805

Areas Issues Explanations Possible Solutions

SAP Fiori You cannot open the Analyze The back-end reuse library might | You can do the following in the
Forecast app in your SAP Fiori not be loading correctly. back-end system:
launchpad. 1. Intransaction SICF, search

for the /sap/bc/
ui5 ui5/sap/
ddfreuse v2 service and
check that it is active.

2. Ifthe service is active, reset
the SAP Fiori cache:
In transaction SE38, execute
the following reports: /U15/
APP INDEX CALCULATE
and /u12/
INVALIDATE GLOBAL CACH
Esand /UI2/
INVALIDATE CLIENT CACH
ES.

3. Clear your browser cache and
check whether you can now
open the app.

The machine on which you want A program error must be fixed. SAP Note 2372802 ¥

to open the Analyze Forecast
app is set to a negative time
zone offset (such as UTC-7).
The app crashes.

More Information

Reporting Customer Incidents

When you report an incident for your installation, you must specify an application component. You can find the
component list for SAP Customer Activity Repository on the SAP Support Portal at http://support.sap.com/swdc
¥ | Support Packages and Patches # Software Downloads ¥ By Alphabetical Index (A-Z) # C » CAR RETAIL
APPLICATIONS BUNDLE » CAR RETAIL APPL BUNDLE 2.0 ¥ Info ¥ scroll down to: Customer Support 3.

For more information on reporting incidents for SAP Customer Activity Repository, see Support Desk
Management.

For generic information on reporting incidents or to search the SAP knowledge base for solutions, see the SAP
Support Portal at http://support.sap.com/ | Knowledge Base & Incidents .
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6.4 SAP Merchandise Planning for Retail

Post-installation of SAP Merchandise Planning for Retail.

1 Note

Some of the activities in this section may have already been performed in the corresponding section under SAP
Customer Activity Repository. Such activities do not need to be repeated during the setup and installation of
consuming applications.

6.4.1 Configure Demand Data Foundation

6.4.1.1 General Settings

1. Verify Client Administration
Ensure that you have updated the client details (transaction scc4).
1 Note

The currency setting here does not determine the currency used in SAP Merchandise Planning for Retail
1.1. This setting is intended for SAP BW configuration and does not affect the choice of currency one uses
for planning.

2. Verify Logical Systems
Ensure that the following Customizing activities under |» SAP NetWeaver j» Application Server ¥ IDoc
Interface / Application Link Enabling (ALE) » Basic Settings » Logical systems 4 are completed:
1. Define the systems as logical systems
2. Assign the logical system to your client

6.4.1.2 Configure Demand Data Foundation Steps

Use

SAP Merchandise Planning for Retail relies on data maintained in Demand Data Foundation (DDF). There are key
DDF configuration steps required to use the SAP Merchandise Planning for Retail application.

Procedure

1. Perform the necessary configuration steps in DDF.
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SAP Merchandise Planning for Retail uses master data and time series data stored in DDF. Before using the
SAP Merchandise Planning for Retail application, you must ensure that DDF is fully configured and
operational.
For more information, see the configuration document Configuring Demand Data Foundation (DDF).

2. Configure data replication from SAP ERP to DDF.
SAP Merchandise Planning for Retail uses master data (such as product, location, and product hierarchy) as
well as organizational data (such as sales organization and distribution channel) that is replicated from SAP
ERP to DDF using DRFOUT.
For more information on setting up this data replication, see the following document Configuring Data
Replication from SAP ERP to DDF.

6.4.1.3 Import SAP NetWeaver Portal Roles for DDF

To set up user authorizations for Demand Data Foundation (DDF), you can use the PFCG roles from the SAP
NetWeaver Business Client (NWBC) and from the SAP NetWeaver Portal. Both sets of roles operate in the same
manner. Using the SAP NetWeaver Portal is optional.

Use

The roles have been created for use in SAP NetWeaver Business Client. To use the functions of these roles in SAP
NetWeaver Portal, you must upload the roles from the SAP back-end system to the portal. The uploaded objects
are converted into portal objects.

Procedure

1. Use the Role Upload tool to generate the SAP NetWeaver Portal roles automatically. For more information
about this tool, see SAP Note 1685257 .
You can also enhance the SAP NetWeaver Portal roles; for example, you can create your own iViews.
You can upload the following roles for DDF:

© SAP ISR DDF MASTER
© SAP ISR DDF READONLY MASTER

For descriptions of these roles and information about maintaining roles in SAP Customer Activity Repository, see
Authorizations section in the SAP Customer Activity Repository 3.0 Administration Guide.
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6.4.2 Activate SAP Merchandise Planning for Retail Planning
Framework Content

The planning framework used by SAP Merchandise Planning for Retail consists of the following elements:

e Business Intelligence Content (Bl Content) Objects: A collection of local Bl Content objects is used as the
basis for the SAP BusinessObjects Analysis, edition for Microsoft Office workbooks.
SAP BusinessObjects Analysis, edition for Microsoft Office workbooks are designed to consume data from BI
Content objects. The local Bl Content objects that are provided with the SAP Merchandise Planning for Retail
applications use the integrated planning engine in SAP Business Warehouse (SAP BW). These local Bl
Content objects are used as an interface between the SAP HANA views and the SAP BusinessObjects
Analysis, edition for Microsoft Office workbooks.

1 Note

The local Bl Content provided with the SAP Merchandise Planning for Retail application is entirely
independent of the SAP Business Warehouse Bl Content and Bl Content Extensions add-on. You can use
this local Bl Content directly in SAP Merchandise Planning for Retail.

e SAP BusinessObjects Analysis, edition for Microsoft Office Workbooks: Microsoft Excel-based
spreadsheets that you use to plan assortments for the different locations in your retail business.

This section of the guide provides information on the SAP HANA content activation, Bl Content activation and
configuration, and data upload activities required to set up the SAP Merchandise Planning for Retail planning
framework.

6.4.2.1 Activate SAP HANA Content for SAP Merchandise
Planning for Retail

Use

In this procedure, you perform the final activation of SAP HANA content (views and stored procedures) required
by the SAP Merchandise Planning for Retail application. This final activation results in a full activation of the SAP
HANA content for SAP Merchandise Planning for Retail. Several SAP HANA views depend on local Bl Content
objects. The SAP HANA views have to be activated following the activation of these Bl Content objects, as
described in this procedure.

Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Merchandise Planning for
Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide as
pertains to SAP Customer Activity Repository. In particular, you must have created all the necessary tables, as
described in Create/Replicate Source Master Data System Tables [page 49].
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Procedure

o

Ensure thatthe Sys REPO user has the authorizations required to successfully activate SAP HANA content.
1. Provide user sys REPO with object privilege SELECT, with option "Grantable to others", on the following
physical DB schemas:
o Physical database schema of your back-end system, typically this is called SAP<SID>.
o Physical database schema that contains the SAP ERP tables

You can use the following example SQL statement to grant the required privilege:
GRANT SELECT ON SCHEMA <Your schema name> TO _SYS_REPO WITH GRANT OPTION;

Log on to SAP HANA Studio.

Open the Modeler and use the Navigator to access your back-end system.
Expand the Content folder located under your system name in the Navigator.
Expand the package listed below:

O sap.is.retail.rap.mpr

All the content in the underlying folders should be active.

More Information

http://help.sap.com/hana | HANA Platform JSection Activating Objects of the SAP HANA Developer Guide SAP.

6.4.2.2 Activate SAP Merchandise Planning for Retail Local

Bl Content

Procedure

178

On your back-end system, open the Data Warehousing Workbench (transaction RSa1).

In the Replicate Metadata dialog box, choose Only Activate.

If a message appears that you are only authorized to work in client. (Brain 009), then refer to SAP Note
316923 (do not import the support package, but use the description under section Workaround).
Select Do not show this question Again in the dialog that appears.

Choose Yes.

Make sure that the current job has finished before you proceed with the next step. Check the status of the
background job using transaction sM37or SLG1. If there are problems, you must first solve them.

You can use transaction RSTCO_ADMIN to restart the activation of the technical content and to verify the
status of the activation.
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1 Note

In the case that you get the short-dump "RAISE_EXCEPTION" when installing InfoObjects from the Bl
content, see SAP Note 1637935#% for a possible solution.

Also, see SAP Note 2090845#% for important information on technical content activation.

Following activation, you can locate the technical content in the Data Warehousing Workbench as follows:
1. Selecting Modeling in the left-hand frame.

2. Expand InfoObjects.

3. Intheright-hand frame, locate Technical Content.

6.4.2.3 Activate Application Bl Content

Caution

Proper authorization is required to complete these steps.

These instructions include maintenance steps for master data for info objects, /RAP/DSACT and /RAP/COMP as
well as to activate content under the Merchandise, Financial Planning for Retail ( /RAP/MP) InfoArea for the
following objects types:

e |nfoObjects

e |nfoCubes

e Composite Providers
e Aggregation levels

e Planning Sequence

e Queries

e Workbooks

The object types must be activated in the order above. Each object type and the detail objects are listed in the
tables below

e Usetransaction RSA1 to launch the BW workbench.

e |nthe navigation window, select push button B/ Content then choose Info Objects. When prompted for Source
System, do not select any and select OK.

e |ocate /RAP/AP. Expand todisplay; RAP Character InfoObject CatalogandRAP Key Figure
InfoObject Catalog. Select the character catalog and drag to the Collected Objects window.

e Select Install and Activate.

e Repeat the previous step for the key figure catalog.

Table 57: Info Objects

InfoObject Description InfoObject Name

BOP DC Stock at Cost /RAP/BDCCV
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InfoObject Description

InfoObject Name

Beginning of Period Stock Cost Value /RAP/BOPCV
Beginning of Period Stock Units /RAP/BOPUN
BOP Store Stock at Cost /RAP/BSTCV
Division /RAP/CDT1
Department /RAP/CDT2
Class /RAP/CDT3
Subclass /RAP/CDT4
Store Comparability Indicator /RAP/COMP
Country /RAP/CONTRY
On Order Cost DC /RAP/DCOCV
On Order Units DC /RAP/DCOUN
Returns at Cost DC /RAP/DCRECV
Return Units DC /RAP/DCREUN
Sales DC Fulfilled at Cost /RAP/DCSCV
DC Sales Units /RAP/DCSUN
Distribution Channel /RAP/DISTC
DataSlice Activation /RAP/DSACT
Sales Direct Fulfilled at Cost /RAP/DTSCV
End of Period Stock DC Cost Value /RAP/EDCCV
End of Period Stock DC Units /RAP/EDCUN
EOP Store Stock at Cost /RAP/ESTCV
End of Period Stock Store Units /RAP/ESTUN
Geographical Hierarchy Level 1 /RAP/GEOLV1
Geographical Hierarchy Level 2 /RAP/GEOLV2
Hierarchy ID /RAP/HIEID
Inventory Adjustment at Cost /RAP/IADCV
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InfoObject Description

InfoObject Name

Markdown Budget /RAP/MRKBUD
Promotion Budget /RAP/PROBUD
Receipt Units DC /RAP/RCPUND
Receipt Units Store /RAP/RCPUNS
Receipt DC at Cost /RAP/RDCCV
Receipt Store at Cost /RAP/RDTCV
Return DC Cost Value /RAP/REDCCV
Returns DC Units /RAP/REDCUN
Weeks of Supply /RAP/WKOSUP
Write Off Adjustment at Cost /RAP/WOFFAD
Distribution Channel /RAP/DISTC
On Order Cost Store /RAP/ONOCV
Returns at Cost Storel /RAP/RETRCV
Return Units Store /RAP/RETRUN
Location /RAP/LOCAT
Sales Organization /RAP/SLORG

e Forthe Info Cubes, go to object types and expand info area to locate /rRaP/MP. Select and transfer to the

Collect objects window.
e Select both cubes and install.

Table 58: Info Cubes (Planning writable)

Info Cube Description Info Cube Name

Financial Merchandise Planning, Plan /RAP/MPRCO1

Channel Planning, Plan /RAP/MPRCO02

Table 59: InfoObject Catalog (RAP)

Catalog Description Catalog Name
RAP Character InfoObject Catalog /RAP/CHAR_CAT
RAP Key Figure InfoObject Catalog /RAP/KYF_CAT
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Table 60: Composite Providers

Composite Provider Description

Financial Merchandise Planning, Plan

Composite Provider

/RAP/CP11

Table 61: Aggregation Levels

Aggregation Description ’ Aggregation Name
Financial Merchandise Plan - Department Query /RAP/C11A01
Channel Mix - Query/PF /RAP/C11A02
Financial Merchandise Plan - Department PF /RAP/C11A03
Financial Merchandise Plan - Class Query /RAP/C11A04
Financial Merchandise Plan - Subclass Query /RAP/C11A05
Financial Merchandise Plan - Division Query /RAP/C11A06
Financial Merchandise Plan - Division PF /RAP/C11A07
Financial Merchandise Plan - Class PF /RAP/C11A08
Financial Merchandise Plan - Subclass PF /RAP/C11A09
Channel Plan - Store Area Query PF /RAP/C11A13
Channel Plan - Single Store Query /RAP/C11A15
Channel Plan - Single Store Query PF /RAP/C11A16
Channel Plan - Multi Store Query/PF /RAP/C11A18
Channel Plan - Comp/Non Comp Query/PF /RAP/C11A19
Channel Plan - Store Area PF /RAP/C11A20

Master Data

In this step, you maintain master data for the info objects DataSlice Activation, /RAP/DSACT and Store
Comparability Indicator, /rRap/comp before continuing with the next activation.

Log on to your back-end system using SAP GUI.
Open the Edit InfoObjects (transaction RSD1).

N

In the Version Type section select Characteristic in the Editing Function section select InfoObject and
enter /RAP/DSACT. Select Maintain.

On the Edit Characteristic /RAP/DSACT : Details screen, select the icon Maintain Master Data .
You are on the Change Master Data of InfoObject /RAP/DSACT maintenance screen.
Add or verify there is an entry for A and D. Save the table and close the window.

N o o s

In your SAP GUI session use the green back arrow to return to Edit InfoObjects. In the Editing Function section
select InfoObject and enter /RAP/COMP. Select Maintain.
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8. You are on the Change Master Data of InfoObject /RAP/COMP maintenance screen.

9. Add or verify there is an entry for C, and the text “Comparable” and N, and the text “Non Comparable”. Save

the table and close the window.

Table 62: Function Type for Planning

Function Type Description

Activation / Deactivation Data Slice

Function Type Name

/RAP/MP_DATASLICE

MPR Channel Mix Top Down Distribution

/RAP/M_CHNMIX_TOPDWN

MPR Channel Plan Multi Store Top Down Distribution

/RAP/M_CHNPLN_MULTI

MPR Channel Plan Single Store Top Down from Multi

/RAP/M_CHNPLN_SNGL

MPR Channel Plan Comp/Non Comp Top Down Distribution

/RAP/M_CHNPLN_TOPDWN

MPR Distribute from CDT1to CDT2

/RAP/M_DISTR_CDT1_2

MPR Distribute from CDT2 to CDT3

/RAP/M_DISTR_CDT2_3

MPR Distribute from CDT3 to CDT4

/RAP/M_DISTR_CDT3_4

Table 63: Planning Functions

Planning Function Description

Planning Function Name

Channel Mix - Actualization

/RAP/C11A02 PFO1

Channel Mix - Delete Plan Data

/RAP/C11A02 PFO02

Channel Mix - Release

/RAP/C11A02 PF03

Channel Mix - Copy Version

/RAP/C11A02 PFO5

Channel Mix - Bottom Up - Merchandise Plan

/RAP/C11A02_ PF06

Merchandise Plan - Deactivate Data Slice

/RAP/C11A02_PFO7

Channel Mix - Bottom Up - Comp/Non-Comp

/RAP/C11A02 PFO08

Channel Mix - Bottom Up - Multi Stores

/RAP/C11A02_ PF09

Channel Mix - Generate Combinations

/RAP/C11A02 PF10

Merchandise Plan - Activate Data Slice

/RAP/C11A02_PF11

Channel Plan - Activate Data Slice

/RAP/C11A02 PF12

Channel Plan - Deactivate Data Slice

/RAP/C11A02 PF13

Financial Merchandise Plan - Department - Copy Version

/RAP/C11A03 PFO1
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Planning Function Description

Planning Function Name

Financial Merchandise Plan - Department - Delete Plan Data

/RAP/C11A03 PFO02

Financial Merchandise Plan - Department - Recalculate BOP

/RAP/C11A03 PF03

Financial Merchandise Plan - Department - Release

/RAP/C11A03_PF04

Financial Merchandise Plan - Department - Initialize BOP - T

/RAP/C11A03 PFO05

Financial Merchandise Plan - Department - Bottom Up

/RAP/C11A03 PF06

Financial Merchandise Plan - Department - Top Down

/RAP/C11A03_PFO07

Financial Merchandise Plan - Department - Actualization

/RAP/C11A03 PFO08

Financial Merchandise Plan - Department - Generate Combi-
nati

/RAP/C11A03_PF09

Financial Merchandise Plan - Department - Initialize BOP - M

/RAP/C11A03 PF10

Financial Merchandise Plan - Departm. - Bottom Up - S. Store

/RAP/C11A03_PF11

Financial Merchandise Plan - Division - Copy Version

/RAP/C11A07 PFO1

Financial Merchandise Plan - Division - Release

/RAP/C11A07 PFO02

Financial Merchandise Plan - Division - Delete Plan Data

/RAP/C11A07 PFO03

Financial Merchandise Plan - Division - Bottom Up

/RAP/C11A07 PFO05

Financial Merchandise Plan - Division - Recalculate BOP

/RAP/C11A07 PFO06

Financial Merchandise Plan - Division - Initialize BOP - T

/RAP/C11RA07 PFO7

Financial Merchandise Plan - Division - Bottom Up - S. Store

/RAP/C11A07 PFO08

Financial Merchandise Plan - Division - Top Down Channel Mix

/RAP/C11A07 PF09

Financial Merchandise Plan - Division - Initialize BOP - M

/RAP/C11A07_PF11

Financial Merchandise Plan - Division - Actualization

/RAP/C11A07_PF12

Financial Merchandise Plan - Division - Generate Combination

/RAP/C11A07 PF13

Financial Merchandise Plan - Class - Copy Version

/RAP/C11A08_PFO1

Financial Merchandise Plan - Class - Release

/RAP/C11A08 PFO02

Financial Merchandise Plan - Class - Delete Plan Data

/RAP/C11A08 PFO03

Financial Merchandise Plan - Class - Bottom Up

/RAP/C11A08 PF04
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Planning Function Description

Financial Merchandise Plan - Class - Recalculate BOP

Planning Function Name

/RAP/C11A08 PFO05

Financial Merchandise Plan - Class - Initialize BOP - T

/RAP/C11A08 PF06

Financial Merchandise Plan - Class - Generate Combination

/RAP/C11A08 PFO7

Financial Merchandise Plan - Class - Top Down

/RAP/C11A08 PF08

Financial Merchandise Plan - Class - Initialize BOP - M

/RAP/C11A08 PF09

Financial Merchandise Plan - Class - Actualization

/RAP/C11A08 PF10

Financial Merchandise Plan - Class - Bottom Up - S. Store

/RAP/C11A08 PF11

Financial Merchandise Plan - Subclass - Copy Version

/RAP/C11A09_PFO1

Financial Merchandise Plan - Subclass - Release

/RAP/C11RA09 PFO02

Financial Merchandise Plan - Subclass - Delete Plan Data

/RAP/C11RA09 PFO03

Financial Merchandise Plan - Reconsiliation - Finalize

/RAP/C11A09 PF04

Financial Merchandise Plan - Subclass - Recalculate BOP

/RAP/C11RA09 PFO05

Financial Merchandise Plan - Reconsiliation - Calc. Markdown

/RAP/C11A09 PF06

Financial Merchandise Plan - Subclass - Initialize BOP - T

/RAP/C11A09 PFO7

Financial Merchandise Plan - Reconsiliation - Calc. Promo

/RAP/C11A09 PF08

Financial Merchandise Plan - Reconsiliation - Calc. OTB

/RAP/C11A09 PF09

Financial Merchandise Plan - Reconsiliation - Aggr. OTB

/RAP/C11A09 PF10

Financial Merchandise Plan - Reconsiliation - Aggr. Markdown

/RAP/C11A09 PF11

Financial Merchandise Plan - Reconsiliation - Aggr. Promo

/RAP/C11A09 PF12

Financial Merchandise Plan - Subclass - Top Down

/RAP/C11A09_ PF13

Financial Merchandise Plan - Subclass - Initialize BOP - M

/RAP/C11A09 PF14

Financial Merchandise Plan - Subclass - Generate Combina-
tion

/RAP/C11RA09 PF15

Financial Merchandise Plan - Subclass - Actualization

/RAP/C11RA09 PF16

Financial Merchandise Plan - Subclass - Bottom Up - S. Store

/RAP/C11A09 PF17

Channel Plan - Store Area - Fill all Periods

/RAP/C11A13 PFO1
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Planning Function Description

Planning Function Name

Channel Plan - Store Area - Copy Store Area

/RAP/C11A13 PF03

Channel Plan - Single Store - Copy Version

/RAP/C11A16 PFO1

Channel Plan - Single Store - Release

/RAP/C11A16 PFO02

Channel Plan - Singe Store - Delete Plan Data

/RAP/C11A16 PFO03

Channel Plan - Single Store - Recalculate BOP

/RAP/C11A16_PFO04

Channel Plan - Single Store - Initialize BOP - T

/RAP/C11A16 PFO05

Channel Plan - Single Store - Create Combination

/RAP/C11A16_PF06

Channel Plan - Single Store - Initialize BOP - M

/RAP/C11A16 PFO7

Channel Plan - Single Store - Actualization

/RAP/C11A16 PFO08

Channel Plan - Single Store - Top Down

/RAP/C11A16 PF09

Channel Plan - Multi Store - Copy Version

/RAP/C11A18 PFO1

Channel Plan - Multi Store - Delete Plan Data

/RAP/C11A18 PFO02

Channel Plan - Multi Store - Release

/RAP/C11A18 PFO03

Channel Plan - Multi Store - Bottom Up

/RAP/C11A18 PF04

Channel Plan - Multi Store - Generate Combinations

/RAP/C11A18 PFO05

Channel Plan - Multi Store - Actualization

/RAP/C11A18 PF06

Channel Plan - Multi Store - Top Down - Comp/Non-Comp

/RAP/C11A18 PFO7

Channel Plan - Multi Store - Top Down - Merchandise Plan

/RAP/C11A18 PFO08

Channel Plan - Multi Store - Copy Store

/RAP/C11A18 PF09

Channel Plan - Comp/Non-Comp

/RAP/C11A19 PFO1

Channel Plan - Comp/Non-Comp

/RAP/C11A19 PFO02

Channel Plan - Comp/Non-Comp

/RAP/C11A19 PFO03

Channel Plan - Comp/Non-Comp

/RAP/C11A19 PF04

Channel Plan - Comp/Non-Comp

/RAP/C11A19 PFO05

Channel Plan - Comp/Non-Comp

/RAP/C11A19 PF06

Channel Plan - Comp/Non-Comp

/RAP/C11A19 PFO7
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Planning Function Description

Channel Plan - Store Area - Aggr. Store Area

’ Planning Function Name

/RAP/C11A20 PFO1

Table 64: Planning Sequence

Planning Sequence Desc

Channel Mix - Copy Version

’ Planning Sequence

/RAP/C11A02 PSO1

Channel Mix - Delete Plan Data

/RAP/C11A02_PS02

Channel Mix - Release

/RAP/C11A02 PS03

Channel Mix - Bottom Up - Merchandise Plan

/RAP/C11A02 PS04

Channel Mix - Bottom Up - Channel Plan - Comp/Non-Comp

/RAP/C11A02 PS05

Channel Mix - Bottom Up - Channel Plan - Multi Store

/RAP/C11A02 PS06

Channel Mix - Actualization

/RAP/C11RA02 PSO7

Activation of Data Slice

/RAP/C11R02_PS08

Deactivation of Data Slice

/RAP/C11A02 PS09

Financial Merchandise Plan - Department - Copy Version

/RAP/C11A03 PSO1

Financial Merchandise Plan - Department - Delete Plan Data

/RAP/C11A03_PS02

Financial Merchandise Plan - Department - Recalculate BOP

/RAP/C11A03 PS03

Financial Merchandise Plan - Department - Release

/RAP/C11A03 PS04

Financial Merchandise Plan - Department - Initialize BOP - M

/RAP/C11A03_PS05

Financial Merchandise Plan - Department - Bottom Up

/RAP/C11RA03 PS06

Financial Merchandise Plan - Department - Top Down

/RAP/C11A03 PS07

Financial Merchandise Plan - Department - Initialize BOP - P

/RAP/C11A03 PS08

Financial Merchandise Plan - Department - Initialize BOP - T

/RAP/C11A03 PS09

Financial Merchandise Plan - Department - Actualization

/RAP/C11A03 PS10

Financial Merchandise Plan - Departm. - Bottom Up - S. Store

/RAP/C11A03 PS11

Financial Merchandise Plan - Division - Copy Version

/RAP/C11A07_PSO1

Financial Merchandise Plan - Division - Release

/RAP/C11A07 PS02

Financial Merchandise Plan - Division - Delete Plan Data

/RAP/C11A07 PS03
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Planning Sequence Desc

Financial Merchandise Plan - Division - Bottom Up

’ Planning Sequence

/RAP/C11R07 PS04

Financial Merchandise Plan - Division - Recalculate BOP

/RAP/C11A07 PS05

Financial Merchandise Plan - Division - Initialize BOP - P

/RAP/C11A07 PS06

Financial Merchandise Plan - Division - Initialize BOP - T

/RAP/C11A07 PS0O7

Financial Merchandise Plan - Division - Bottom Up - S. Store

/RAP/C11A07 PS08

Financial Merchandise Plan - Division - Top Down - Chan. Mix

/RAP/C11A07 PSO09

Financial Merchandise Plan - Division - Initialize BOP - M

/RAP/C11A07 PS10

Financial Merchandise Plan - Division - Actualization

/RAP/C11A07_PS11

Financial Merchandise Plan - Division - Top Down - Multi St.

/RAP/C11A07 PS12

Financial Merchandise Plan - Class - Copy Version

/RAP/C11A08 PSO1

Financial Merchandise Plan - Class - Release

/RAP/C11A08 PS02

Financial Merchandise Plan - Class - Delete Plan Data

/RAP/C11A08 PS03

Financial Merchandise Plan - Class - Bottom Up

/RAP/C11R08 PS04

Financial Merchandise Plan - Class - Recalculate BOP

/RAP/C11A08 PS05

Financial Merchandise Plan - Class - Initialize BOP - P

/RAP/C11A08 PS06

Financial Merchandise Plan - Class - Initialize BOP - T

/RAP/C11A08 PSO7

Financial Merchandise Plan - Class - Top Down

/RAP/C11A08 PS08

Financial Merchandise Plan - Class - Initialize BOP - M

/RAP/C11A08 PS09

Financial Merchandise Plan - Class - Actualization

/RAP/C11A08 PS10

Financial Merchandise Plan - Class - Bottom Up - S. Store

/RAP/C11A08_PS11

Financial Merchandise Plan - Subclass - Initialize BOP - T

/RAP/C11RA09 PFO06

Financial Merchandise Plan - Subclass - Copy Version

/RAP/C11A09 PSO1

Financial Merchandise Plan - Subclass - Release

/RAP/C11A09 PS02

Financial Merchandise Plan - Subclass - Delete Plan Data

/RAP/C11RA09 PS03

Financial Merchandise Plan - Reconsiliation - Finalize

/RAP/C11R09 PS04

Financial Merchandise Plan - Subclass - Recalculate BOP

/RAP/C11RA09 PS05
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Planning Sequence Desc

Financial Merchandise Plan - Reconsiliation - Markdown
Budge

’ Planning Sequence

/RAP/C11A09 PS06

Financial Merchandise Plan - Subclass - Initialize BOP - P

/RAP/C11A09 PSO07

Financial Merchandise Plan - Reconsiliation - Promo Budget

/RAP/C11A09 PS08

Financial Merchandise Plan - Reconsiliation - OTB

/RAP/C11RA09 PS09

Financial Merchandise Plan - Subclass - Top Down

/RAP/C11A09 PS10

Financial Merchandise Plan - Subclass - Initialize BOP - M

/RAP/C11A09 PS1l

Financial Merchandise Plan - Subclass - Actualization

/RAP/C11RA09 PS13

Financial Merchandise Plan - Subclass - Bottom Up - S. Store

/RAP/C11A09 PS14

Channel Plan - Store Area - Fill all Periods

/RAP/C11A13 PSO1

Channel Plan - Store Area - Copy Store Area

/RAP/C11A13_PS02

Channel Plan - Single Store - Copy Version

/RAP/C11A16 PSO1

Channel Plan - Single Store - Release

/RAP/C11A16 PS02

Channel Plan - Single Store - Delete Plan Data

/RAP/C11A16 PS03

Channel Plan - Single Store - Recalculate BOP

/RAP/C11A16 PS04

Channel Plan - Single Store - Initialize BOP - P

/RAP/C11A16 PS05

Channel Plan - Single Store - Initialize BOP - T

/RAP/C11A16 PS06

Channel Plan - Single Store - Initialize BOP - M

/RAP/C11A16_PSO07

Channel Plan - Single Store - Actualization

/RAP/C11A16 PSO8

Channel Plan - Single Store - Top Down

/RAP/C11A16 PS09

Channel Plan - Multi Store - Copy Version

/RAP/C11A18 PSO1

Channel Plan - Multi Store - Delete Plan Data

/RAP/C11A18 PS02

Channel Plan - Multi Store - Release

/RAP/C11A18_ PS03

Channel Plan - Multi Store - Bottom Up

/RAP/C11A18 PS04

Channel Plan - Multi Store - Actualization

/RAP/C11A18 PS05

Channel Plan - Multi Store - Top Down - Comp/Non-Comp

/RAP/C11A18 PS06
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Planning Sequence Desc ’ Planning Sequence

Channel Plan - Multi Store - Top Down - Channel Mix /RAP/C11A18 PSO7
Channel Plan - Multi Store - Top Down - Merchandise Plan /RAP/C11A18_PSO08
Channel Plan - Multi Store - Copy Store /RAP/C11A18 PS09
Channel Plan - Comp/ Non-Comp - Copy Version /RAP/C11A19 PSO1
Channel Plan - Comp/Non-Comp - Delete Plan Data /RAP/C11A19 PS02
Channel Plan - Comp/Non-Comp - Release /RAP/C11A19 PS03
Channel Plan - Comp/Non-Comp - Actualization /RAP/C11A19 PS04
Channel Plan - Comp/Non-Comp - Bottom Up /RAP/C11A19 PS06
Channel Plan - Comp/Non-Comp - Top Down /RAP/C11A19 PSO7
Channel Plan - Store Area - Aggr. Store Area /RAP/C11A20 PSO1

Queries There are too many queries to list in this section. Activate all queries under the /RaP/MP Info Area.

Table 65: Workbooks

Workbook Description ’ Workbook Technical Name

01 - Channel Mix /RAP/MPCHANNELMIX

01 - Channel Mix /RAP/MPCHANNELMIXV?2

03 - Merchandise Plan - Class /RAP/MPCLASS

03 - Merchandise Plan - Class /RAP/MPCLASSV2

02 - Merchandise Plan - Department /RAP/MPDEPARTMENT

02 - Merchandise Plan - Department /RAP/MPDEPARTMENTV?2

01 - Merchandise Plan - Division /RAP/MPDIVISION

01 - Merchandise Plan - Division /RAP/MPDIVISIONV2

05 - Merchandise Plan - OTB Reconsiliation Report /RAP/MPOTBRECONSILIATION
05 - Merchandise Plan - OTB Reconsiliation Report /RAP/MPOTBRECONSILIATIONV2
05 - Channel Plan - Store Area Plan /RAP/MPSTOREAREA

05 - Channel Plan - Store Area Plan /RAP/MPSTOREAREAV?2

02 - Channel Plan - Store Comparability /RAP/MPSTORECOMP
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Workbook Description Workbook Technical Name
02 - Channel Plan - Store Comparability /RAP/MPSTORECOMPV2

03 - Channel Plan - Multi Store /RAP/MPSTOREMULTI

03 - Channel Plan - Multi Store /RAP/MPSTOREMULTIV?2
04 - Channel Plan - Single Store /RAP/MPSTORESINGLE

04 - Channel Plan - Single Store /RAP/MPSTORESINGLEV2
04 - Merchandise Plan - Subclass /RAP/MPSUBCLASS

04 - Merchandise Plan - Subclass /RAP/MPSUBCLASSV2

6.4.2.4 Configure SAP Merchandise Planning for Retail Local
Bl Content

6.4.2.4.1 Enable the Planning Application Kit (PAK)

Use

To be able to use the SAP BusinessObjects Analysis, edition for Microsoft Office workbooks provided as part of
the SAP Assortment Planning for Retail planning framework content, you must enable the Planning Application
Kit.

Procedure

1. Read SAP Note 1637199 .

2. Inyour back-end system, launch table/view maintenance (transaction sM30).

3. Enter RSPLS_HDB_ACT in the Table/View field and choose Maintain.

4. Choose New Entries.

5. Inthe HANA Integratn. Active column select Deep HANA Integration Active and inthe Functn. Active

column, enable the checkbox.

6.4.2.4.2 Maintain RSADMIN Parameter for Input Cells

In this procedure, you maintain the RSADMIN parameter for Input Cells in the SAP BW application to suppress zero
values for actual data versions.
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Log on to your back-end system.
Open the ABAP Editor (transaction SE38).
Run program SAP_RSADMIN MAINTAIN

AW

In RSAD Table Maintenance, insert ZERO_SUPPRESSION ON INPUTCELLS in OBJECT and Execute.

6.4.2.4.3 Maintain Fiscal Year Variants

Use

In this section you maintain the required fiscal year variant values for week and month; OFISCVARNT 'RW' and
"RM'.

Caution

SAP Merchandise Planning for Retail uses activated time objects 0FISCPER (fiscal year period) and
OFISCVARNT (fiscal year variant), provided as part of the technical BI Content.

If you are also using the SAP Assortment Planning for Retail application, you use the same fiscal year variant
that was created for this application.

Procedure

Fiscal Variant RW

The steps provided in this procedure allow you to maintain OFISCVARNT 'RW' using the standard 4-5-4 calendar
entries. If you are using alternative fiscal periods in your retail business, for example, each week starting on a
Sunday instead of Saturday, you can provide your own entries instead of the ones suggested in this guide.

1. Logonto your back-end system.

2. Launch fiscal year variant maintenance (transaction GVAR).

3. Choose New Entries.

4. Onthe New Entries: Overview of Added Entries screen make the following sets of entries:

Table 66:
Field Name User Entry
FV RW

Description Planning week

Year- Select

dependent
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Field Name User Entry

Calendar yr Do not select

Number of 53
period

postings

No.of
special

periods

5. Choose Enter.
An information message is displayed about creating more than 16 periods, choose Continue.
6. Choose Back.
You can see the newly created entry.
7. Mark the entry RW and select Periods from the Dialog Structure.
8. Enter 2012 in the Calendar yr field and choose Continue.
Data for the previous year must be maintained.
9. Choose New Entries.
10. Open SAP Note 2112634 %%, locate the entries for year 2012, and enter the data by copy-and-paste. Note that

this SAP Note is applicable for both SAP Merchandise Planning for Retail and SAP Assortment Planning for
Retail.

11. Choose Enter to finish your input.
While making the fiscal year entries, an information message might be displayed stating that there are Gaps in
financial year variant periods RW. This is an information message only, and the entered fiscal year data is
saved.

12. Maintain the weekly fiscal year variant in the same way for the year 2017. The entries for year 2017 are also
available in SAP Note 2112634 # .

13. Select Shortened Fiscal Years from the Dialog Structure.
14. Enter 2013 in the Fiscal year field and choose Continue.
15. Choose New Entries.

16. Enter 52 in the No. of posting periods field.

17. Choose Back twice.

18. Maintain the weekly fiscal year variant in the same way for the shortened fiscal years, that is, years 2013,
2014, 2015, 2016, and 2018. The corresponding tables are available in SAP Note 2112634 ¥ .
19. Choose Save after you have finished the maintenance for year 2018.

Fiscal Variant RM

The next steps allow you to maintain 0FTISCVARNT 'RM' using the standard 12 month calendar entries. If you are
using alternative fiscal periods in your retail business, you can provide your own entries instead of the ones
suggested in this guide. These month entries must align with the week values used in the prior step.

1. Inthe Fiscal Year Variants view, choose New Entries.
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2. Onthe New Entries: Overview of Added Entries screen make the following sets of entries:

Table 67:

Field Name User Entry
FV RM

Description Planning month

Year- Select
dependent

Calendar yr Do not select

Number of 12
period

postings

No.of
special

periods

3. Choose Enter.

4. Choose Back.
You can see the newly created entry.
To get the information to enter in the next step, open SAP Note 2112634 # . Note that this SAP Note is
applicable for both SAP Merchandise Planning for Retail and SAP Assortment Planning for Retail. If you have
used these dates for your weekly calendar, then align the month end dates to match. An example is contained
in the table below using the 2015 calendar entries from the SAP Note.

5. Mark the entry RM and select Periods from the Dialog Structure and double click to open the Calendar year
dialog.

Enter 2012 in the Calendar yr field and choose Continue.

Choose New Entries. For the year selected to enter the information that will define each period.

Enter the last valid calendar date of the period being added in the Month and Day fields.

© 0 N o

Enter the relevant Period number.

10. In the Year Shift field, enter +1 if the fiscal year is later than the calendar year enter. Enter -1if the fiscal year is
before the calendar year.

11. Press Enter to accept the first row.

12. Continue adding each period to complete the fiscal year.
Maintain the monthly fiscal year variant in the same way for the remaining years.

13. Choose Save after you have finished the maintenance for year 2018.

Choose Save after you have finished the maintenance for year the last year.

Table 68: 2015 Monthly Calendar

Year Shift
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Month Day Period Year Shift
2 28 1 0
3 28 2 0
5 2 3 0
5 30 4 0
6 27 5 0
8 1 6 0
8 29 7 0
9 26 8 0
10 31 9 0
1 28 10 0
12 26 1 0
12 31 12 0

6.4.2.4.4 Generate Time Dimension

Use

In this procedure you generate the time dimension. There is a weekly and monthly time dimension required. The
steps provided in this procedure allow you to maintaintheM FISCAL CALENDAR tableinthe sys BI schema.

Perform the steps for the weekly (RW), then the monthly (RM) dimensions.

Procedure

1. Logontoyour SAP HANA studio.
2. From the Quick Launch tab page, choose Generate Time Data.
3. Inthe Generate Time Data dialog, input the following values:

Table 69:

Comment

Calendar Type Fiscal
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Field Value Comment

From Year 2010 Ensure that you choose the first year that you
have entered in transaction GVAR.

To Year 2020 Ensure that you choose the last year that you
have entered in transaction GVAR.

Variant RW: (Client) (Istiteration) Ensure that you choose the fiscal year variant

) ) that you have defined in transaction GVAR for
RM: (Client) (2nditeration) ) )

the appropriate client..

4. Choose button Generate.
5. ChecktableM FISCAL CALENDARINnthe SYS BI schema to confirm the time generation.

Return to Step 2 in the procedure and repeat the steps for the monthly dimension.

6.4.2.4.5 Maintain Versions

In this step, you maintain the master data for the InfoObject /RAP/VERSN to support versions in workbooks.

1. Open the Edit InfoObjects (transaction RSD1).

2. Inthe Version Type section select Characteristic and in the Editing Function section select InfoObject.
In the text input field enter /RAP/VERSN. Select Maintain.

3. Onthe Edit Characteristic /RAP/VERSN : Details screen, select the icon Maintain Master Data .
4. You are on the Change Master Data of InfoObject /RAP/VERSN maintenance screen.
5. Add the entries in the table below. Save the table and close the window.

Table 70:
Version Text
MO1 MO Working Version
MO2 MO Simulation Version
MOR MO Reporting Version
MOP MO Inseason Version
MD1 MD Working Version
MD2 MD Simulation Version
MDR MD Reporting Version
MDP MD In season Version
MP1 MP Working Version
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Version Text

MP2 MP Simulation Version
MPR MP Reporting Version
MPP MP In season Version
MM1 MM Working Version
MM2 MM Simulation Version
MMR MM Reporting Version
MMP MM In season Version
MMF MM Final Version

FO1 FO Working Version
FO2 FO Simulation Version
FOR FO Reporting Version
FOP FO In season Version
FD1 FD Working Version
FD2 FD Simulation Version
FDR FD Reporting Version
FDP FD In season Version
FM1 FM Working Version
FM2 FM Simulation Versio
FMR FM Reporting Version
FMP FM In season Version
FL1 FL Working Version
FL2 FL Simulation Versio
FLR FL Reporting Version
FLP FL In season Version
SAP Store Area Plan
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6.4.2.4.6 Maintain Time Hierarchy

The time hierarchy is used to summarize the fiscal periods for planning. In this step, you create 2 time hierarchies:
YR/SEASON and YR/SEASON/MON/WK. Use transaction RSH1 to create the hierarchies for the InfoObject
0FISCPER. The instructions are an example of the required steps that will be repeated for each year and time
period

Table 71:
InfoObject ’ Time hierarchy example
0FISCPER e Create the ORP_FISCHIERO2 hierarchy name with the entry YR/SEASON in the Short

Description field.

® (Create the Year hierarchy node with Year in the Short Description.

® Choose the Year hierarchy node, and create the Spring hierarchy node with Spring
in the Short Description field under the Year hierarchy node. Click continue

e Choose the Spring hierarchy node, use the Characteristic Nodes Button to insert the
Fiscal year/Period value for each period for that season.

e Continue the process for each year, season and period. Save and activate the hierarchy
when completed.

e Create the ORP_FISCHIERO1 hierarchy name with the entry YR/SEASON/MON/WK in
the Short Description field.

e Create the Year hierarchy node with Year value in the Short Description field.

e Choose the Year hierarchy node, and create the Spring hierarchy node with Spring
in the Short Description field under the Year hierarchy node.

® Choose the Spring hierarchy node, and create the February hierarchy node with
February in the Short Description field under the Spring hierarchy node.

e Choose the February hierarchy node, use the Characteristic Nodes Button to insert the
Fiscal year/Period value for each period for that month.

e Continue the process for each year, season, month, period as desired. Save and activate
the hierarchy when completed.

6.4.2.4.7 Activate Internet Communication Framework (ICF)
Services

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Merchandise
Planning for Retail application are made available in an inactive state.

In this procedure, you activate the ICF service.

1. Logonto your back-end system.
2. Openthe HTTP Service Hierarchy Maintenance screen (transaction SICF).
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3. Enter the following data:

Table 72:

Field name User action and values

Hierarchy Type SERVICE

Choose Execute.

On the Maintain Service screen, expand the hierarchy of Default host.
Expand SAP.

Select the BW entry.

From the context menu choose Activate service.

© N o

. In the confirmation dialog box, choose Yes to activate all sub-nodes below the BW node in the hierarchy.
10. Choose Back.

6.4.2.4.8 Maintain Source System IDs

In this procedure, you maintain the source system IDs.

1. Logonto your back-end system.
2. Openthe Data Warehouse Workbench: Modeling screen (transaction RSA1).
3. Choose InfoProvider.
4. Choose from the menu |l Tools » Asgnmt of Srce Syst. to Srce Syst. ID 1.
5. Enter a unique 2 digit Source System ID for all of your systems.
You have the following example:
Table 73:
Source System Source Name Source System ID System ID Text
FILE FILE 01 Flat files
6. Choose Enter.
7. Enter a Source System ID Text for each system.
8. Choose Save.
9. Ifthe system displays a dialog box with the information Empty source system IDs are not saved, choose Enter.

10. Choose Back.

6.4.2.4.9 Connect File System in SAP BW

In this procedure, you perform the settings that are necessary for the connectivity for an external system - PC
files on the Workstation (for example Excel files) or files on the application server in SAP BW.

1. Logonto your back-end system.
2. Open the Data Warehouse Workbench: Modeling screen (transaction RSA1).
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Choose Modeling.

Choose Source Systems.

In the right-hand frame, mark the entry File.
Right-click the folder of File.

Choose Create.

0 N ook~ w

Enter the following data:
Table 74:

Field name User action and values

Logical system name FILE

Source system name FILE

9. Choose Continue.
10. Right-click the FILE Source System.
11. Follow the context menu path Activate.

6.4.2.5 Maintain Process Chain Related

Maintain BW process chain variants relevant for SAP Merchandise Planning for Retail.

Context

In this procedure, you activate the following infoobjects and maintain the BW process chain variants.

Table 75: Planning: Characteristic Relationships

InfoObject Description InfoObject Name
Characteristic Rels. for Financial Merchandise Planning Plan /RAP/MPRCO1
Characteristic Rels. for Channel Planning Plan /RAP/MPRCO02

Table 76: Planning: Data Slices

InfoObject Description InfoObject Name

Data Slices for Financial Merchandise Planning, Plan /RAP/MPRCO1

Data Slices for Channel Planning, Plan /RAP/MPRC02
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Table 77: Process Chain Doc Process Chain

InfoObject Name

/RAP/MPPCO1 01

Table 78: Process Chain Starter

InfoObject Name

/RAP/MPPCO1 01

Procedure

In this process you will create variants and activate the BW process chains.

1. Planning Sequence Data Slice Activation

Go to transaction RSPLAN

Select the Planning Sequence button.

In the planning sequence field, enter /RAP/C11A02 PS08 and choose Edit button.
Select the Variables button.

Select the Geographical Level 1 Input help and select a value.

Select the Save As Button.

In the Variables prompt, choose F9 to turn Cross User-variant on.

0 N o ok~ W

Enter a variant name. For description enter Data Slice Activation and selectthe Cross-User Variant
check box.

9. Select the Continue button.

10. Select the Continue button in the variables screen.

11. Go to transaction RSA1.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose Edit.

14. In the right tree, right click on Execute Planning Sequence Data Slice Activation (/RAP/MPPCO01_10)
and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).
16. Select the Transfer button and save.
2. Planning Sequence Deactivation of Data Slice
Go to transaction RSPLAN
Select the Planning Sequence button.
In the planning sequence field, enter /RAP/C11A02 PsS09 and choose Edit button.
Select the Variables button.
Select the Geographical Level 1 Input help and select a value.
Select the Save As Button.
In the Variables prompt, choose F9 to turn Cross User-variant on.
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Enter a variant name. For description enter Data Slice Deactivation and select the Cross-User
Variant check box.

9. Select the Continue button.

10. Select the Continue button in the variables screen.

11. Goto transaction RSA1.

12. In the navigation panel, select the Modeling button, then Process Chain.
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13. In the process chain panel, right click on Merchandise Planning - Actualization and choose Edit.
14. In the right tree, right click on Execute Planning Sequence Data Slice Deactivation (/RAP/MPPCO1_11)

and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).

16. Select the Transfer button and save.

3. Planning Sequence Channel Mix - Actualization

© N OEwN

9.

Go to transaction RSPLAN

Select the Planning Sequence button.

In the planning sequence field, enter /RAP/C11A02 PsS07 and choose Edit button.

Select the Variables button.

Select the Geographical Level 1 Input help and select a value.

Select the Save As Button.

In the Variables prompt, choose F9 to turn Cross User-variant on.

Enter a variant name. For description enter Channel Mix - Actualization and select the Cross-User
Variant check box.

Select the Continue button.

10. Select the Continue button in the variables screen.

11.

Go to transaction RSAL.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on Execute Planning Sequence Channel Mix - Actualization (/RAP/

MPPCO01_02) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).

16. Select the Transfer button and save.

4. Planning Sequence Financial Merchandise Plan - Division - Actualization

© N OO R WD

9.

Go to transaction RSPLAN

Select the Planning Sequence button.

In the planning sequence field, enter /RAP/C11A07_Ps11 and choose Edit button.

Select the Variables button.

Select the Geographical Level 1 Input help and select a value.

Select the Save As Button.

In the Variables prompt, choose F9 to turn Cross User-variant on.

Enter a variant name. For description enter MP - Division - Actualization and selectthe Cross-
User Variant check box.

Select the Continue button.

10. Select the Continue button in the variables screen.

11.

Go to transaction RSA1L.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on Execute Planning Sequence Financial Merchandise Plan - Division -

Actualization(/RAP/MPPCO01_03) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).

16. Select the Transfer button and save.

5. Planning Sequence Financial Merchandise Plan - Department - Actualization

1
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Select the Planning Sequence button.

In the planning sequence field, enter /RAP/C11A03 Ps10 and choose Edit button.
Select the Variables button.

Select the Geographical Level 1 Input help and select a value.

Select the Save As Button.

In the Variables prompt, choose F9 to turn Cross User-variant on.

©® N O R WD

Enter a variant name. For description enter MP - Department - Actualization and selectthe
Cross-User Variant check box.

9. Select the Continue button.

10. Select the Continue button in the variables screen.

11. Goto transaction RSA1.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on Execute Planning Sequence Financial Merchandise Plan - Department -
Actualization(/RAP/MPPCO01_04) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).
16. Select the Transfer button and save.
6. Planning Sequence Financial Merchandise Plan - Class - Actualization
1. Gototransaction RSPLAN
Select the Planning Sequence button.
In the planning sequence field, enter /RAP/C11208 PsS10 and choose Edit button.
Select the Variables button.
Select the Geographical Level 1 Input help and select a value.
Select the Save As Button.
In the Variables prompt, choose F9 to turn Cross User-variant on.

© N oS WD

Enter a variant name. For description enter MP - Class - Actualization and selectthe Cross-User
Variant check box.

9. Select the Continue button.

10. Select the Continue button in the variables screen.

11. Go to transaction RSA1.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on Execute Planning Sequence Financial Merchandise Plan - Class -
Actualization(/RAP/MPPCO01_05) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).
16. Select the Transfer button and save.
7. Planning Sequence Financial Merchandise Plan - Subclass - Actualization
Go to transaction RSPLAN
Select the Planning Sequence button.
In the planning sequence field, enter /RAP/C11A09 Ps13 and choose Edit button.
Select the Variables button.
Select the Geographical Level 1 Input help and select a value.
Select the Save As Button.
In the Variables prompt, choose F9 to turn Cross User-variant on.

No o s N
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9.

Enter a variant name. For description enter MP - Subclass - Actualization and select the Cross-
User Variant check box.

Select the Continue button.

10. Select the Continue button in the variables screen.

11.

Go to transaction RSAL.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on Execute Planning Sequence Financial Merchandise Plan - Subclass -

Actualization(/RAP/MPPCO01_06) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).

16. Select the Transfer button and save.

8. Planning Sequence Channel Plan - Store Comp - Actualization

© N OO s wN

9.

Go to transaction RSPLAN

Select the Planning Sequence button.

In the planning sequence field, enter /RAP/C11A19 PS04 and choose Edit button.

Select the Variables button.

Select the Geographical Level 1 Input help and select a value.

Select the Save As Button.

In the Variables prompt, choose F9 to turn Cross User-variant on.

Enter a variant name. For description enter CP - Store Comp - Actualization and selectthe
Cross-User Variant check box.

Select the Continue button.

10. Select the Continue button in the variables screen.

11.

Go to transaction RSAL.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on Execute Planning Sequence Channel Plan - Store Comp -

Actualization(/RAP/MPPCO01_07) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).

16. Select the Transfer button and save.

9. Planning Sequence Channel Plan - Multi Store - Actualization

204
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Go to transaction RSPLAN

Select the Planning Sequence button.

In the planning sequence field, enter /RAP/C11A18 Ps05 and choose Edit button.

Select the Variables button.

Select the Geographical Level 1 Input help and select a value.

Select the Save As Button.

In the Variables prompt, choose F9 to turn Cross User-variant on.

Enter a variant name. For description enter CP - Multi Store - Actualization and selectthe
Cross-User Variant check box.

Select the Continue button.

10. Select the Continue button in the variables screen.

11.

Go to transaction RSA1L.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.
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14. In the right tree, right click on Execute Planning Sequence Channel Plan - Multi Store -
Actualization(/RAP/MPPCO01_08) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).
16. Select the Transfer button and save.

10. Planning Sequence Channel Plan - Single Store - Actualization

Go to transaction RSPLAN

Select the Planning Sequence button.

In the planning sequence field, enter /RAP/C11A16_ Ps08 and choose Edit button.
Select the Variables button.

Select the Geographical Level 1 Input help and select a value.

Select the Save As Button.

In the Variables prompt, choose F9 to turn Cross User-variant on.
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Enter a variant name. For description enter CP - Single Store - Actualization and selectthe
Cross-User Variant check box.

9. Select the Continue button.

10. Select the Continue button in the variables screen.

11. Goto transaction RSA1.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on Execute Planning Sequence Channel Plan - Single Store -
Actualization(/RAP/MPPCO01_09) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).
16. Select the Transfer button and save.

6.4.2.6 Maintain BEX Variables

In this step, you maintain the variables /RAP/HIEID MSM Oland /RAP/UNIT MSM 01.To do thislaunch the
Query Designer and follow the steps below.

1

7.

Log in to the system desired and select the Open queryicon. In the prompt search the InfoAreas for
Merchandise, Financial Planning for Retail and select.

Open query Channel Mix - query/PF ( /RAP/CP11A02 IRQO1).

. Inthe Filter panel, Characteristic Restrictions and select Hierarchy ID and expand. Choose the variable

Hierarchy ID beneath to focus the value in the Properties panel.

Select the Default Values tab and enter the same hierarchy id used in the Customizing activity.

Return to the Filter panel, Characteristic Restrictions and select Unit of Measure and expand. Choose the
variable Unit of Measure beneath to focus the value in the Properties panel.

Select the Default Values tab and enter the value 'PC' to represent the default unit of measure value for
pieces.

Save the Query and exit.

to support versions in workbooks.
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6.4.2.7 Generate Missing Data Reports

Use

There are two reports required to populated supporting tables.

Procedure

The first report will generate entries for table /RAP/RS_VARCUSTS.

e Use transaction code. SE38 and enter /RAP/SEED BW_CUSTOMIZING DATA inthe Program field. Use the
Execute button to run the report.

The second report is used to set the session client on the HANA system.

e Use transaction code. SE38 and enter /RAP/MPR_REPORTING CLIENT inthe Program field. Use the Execute
button to run the report.

6.4.2.8 Create Geographical Location Hierarchies

SAP Merchandise Planning for Retail supports up to 2 levels of geographical location hierarchies. For example, you
create the first level for the world regions, the second level for countries, and then the location hierarchy. The
location hierarchy node assigned to a geographical location hierarchy must be a distribution chain hierarchy (DC),
which is a type 04 or a promotion location hiearchy which is a type 05.

Do the following steps to create a geographical location hierarchy:

1. Logintothe application server using SAP GUI and execute transaction code NWBC.
2. Select the Services menu.
3. Inthe left navigation menu select | Location Services » Location Hierarchy 3.

In the POWL menu on the right, select the Create button, then Geographical Location Hierarchy in the
dropdown.

4. Enter the location hierarchy name, description and the master data system for your new geographical
location hierarchy.
5. Select the Editor tab.

1 Note

o The Location and Import tabs are disabled.

Enter or search for the distribution chain location hierarchy or promotion location hierarchy that you want to
add to your geographical location hierarchy.

6. Add the desired DC location hierarchy or promotion location hierarchy to your geographical location
hierarchy. You may have either or both types of hierarchies added to the same geographical location
hierarchy node.
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7. Save your entries.

In the example below you have two level 2 hierarchies. The level 3 hierarchies are the actual distribution chain
location hierarchies and/or promotion location hierarchies that were selected (created in a previous activity).

e GLOBAL (GEOLEVELI)
o NORTH_AMERICA (GEOLEVEL?2)

o DC Hierarchy for Sales Org/Dist. Channel XYZ (GEOLEVELS3)
This will assign all locations for the sales org / distribution channel XYZ to North America's node.

o Promotion location hierarchy PL123 (GEOLEVEL3)
This will assign all locations for the promotion location hierarchy PL123 to North America's node.

o SOUTH_AMERICA (GEOLEVELZ2)

o DC Hierarchy for Sales Org/Dist. Channel ABC (GEOLEVEL3)
This will assign all locations for the sales org / distribution channel ABC to South America's node.

6.4.2.9 Maintain Article and Geographical Hierarchy

Use

There are two types of hierarchies used in SAP Merchandise Planning for Retail. The Geographical and the Article
Hierarchy.

Procedure

There is a Customizing activity to define the required hierarchies. Use transaction code spro and in the Dialog
Structure navigate to | Cross-Application Components » Assortment Planning for Retail » Imported Demand
Data Foundation Settings  Basic Settings 4 and choose Define Default Values.

e |nthe Hierarchy ID field use the prompt to select the applicable article hierarchy id. If SAP Assortment

Planning for Retail is installed, it is already populated.
® |nthe Geo Hierarchy IDfield use the prompt to select the applicable geo hierarchy id .

6.4.2.10 Reporting Currency for Geo Hierarchy Level 2

The geographical hierarchy level 2 requires a reporting currency. Do the following steps to create a geographical
location hierarchy currency:

1. Inyour back-end system, launch table/view maintenance transaction code sM30.

2. Inthe Maintain Table Views: Initial Screen enter /RAP/GEOLVL_CUST in the Table/view field and select the
Maintain button

3. Choose New Entries .

4. Use the F4 help to select the Geographical Level 02 desired.
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5. Use the F4 help to select the Reporting Currency associated with the Geographical Level O2 selected.
6. Repeat for each Geographical Level 02 required.
7. Save your entries.

6.4.2.11 Verify the Connection Between the SAP Merchandise
Planning for Retail System and SAP BusinessObjects
Analysis, edition for Microsoft Office

The SAP Merchandise Planning for Retail application includes several SAP BusinessObjects Analysis, edition for
Microsoft Office workbooks. These workbooks, which are installed on your back-end system as part of the local Bl
Content, can only be opened using SAP BusinessObjects Analysis, edition for Microsoft Office.

In this step, you verify that you can open the SAP Merchandise Planning for Retail workbooks from SAP
BusinessObjects Analysis, edition for Microsoft Office.

1. Open SAP BusinessObjects Analysis, edition for Microsoft Office from | Start » All Programs » SAP Business
Intelligence j» SAP BusinessObjects Analysis ¥ Analysis for Microsoft Excel 3.

2. From the File menu, select |+ Analysis » Open Workbook (Open Workbook from SAP NetWeaver) .

3. Select your back-end system.
Tip: The list of systems corresponds to the systems available in your SAP Logon.

4. If single sign-on is not configured provide your user information.

5. Search for /rRaP/MP* on the Search tab.

6. Open any of the workbooks from the list of SAP Merchandise Planning for Retail workbooks.
The opening of the workbook indicates that there are no issues with the connection between your back-end
system and SAP BusinessObjects Analysis, edition for Microsoft Office.

6.4.2.12 Verify Users, Privileges, and Roles

Use

Prior to proceeding with the post-installation steps for the application, you need to ensure that the required
database and back-end application users have all the required privileges, roles and authorizations.

Prerequisites

You have read and implemented the procedure described in Verify SAP HANA User and Privileges [page 40].
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Procedure

1. Ensure that the SAP HANA database users listed below exist and that they have the required additional roles/

privileges.
Table 79:

User

SAP<SID>

This is the generic database user speci-
fied for the connection from the SAP
NetWeaver back-end server to the SAP
HANA database.

o

o

Privilege EXECUTE on procedure TRUNCATE PROCEDURE OBJECTS

Privilege EXECUTE on procedure GET PROCEDURE OBJECTS

Role/Privilege

_SYS_REPO

<Your User Name>*

o

Privilege REPO.READ on package bw2hana/SAP<SID> /RAP/
<InfoCube> REPORTING

The corresponding privileges will be created automatically when activating
Bl Content.

Session Client of this database user has to be set to the appropriate back-
end system client.

1

2.

Log on to SAP HANA Studio.

Open the Modeler perspective and use the Navigator to access your
back-end system.

Under Security, select a user.

Set the Session Client to the client number created in Set Up SAP Cli-
ent [page 47].

This step is necessary to use the SAP Merchandise Planning for Retail
planning framework, where SAP BusinessObjects Analysis, edition for
Microsoft Office workbooks obtain data from SAP HANA views.

For more information, see the Assign Default Client section in the SAP
HANA Modeling Guide.

must be identical.

*The username on SAP HANA database level, back-end system and on the front-end server (SAP NetWeaver Gateway)

2. Ensure that your back-end application user has the following roles/authorizations.
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Table 80:

User Role/Authorization

<Your User Name>* © SAP ISR DDF MASTER

o /RAP/BW _MPR WORKBOOKS

o Set SAP HANA User Mapping to C ( DBMS user, else SAP HANA user with
same name as BW user) in transaction RS2HANA VIEW.

o The user profile must have the following parameters maintained (transac-

tion su3, Parameters tab):

Table 81:
Parameter Value
RSPLS HDB PE TRACE Y
RSPLS HDB_SUPPORT HDB_ON

*The username on SAP HANA database level, back-end system and on the front-end server (SAP NetWeaver Gateway)

must be identical.

6.4.3 Configure Data Replication Steps

6.4.3.1 Initial Load of Data to DDF Using DRFOUT

Use

SAP Merchandise Planning for Retail uses master data, such as product, location, and product hierarchy, that is
replicated from SAP ERP (more specifically, the SAP Retail add-on to SAP ERP) to the DDF module in SAP
Customer Activity Repository using the DRFOUT data replication framework.

1 Note

Not all of the master data is replicated into DDF using DRFOUT. Some data must be replicated separately using
SLT replication.
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SAP Merchandise Planning for Retail requires that the following master data is replicated from a connected SAP

ERP system using DRFOUT:

Table 82:
Sequence Master Data Technical Details For more information, see:
1 Product Hierarchy | ® SAP ERP Description: Material Group http://help.sap.com/car| <your release>
Hierarchy
e DRFOUT Outbound Impl tati > Application Help > <> > Demand Data
utbound Implementation:
PMCH Foundation # Integration Information
e DDF Inbound Interface: /DMF/ Inbound Interfaces For Remote Function
MDIF PROD HIER INBOUND Call (RFC) Communication » Product
Hierarchy Master Data ]
2 Product * SAP ERP Description: Material http://help.sap.com/carl} <your release>
e DRFOUT Outbound Implementation: o
o » Application Help # Demand Data
e DDF Inbound Interface: /DMF/ Foundation > Integration Information >
MDIF PRODUCT INBOUND Inbound Interfaces For Remote Function
- - Call (RFC) Communication % Product
Master Data }
3 Location ® SAP ERP Description: Plant http://help.sap.com/carllr <your release>
e DRFOUT Outbound Implementation: o
—_— > Application Help > Demand Data
e DDF Inbound Interface: /DMF/ Foundation ¥ Integration Information
MDIF LOCATION INBOUND Inbound Interfaces For Remote Function
- - Call (RFC) Communication # Product
Location Master Data 1
4 Product Location | ® SAP ERP Description: Material/Plant http://help.sap.com/car|lF <your release>
e DRFOUT Outbound Implementation: o
— > Application Help > Demand Data
e DDF Inbound Interface: /DMF/ Foundation > Integration Information }
MDIF PROD LOC INBOUND Inbound Interfaces For Remote Function
Call (RFC) Communication > Product
Location Master Data 4
5 Product Location ® SAPERP Description: Sales Price http://help.sap.com/carl} <your release>
e DRFOUT Outbound Implementation: o
bSPR > Application Help > Demand Data
e DDF Inbound Interface: /DMF/ Foundation > Integration Information >
MDIF PROD LOC INBOUND Inbound Interfaces For Remote Function
Call (RFC) Communication ¥ Product
Location Master Data }

Common Installation Guide CARAB 2.0
Post-Installation

CUSTOMER 211


http://help.sap.com/car
http://help.sap.com/car
http://help.sap.com/car
http://help.sap.com/car
http://help.sap.com/car

Sequence Master Data Technical Details For more information, see:
6 Inventory * SAPERP Description: Inventory http://help.sap.com/car| <your release>
e DRFOUT Outbound Implementation: o
- > Application Help » Demand Data
e DDF Inbound Interface: /DMF/ Foundation > Integration Information. >
OPIF INVENTORY INBOUND Inbound Interfaces For Remote Function
Call (RFC) Communication > Inventory
Master Data ]
U Product Location ® SAPERP Description: Moving Average http://help.sap.com/carl} <your release>
Price
. > Application Help > Demand Data
e DRFOUT Outbound Implementation:
PMAP Foundation ¥ Integration Information »
e DDF Inbound Interface: /DMF/ Inbound Interfaces For Remote Function
MDIF PROD LOC_INBOUND Call (RFC) Communication » Product
Location Master Data }
9 Location ® SAPERP Description: Vendor http://help.sap.com/carl} <your release>
e DRFOUT Outbound Implementation: o
» Application Help ¥ Demand Data
PVEN
e DDF Inbound Interface: /DMF/ Foundation > Integration Information. >
MDIF LOCATION INEBOUND Inbound Interfaces For Remote Function
Call (RFC) Communication > Location
Master Data }
10 Product Hierarchy | ® SAP ERP Description: Article Hierar- http://help.sap.com/carl} <your release>
chy
. > Application Help » Demand Data
e DRFOUT Outbound Implementation:
PAHY Foundation ¥ Integration Information ¥
e DDF Inbound Interface: /DMF/ Inbound Interfaces For Remote Function
MDIF PROD HIER INBOUND Call (RFC) Communication } Product
Hierarchy Master Data |
Prerequisites

Before replicating data from SAP ERP to DDF using DRFOUT, the following prerequisites must be fulfilled:

e The following business functions are activated in SAP ERP:
© ISR APPL OUTBOUND DMF

© ISR RETAIL OUTBOUND DMF
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® You have noted the different terms for the following objects:

Table 83:
SAP ERP SAP Retail DDF / SAP Merchandise Planning for
Retail
Material Article Product
Plant Site Location
Procedure

1. Read the Business Process Documentation associated with the Enabling Demand Data Foundation and
Creating Demand Forecast business process of the Customer Activity Repository scenario in SAP Solution
Manager.

2. Read the Configuring Data Replication from SAP ERP to DDF configuration document associated with the
Enabling Demand Data Foundation and Creating Demand Forecast business process of the Customer Activity
Repository scenario in SAP Solution Manager.

6.4.3.2 Initial Load of Sales Data from BW

Use

If you have accumulated large amounts of historical sales data using SAP POS Data Management or SAP
Customer Activity Repository, it is possible that you are storing these large data sets in a connected SAP BW
system. In such a case, you can perform the initial load of the sales time series (historical POS data) data into DDF
using the Bl Interface for Time Series report.

Procedure

Log on to your back-end system.
Execute transaction sE38.
Specify /DMF/BI_IF_TSin the Program field and choose Execute.

~won o

Read the documentation associated with the report, carry out the described customizing, and run the report
accordingly.
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More Information

http://help.sap.com/car| Application Help » Demand Data Foundation j Integration Information  Inbound
Interfaces For Remote Function Call (RFC) Communication ¥ Sales Time Series 3.

6.4.3.3 Initial Load of Goods Movement KPlIs

Load goods movement Key Performance Indicators (KPI) for returns, receipts, and open quantity.

Context

The goods movement data is stored in the SLT replicated tables EKPO, EKET, EKBE, MARA and MARM in the
Customer Activity Repository. You perform the initial load of this data into DDF using the /RAP/
MPR_ECC_KPI_CALC report. This report will load 2 years of data from the current date. In addition it is
recommended you run this report weekly to update the aggregated KPIs with the ongoing ERP activity.

Procedure
1. Logonto your back-end system.

2. Execute transaction SE38.

3. Specify /RAP/MPR_ECC_KPI_CALC in the Program field and choose Execute.

6.4.3.4 Delta Load of Data to DDF Using DRFOUT

We recommend that you schedule a weekly periodic task to replicate inventory data (outbound implementation
PINV) from the SAP ERP system to the system for SAP Merchandise Planning for Retail 1.0 SP4. This replication
builds up the inventory history data that is needed by SAP Merchandise Planning for Retail 1.0 SP4.
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6.4.3.5 Delta Load of Sales Data in SAP Customer Activity
Repository

Use

Once the initial load of historical sales data is completed or, if you are working on a brand new system
implementation and do not have to perform an initial sales data load, you need to configure the periodic delta load
of sales data in SAP Customer Activity Repository.

Procedure

1. Ensure that you have properly configured the POS Sales Transfer and Audit functionality in SAP Customer
Activity Repository to receive transaction data from your connected POS systems.
For more information, see Business Process Documentation associated with the Performing POS Data
Transfer and Audit business process of the SAP Customer Activity Repository Solution Manager scenario.

2. Ensure that you have configured the Supply - DMF-Based Applications outbound tasks to load sales data from
POS Sales Transfer and Audit to DDF.

For more information, see http://help.sap.com/car| Application Help » POS Transaction Management
Task Processing ¥ Tasks for Sending Data to Follow-On Applications 4.

= Recommendation

If you are not storing aggregated sales data in an SAP BW system, and have historical sales data that you
would like to load into DDF from POS Sales Transfer and Audit, you can configure the Supply - DMF-Based
Applications outbound tasks to perform this initial load.

3. Monitor the transfer of sales time series data as described in http://help.sap.com/car| Application Help

Demand Data Foundation ¥ Integration Information ¥ Inbound Processing 3.
4. Specify Point of Sale Data as the source of sales data in Customizing under |+ Cross-Application Components

» Demand Data Foundationl » Data Maintenance ¥ Define Time Series Source 4.

More Information

http://help.sap.com/carlp Application Help » Demand Data Foundation ¥ Integration Information ¥ Inbound

Interfaces For Remote Function Call (RFC) Communication » Sales Time Series .
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6.4.3.6 Delta Load of Goods Movement KPIs

Once the initial load of historical goods movement KPIs data is completed you should continue to update your
data on a weekly basis. As data is replicated from SAP ERP activity the values for goods movement KPIs can only
be added to the Demand Data Foundation when you execute the report /RAP/MPR_ECC_KPI_CALC.

6.4.3.7 Replicate SAP ERP Tables for SAP Merchandise
Planning for Retail

Use

In this procedure, you ensure that all SAP Retail or SAP S/4HANA tables that are relevant for SAP Merchandise
Planning for Retail have not only been created but have also been filled with data. More specifically, you replicate
the contents of relevant tables from the source SAP Retail or SAP S/4HANA system to your back-end system.

1 Note

If you have already replicated the relevant tables in the Create/Replicate Source Master Data System Tables
[page 49] procedure, you can skip this procedure.

The steps outlined in this procedure are required when you are implementing one of the system landscape
variants that require data to be replicated from a source SAP Retail or SAP S/4HANA system. If your source SAP
Retail or SAP S/4HANA system and your back-end system are co-deployed on the same SAP HANA database,
proceed to the next procedure.

SAP Merchandise Planning for Retail requires that the following master data is replicated from a connected SAP
ERP system using SLT replication:

Table 84:
Master Data ‘ SAP ERP Table
General Material Data MARA,
Units of Measure for Material MARM,
Purchasing Document Iltem EKPO,
History per Purchasing Document EKBE
Scheduling Agreement Schedule Lines EKET
Procedure

1. Define client transformation rules for all SAP ERP tables that you plan to replicate.
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In most cases, you need to apply transformation rules to map the client of the source SAP ERP system to the
client on the target back-end system.

Caution

Transformation rules must be defined before replicating tables.

For more information, refer to one of the following:

o Set Up SAP Client [page 47]

o http://help.sap.com/hana_platform|p System Administration and Maintenance Information » Application
Operations Guide - Trigger-Based Data Replication Using SAP LT Replication Server for SAP HANA ¥ Data
Transformation Capabilities within SAP Landscape Transformation Replication Server J

o SAP Note 1733714

2. Read SAP Note 2054656#% and replicate the tables listed in the file attached to this SAP Note.
For more information, see:
o http://help.sap.com/hana_platform|p System Administration and Maintenance Information ¥ Application

Operations Guide - Trigger-Based Data Replication Using SAP LT Replication Server for SAP HANA »
(<Managing the Replication Process Using the SAP HANA studio>and<Important

Transactions and Control Tables>) 3

Caution

This procedure includes the replication of tables from your source SAP ERP system. Trigger-based
replication includes deletion in source tables by archiving activities (since on the database level it is
impossible to distinguish between delete actions caused by archiving and regular deletion of data records).
As aresult, SAP LT (Landscape Transformation) Replication Server replicates archiving activities as delete
actions in the SAP HANA database.

More specifically, when data is archived in your source SAP ERP system, records are deleted from their
respective database tables. Therefore, when these tables are replicated to another SAP HANA database,
the records that were archived in the source tables are deleted in the target database tables.

When deciding on the frequency at which to archive data in the source SAP ERP system, you must consider
and balance the performance requirements of your SAP ERP system and the amount of historical data that
should be replicated to and available in your back-end system.

6.4.4 Specify Analysis Workbooks Settings
6.4.4.1 Enable Macros

Use

In this procedure, you enable your SAP BusinessObjects Analysis, edition for Microsoft Office workbooks to use
macros.
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Procedure

1. Open the SAP BusinessObjects Analysis, edition for Microsoft Office from | Start » All Programs ¥ SAP
Business Intelligence » SAP BusinessObjects Analysis ¥ Analysis for Microsoft Excel .

Choose |l File » Options » Customize Ribbon .

Under Customize the Ribbon, select Main Tabs.

Enable the entry Developer and confirm by choosing OK.

Now you will see the new Developer tab in your SAP BusinessObjects Analysis, edition for Microsoft Office.
Select the Developer Tab and choose Macro Security.

N o gk~ WD

Choose Enable all macros.

6.4.4.2 General Workbook Settings

Use

You use Analysis for Microsoft Excel in which you can launch the planning workbooks.

Procedure

If you are unable to see the Analysis and SAP Planning for Retail tabs on the menu of Analysis for Microsoft Excel,
perform the following steps in the Options, Add-Ins of the Excel options:

1. Enter comin the Manage field and choose Go.

2. Inthe coM Add-Ins box, select the Analysis and Planning options and choose Go. If you do not find them in
the list, Enter Disabled in the Manage field and choose Go.

Now you are able to view the Analysis and SAP Planning for Retail tabs. On the Analysis tab right click and, go to
Settings, and ensure that the Planning field is selected.

6.5 SAP Promotion Management for Retail

6.5.1 Activate Internet Communication Framework (ICF)
Services

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Promotion
Management for Retail application are made available in an inactive state. In this procedure, you activate an ICF
service required for the SAP Manage Promotional Offers Fiori app.

1. Logonto your front-end system.
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2. Open service maintenance (transaction SICF).
3. Inthe Maintain Service screen, select the service by specifying the following:
o Hierarchy Type: SERVICE
© Virtual Host: DEFAULT HOST
o Service Path: /sap/bc/bsp/sap/
o Service name: pmroffers
4. Choose Execute.
5. To activate the service, choose Service/host Activate.
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7

Additional Information

7.1 Workbook Design Example

Use

In this procedure, you walk through an example of creating an SAP BusinessObjects Analysis, edition for
Microsoft Office workbook. You can use steps of this procedure to create customized versions of the SAP-
delivered assortment planning workbooks.

Prerequisites

The necessary Bl queries must exist in the back-end system.

Procedure

0 N OOk~ w

11.

12.

220

Open SAP BusinessObjects Analysis, edition for Microsoft Office from | Start » All Programs ¥ SAP Business
Intelligence j» SAP BusinessObjects Analysis ¥ Analysis for Microsoft Excel 3.

Select the cell in the worksheet where the crosstab with the data from the selected data source should be
inserted.

From the menu, choose |+ Analysis ¥ Insert » Select Data Source 3.

Choose Skip on the popup window Logon to SAP BusinessObjects Bl Platform.

In the Select Data Source dialog box, select the source system, then choose Next.

In the Logon to system <Your System Name> dialog box, enter your logon data, then choose OK.

In the Select Data Source dialog box, choose tab Search.

In the Search tab, you can search for the description or technical name of a data source, that is, the name of
the Bl query that will provide the data for your workbook.

For example, search for /RAP/MO12A01 IRQO02 or /RAP/MO1A01 IRQO1.In general, you can search for /RAP*
to find any SAP Assortment Planning for Retail query.

. Select the required data source, and then choose OK.
10.

On the Prompts screen, make the relevant entries base on the selected query in the Specify Value for Prompts
area.

Choose OK, and then you will see the table is inserted in the sheet. You can now analyze the data and change
the displayed data set according to your needs. You can also add other components to your analysis, for
example charts.

Choose menu [ Analysis ¥ Display 3 to open the design panel.
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13. Choose the Components tab in the bottom right corner, and right-click BookI and choose Use Planning
Sequence.

14. In the Search For field of the Open Planning Sequence dialog box enter your planning sequence and choose
Search.

15. Select the required planning sequence, and then choose OK. The planning sequence will be displayed under
| Bookl ¥ Planning Objects Jin the design panel.

16. Select the cell in the worksheet where a button should be inserted.

17. From the menu, choose |# Developer ¥ Insert i Button (Form Control) 3, and insert the button using drag and
drop.

18. In the Assign Macro dialog box, choose New.

19. In the VB edit, maintain the relevant code in the Sub ButtonX_Click area.

20.Choose Close.

21. Right-click the button, and choose Edit Text. Replace the button name with a meaningful name.

22.Position your cursor where the condition will be defined, and make the relevant entries.

23.Select the sheet and position the cursor where the variable list will be inserted, for example cell H1 in sheetl.

24.Choose menu |l Analysis  Info # Field i Variables 1, and the variables will be inserted into the relevant
sheet.

25.Maintain the relevant entries in the sheet.

26.Choose your Planning Sequence in the design panel.

27.In the section of Variables of Planning Sequence, make the relevant entries.

28.Choose Save Button.

29.Provide a file name and save the workbook as type Excel Macro-Enabled Workbook (*.xIsm).

30.Choose Save.

Result

The customized workbook is created.
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be a
binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does
not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales
person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency
(see: http://help.sap.com/disclaimer).

Common Installation Guide CARAB 2.0
222 CUSTOMER Important Disclaimers and Legal Information


http://help.sap.com/disclaimer/

Common Installation Guide CARAB 2.0
Important Disclaimers and Legal Information CUSTOMER 223



go.sap.com/registration/
contact.html

© 2016 SAP SE or an SAP affiliate company. All rights reserved.
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